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Prólogo

Bem-vindo

Bem-vindo à Introdução ao Ubuntu, um guia introdutório escrito para
ajudar novos usuários a começarem a usar Ubuntu.

Nosso objetivo é cobrir o básico do Ubuntu (como a instalação e ope-
ração do ambiente de trabalho), bem como gerenciamento de hardware e
soware, trabalhando com a linha de comando e segurança. Nós projeta-
mos este guia para ser simples de seguir, com instruções passo a passo e
muitas imagens, permitindo-lhe descobrir o potencial do seu novo sistema
Ubuntu.

Por favor, tenha em mente que este guia é ainda um trabalho em anda-
mento e sempre será. Ele é escrito especificamente para o Ubuntu .
, e, apesar de termos como objetivo não limitar as nossas instruções a LTS é uma abreviatura em inglês para “Suporte

de longo-prazo”. Uma nova versão LTS é
lançado a cada 2 anos. Iniciando com o Ubuntu
12.04 LTS, tanto a versão Desktop como a
Servidor terão cinco anos de suporte, ou
seja, você recebe atualizações de segurança
gratuitas por pelo menos cinco anos.

esta versão, é inevitável que algumas coisas mudem ao longo da vida do
Ubuntu. Sempre que uma nova versão do Ubuntu for lançada, iremos in-
corporar atualizações e alterações em nosso guia, e fazer uma nova versão
disponível http://www.ubuntu-manual.org.

Introdução ao Ubuntu . não tem a intenção de ser um manual de
instruções compreensivo. É mais um guia de início-rápido que vai levá-
lo a fazer as coisas que você precisa fazer em seu computador de forma
rápida e fácil, sem se preocupar com detalhes técnicos. Como em versões
anteriores, o Ubuntu .  incorpora muitos novos recursos, incluindo
melhorias no Unity e o . Mais sobre o Unity e o que ele significa, e o HUD é uma abreviatura em inglês para

”heads-up display”, algo como ”visualizador de
sugestões”. É um conceito novo, integrado ao
Unity 5.2 e ainda está em desenvolvimento.

, pode ser encontrado em Capítulo : O Ubuntu Desktop.
Para informações mais detalhadas sobre o uso do Unity e do Ubuntu

Desktop, veja o “Guia do Ubuntu Desktop,” que pode ser obtido em qual-
quer uma das seguintes formas:

‣ no Dash, digite yelp;
‣ no barra de menu da área de trabalho, clique em Ajuda ‣Ajuda do

Ubuntu;
‣ ir para https://help.ubuntu.com, Ubuntu .  ‣ para Ajuda do

Ubuntu Desktop.

A Internet também é uma excelente fonte. Por exemplo, no https://
help.ubuntu.com você vai encontrar documentação sobre como instalar
e usar o Ubuntu, e no Fórum Ubuntu, http://ubuntuforums.org, e Ask
Ubuntu, http://askubuntu.com, você encontra respostas para muitas ques-
tões relacionadas com Ubuntu. Mais informações sobre a documentação

on-line e do sistema pode ser encontrada em
Capítulo⁇: ⁇.

Se algo não estiver coberto neste manual, é provável que você que você
encontre as informações que procura em um desses lugares. Nós faremos
o possível para incluir links para uma ajuda mais detalhada em todos os
lugares possíveis.

Filosofia Ubuntu

O termo “ Ubuntu” é um conceito tradicional Africano que se originou
a partir das línguas Bantu do sul da África. Pode ser descrito como um As pessoas às vezes se perguntam como

pronunciar Ubuntu. Cada “u” é pronunciado da
mesma forma como em português.

modo de ligação com os outros—viver em uma comunidade global, onde
suas ações afetam toda a humanidade. Ubuntu é mais do que apenas
um sistema operacional: é uma comunidade de pessoas que se unem

http://www.ubuntu-manual.org
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voluntariamente para colaborar em um projeto internacional de soware
que visa proporcionar a melhor experiência de usuário possível.

O compromisso Ubuntu

‣ O Ubuntu sempre será gratuito, e não cobrará adicionais por uma
versão corporativa ou atualizações de segurança.

‣ Ubuntu vem com suporte total comercial da Canonical e centenas de
empresas ao redor do mundo.

‣ Ubuntu possui a melhor tradução e acessibilidade que a comunidade de
soware livre pode oferecer.

‣ Todas as principais aplicações do Ubuntu são sowares grátis e livres.
Nós queremos que você use soware grátis e livre, melhore-o e passe-o
adiante.

Uma breve história do Ubuntu

O Ubuntu foi concebido em  por Mark Shuleworth, um bem-
sucedido empreendedor sul-africano, e a sua empresa Canonical. Shuleworth A Canonical é a empresa que provê suporte

financeiro e técnico ao Ubuntu. Ela tem em-
pregados ao redor do mundo que trabalham
no desenvolvimento e melhoria do sistema
operacional, assim como na revisão do traba-
lho enviado por contribuidores voluntários.
Para saber mais sobre a Canonical, vá para
http://www.canonical.com.

reconheceu a força do Linux e do código-aberto, mas também estava ci-
ente da fraqueza que dificultava o seu uso em massa.

Shuleworth iniciou com intenções claras de enfrentar essas fraquezas
e criar um sistema que seria fácil de usar, completamente livre (ver em
Capítulo : Aprendendo mais a definição completa de “livre”), e pudesse
competir com os outros sistemas operacionais principais. Com o sistema
Debian como base, Shuleworth começou a construir o Ubuntu. Utili- o Debian é o sistema operacional Linux em que

o Ubuntu é baseado. Para mais informações
visite http://www.debian.org/.

zando seus próprios recursos de início, s de instalação era impressos e
enviados mundo afora sem custo aos destinatários. O Ubuntu se espalhou
depressa, sua comunidade cresceu rapidamente e logo o Ubuntu se tornou
a distribuição Linux mais popular.

Com cada vez mais pessoas trabalhando no projeto do que nunca antes,
suas funcionalidades principais e suporte a hardware continuam a me-
lhorar. O Ubuntu ganhou a atenção de grandes organizações ao redor do
mundo. Um dos sistemas operacionais da IBM é baseado no Ubuntu. Em
, a Polícia Francesa começou a transição de sua infra-estrutura com-
pleta para uma variação do Ubuntu—um processo que, segundo notícias,
os fez economizar ”milhões de euros” em taxas de licenças do Microso
Windows. No final de , a Polícia Francesa antecipou que todos os seus
computadores estariam executando o Ubuntu. Os lucros da Canonical
provêm da combinação da sua oferta de suporte técnico e adaptação de
soware.

Enquanto grandes organizações acham útil pagar pelo serviço de su- Para mais informações do Ubuntu Server
Edition, e como usá-lo em sua empresa, visite
http://www.ubuntu.com/business/server/
overview.

porte, Shuleworth prometeu que o sistema Ubuntu para desktop será
gratuito. Em , o Ubuntu tinha uma estimativa de instalação de % dos
computadores do mundo. Isso é igual a dez milhões de usuários, e cresce
a cada ano. Como o registro não é obrigatório, o percentual de usuários
Ubuntu deve ser tratado como uma estimativa.

O que é Linux?

Ubuntu é construído sobre a fundação do Linux, que é um membro da
família Unix. Unix é um dos mais antigos tipos de sistemas operacionais e
forneceu confiabilidade e segurança em aplicações profissionais por quase
meio século. Muitos servidores em todo o mundo que armazenam dados
de sites populares (como YouTube e Google) executam alguma variante

http://www.canonical.com
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de um sistema Unix. O kernel Linux é melhor descrito como o núcleo, ou
quase o cérebro, do sistema operacional.

O kernel Linux é o controlador do sistema operacional. Ele é respon-
sável pela alocação de memória e o tempo de uso do processador. Ele
também pode ser imaginado como o programa que gerencia todos e qual-
quer aplicativo no computador.

Linux was designed from the ground up with security and hardware While modern graphical ambiente de trabalhos
have generally replaced early command-line
interfaces, the command line can still be a
quick and efficient way of performing many
tasks. See Capítulo 6: Tópicos avançados for
more information, and Capítulo 2: O Ubuntu
Desktop to learn more about GNOME and
other desktop environments.

compatibility in mind, and is currently one of the most popular Unix-
based operating systems. One of the benefits of Linux is that it is incredi-
bly flexible and can be configured to run on almost any device—from the
smallest micro-computers and cellphones to larger super-computers. Unix
was entirely command line-based until graphical user interfaces (s)
began to emerge in the early s.

As primeiras s eram difíceis de configurar, desengonçadas, e ge-
ralmente apenas usadas por programadores de computadores. Na década
passada, contudo, as interfaces gráficas de usuário melhoraram muito em
termos de usabilidade, confiabilidade e aparência. O Ubuntu é apenas uma
das muitas distribuições Linux diferentes, e usos de um dos mais populares Para saber mais sobre distribuições Linux, veja

Capítulo⁇: ⁇.ambientes gráficos de área de trabalho chamado .

O Ubuntu é ideal para você?

Novos usuários do Ubuntu podem achar que demora algum tempo para
se sentirem confortáveis ao experimentar um novo sistema operacional.
Você, sem dúvida, irá encontrar muitas similaridades com o Microso
Windows e com o Mac  , e também algumas diferenças. Usuários
vindos do Mac   vão perceber mais facilmente as similaridades, de-
vido ao fato de que tanto o Mac   quanto o Ubuntu se originaram do
Unix. O shell Unity, padrão do Ubuntu, é um novo conceito completo,
que necessita de algum tempo de exploração para se acostumar a ele. Veja
Capítulo : O Ubuntu Desktop para mais informações sobre o shell Unity.

Antes que você decida se o Ubuntu serve ou não para você, sugerimos
que você se dê algum tempo para se acostumar com a maneira que as
coisas são feitas no Ubuntu. Você deve estar ciente que irá descobrir que
algumas coisas são diferentes do que você está acostumado. Nós também
sugerimos levar o seguinte em consideração:

O Ubuntu é baseado na comunidade. Isto é, o Ubuntu é desenvolvido,
escrito e mantido por uma comunidade. Por causa disto, o suporte
provavelmente não está disponível na sua loja de computadores local.
Felizmente, a Comunidade Ubuntu está aqui para ajudar. Há muitos
artigos, guias e manuais disponíveis, bem como usuários em diversos
fóruns de Internet e salas de bate-papo () que estão dispostos a
auxiliar os iniciantes. Além disso, ao final deste guia, incluímos um
capítulo de resolução de problemas: Capítulo : Solução de problemas.

Muitos aplicativos projetados para Microso Windows ou Mac   não
executam no Ubuntu. Para a grande maioria das tarefas diárias de
computação, você encontrará aplicativos alternativos disponíveis no
Ubuntu. No entanto, muitos aplicativos profissionais (como o Adobe
Creative Suite) não são desenvolvidos para funcionar com o Ubuntu.
Se você utiliza um aplicativo comercial que não é compatível com o
Ubuntu, e ainda assim deseja usar o Ubuntu, você pode usar dupla-
inicialização. Como alternativa, alguns aplicativos desenvolvidos para Para saber mais sobre dupla-inicialização

(execução do Ubuntu lado a lado com ou-
tro sistema operacional), veja Capítulo 1:
Instalação.

Windows executarão no Ubuntu com um programa chamado Wine.
Para mais informações sobre Wine, acesse http://www.winehq.org.

Many commercial games will not run on Ubuntu. If you are a heavy gamer,

http://www.winehq.org
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then Ubuntu may not be for you. Game developers usually design
games for the largest market. Since Ubuntu’s market share is not as
substantial as Microso’s Windows or Apple’s Mac  , most game
developers will not allocate resources towards making their games
compatible with Linux. If you just enjoy a game every now and then, See Capítulo 5: Gerenciamento de Programas

to learn more about Ubuntu Software Center.there is active game development within the community, and many
high quality games can be easily installed through the Ubuntu Soware
Center.

Detalhes para contato

Muitas pessoas têm contribuído com o seu tempo para este projeto. Se
você encontrar alguns erros ou pensa que nós tenhamos deixado algo de
fora, sinta-se livre para contatar-nos. Nós faremos tudo para termos a
certeza de que este manual esteja atualizado, informativo e profissional.
Nossos detalhes para contato seguem abaixo:

‣ Página: http://www.ubuntu-manual.org/
‣ E-mail: ubuntu-manual@lists.launchpad.net
‣ : #ubuntu-manual em irc.freenode.net
‣ Relatos de erros: https://bugs.launchpad.net/ubuntu-manual/+filebug

Sobre a equipe

Nosso projeto é um esforço voluntário de código-aberto para criar e man-
ter uma documentação de qualidade para o Ubuntu e seus derivados.

Quer ajudar?

Estamos sempre à procura de pessoas talentosas para trabalhar e, diante
do tamanho do projeto, temos a sorte de reunir um amplo conjunto de
habilidades:

‣ Autores, editores
‣ Programadores (Python ou TEX)
‣ Designer de interface
‣ Designers de ícones e folha de rosto
‣ Organizadores de eventos e pessoas com ideias
‣ Testadores
‣ Web designers e desenvolvedores
‣ Tradutores e capturadores de tela
‣ Encarregados de relatar e fazer a triagem de erros

Para saber como você pode ajudar, por favor visite http://ubuntu-
manual.org/getinvolved.

Convenções usadas neste livro

As seguintes convenções tipográficas são usadas neste livro:

‣ Nomes de botões, itens de menus, e outros elementos da  são confi-
gurados em boldfaced type.

‣ As sequências de menu são as vezes apresentadas como Arquivo ‣
Salvar como…, o que significa, “Escolha o menu Arquivo, então esco-
lha a opção Salvar como….”

http://www.ubuntu-manual.org/
mailto:ubuntu-manual@lists.launchpad.net
irc.freenode.net
https://bugs.launchpad.net/ubuntu-manual/+filebug
http://ubuntu-manual.org/getinvolved
http://ubuntu-manual.org/getinvolved
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‣ Fonte mono-espaçada é usada para textos que você deve digitar no
computador, textos que são saídas do computador (como no terminal) e
atalhos de teclado.





1 Instalação

Obtendo o Ubuntu

Antes de você começar a usar o Ubuntu, você precisará obter uma cópia Muitas empresas (como por exemplo, a Dell
e a System76) vendem computadores com
o Ubuntu pré-instalado. Se você já possui o
Ubuntu instalado em seu computador, sinta-se
livre para pular para Capítulo 2: O Ubuntu
Desktop.

de uma imagem de instalação do Ubuntu em  ou em . Algumas
opções para fazer isso estão resumidas abaixo.

Requisitos mínimos do sistema

O Ubuntu roda muito bem na maioria dos sistemas computacionais. Se A maioria dos computadores de hoje em dia
cumprem com os requerimentos listados aqui;
veja a documentação do seu computador ou o
website do fabricante para mais informações.

você não está certo se ele irá funcionar no seu computador, o Live  é
uma boa maneira de testar o sistema primeiro. Abaixo estão listadas as
especificações de hardware que o seu computador deve atender como
requisitos mínimos.

‣ Processador  GHz x (Pentium  ou melhor)
‣   de memória ()
‣   de espaço de disco (é recomendado no mínimo  )
‣ Suporte para vídeo capaz de operar resolução ×
‣ Suporte para áudio
‣ Uma conexão de Internet (altamente recomendável, mas não exigida)

Baixando o Ubuntu

O método mais fácil e comum para adquirir o Ubuntu é baixando a ima-
gem de  diretamente de http://www.ubuntu-br.org

‣ Baixar e instalar
‣ Experimente a partir de um  ou um dispositivo 
‣ Execute-o com o Windows

Baixe e instale / Experimente a partir de um CD ou dispositivo USB

Para as opções Baixar e instalar, ou Experimentar a partir de um  ou
dispositivo , selecione se você necessita da versão de -bits ou de -
bits (a de -bits é recomendada para a maioria dos usuários) e depois
clique em “Iniciar download.”

Instalar e executar lado a lado com oWindows.

Para a opção Executá-lo no Windows, basta selecionar “Iniciar Download,”
e seguir as instruções do Instalador do Ubuntu para Windows.

32-bit vs 64-bit

O Ubuntu e seus derivados estão disponíveis em duas versões:  bits e
 bits. Essa diferença se refere à maneira com que os computadores pro- 32 bits e 64 bits são os tipos de arquiteturas de

processadores. A maioria dos novos computa-
dores desktop possuem um processador de 64
bits.

cessam informações. Computadores capazes de executar sowares de 
bits podem processar mais informações do que computadores executando
sowares de  bits; porém, sistemas de  bits requerem mais memória
para fazê-lo. Apesar disso, estes computadores ganham em performance
por estar rodando sowares de  bits.

http://www.ubuntu-br.org
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‣ Se o seu computador tem um processador de  bits, instale a versão 
bits.

‣ Se o seu computador for mais velho, um netbook ou se você não souber
o tipo do processado do computador, instale a versão de  bits.

Se o seu computador tiver um processador de  bits, clique na opção
“ bits” antes de clicar em “Iniciar download”.

Baixar Ubuntu como um torrent

ando uma nova versão do Ubuntu é liberada, o servidors de download Torrents são uma forma de compartilhar
arquivos e informações pela Internet via
compartilhamento de arquivo peer-to-peer.
Um arquivo com a extensão .torrent é
disponibilizado aos usuários, que é então
aberto com um programa compatível tal como
uTorrent, Deluge, ou Transmission. Esses
programas baixam partes do arquivo de outras
pessoas por todo o mundo.

pode ficar “sobrecarregado” enquanto muitas pessoas tentam efetuar
download ou atualização de versão do Ubuntu ao mesmo tempo. Se você
tem familiaridade com o uso de torrents, pode baixar o arquivo torrent
clicando em “Dowloads alternativos,” e então em “BitTorrent download.”
Baixar via torrent pode melhorar a velocidade do seu download, e também
ajudará a espalhar o Ubuntu para outros usuários pelo mundo.

Gravando a imagem do CD

Uma vez que seu download foi terminado, existirá um arquivo chamado Apesar da versão de 64 bits do Ubuntu ser
referida como a versão ”AMD64”, ela irá
rodar em processadores Intel, AMD e outros
processadores compatíveis com 64 bits.

ubuntu-.-desktop-i.iso ou similar, o (i aqui no nome do arquivo
se refere à versão de  bits. Se você baixou a versão de  bits, o nome
do arquivo deverá conter amd). Esse arquivo é uma imagem de —um
snapshot dos conteúdos de um —que você precisa gravar em um .

Criando uma unidade USB inicializável

If your  is able to boot from a  stick, you may prefer to use a 
memory stick instead of burning a . Scroll down to “Burn your  or
create a  drive,” select  or  stick, choose the  you are using to
create the  drive, and then click Show me how. If you select the “
Stick” option, your installation will be running from the  memory
stick. In this case, references to Live , will refer to the  memory
stick.

Experimentando o Ubuntu

O  do Ubuntu e a unidade  funcionam não apenas como mídia de
instalação, mas também permitem que você teste o Ubuntu sem fazer
qualquer alteração permanente no seu computador, executando o sistema
operacional inteiro a partir do  ou da unidade .

Your computer reads information from a  at a much slower speed In some cases, your computer will not recog-
nize that the Ubuntu CD or USB is present as it
starts up and will start your existing operating
system instead. Generally, this means that
the priority given to boot devices when your
computer is starting needs to be changed.
For example, your computer might be set to
look for information from your hard drive, and
then to look for information on a CD or USB.
To run Ubuntu from the Live CD or USB, we
want the computer to look for information
from the appropriate device first. Changing
your boot priority is usually handled by BIOS
settings; this is beyond the scope of this guide.
If you need assistance with changing the boot
priority, see your computer manufacturer’s
documentation for more information.

than it can read information off of a hard drive. Running Ubuntu from the
Live  also occupies a large portion of your computer’s memory, which
would usually be available for applications to access when Ubuntu is
running from your hard drive. e Live / experience will therefore
feel slightly slower than it does when Ubuntu is actually installed on
your computer. Running Ubuntu from the / is a great way to test
things out and allows you to try the default applications, browse the
Internet, and get a general feel for the operating system. It’s also useful
for checking that your computer hardware works properly in Ubuntu and
that there are no major compatibility issues.

Para experimentar o Ubuntu utilizando o  ou unidade  Live,
insira o  do Ubuntu na unidade de , ou conecte o dispositivo  e
reinicie o computador.
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Depois que seu computador encontra o Live / conectado, e mos-
tra uma tela de carregamento, você será presenteado com a tela ”Bem-
Vindo”. Usando seu mouse, selecione seu idioma na lista à esquerda, então
clique no botão Testar Ubuntu. O Ubuntu será iniciado, executando dire-
tamente do dispositivo do live /.
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Figura 1.1: A tela “Bem-vindo” permite você
escolher o seu idioma .

Assim que o Ubuntu estiver funcionando, você verá a área de traba-
lho padrão. Falaremos mais sobre como usar o Ubuntu em Capítulo : O
Ubuntu Desktop, mas por enquanto, sinta-se à vontade para fazer alguns
testes. Abra alguns aplicativos, mude as configurações e explore de ma-
neira geral—quaisquer mudanças que forem feitas não serão salvas após
a sua saída, então não há necessidade de se importar em quebrar algo
acidentalmente.

When you are finished exploring, restart your computer by clicking Alternatively, you can also use your mouse to
double-click the “Install Ubuntu 12.04” icon
that is visible on the desktop when using the
Live CD. This will start the Ubuntu installer.

the “Power” buon in the top right corner of your screen (a circle with
a line through the top) and then select Restart. Follow the prompts that
appear on screen, including removing the Live  and pressing Enter
when instructed, and then your computer will restart. As long as the Live
 is no longer in the drive, your computer will return to its original state
as though nothing ever happened!

Instalando o Ubuntu—Introdução

At least   of free space on your hard drive is required in order to install Clicking on the underlined “release notes” link
will open a web page containing any important
information regarding the current version of
Ubuntu.

Ubuntu; however,   or more is recommended. is will ensure that
you will have plenty of room to install extra applications later on, as well
as store your own documents, music, and photos. To get started, place the
Ubuntu  in your  drive and restart your computer. Your computer
should load Ubuntu from the . When you first start from the , you
will be presented with a screen asking you whether you want to first try
out Ubuntu or install it. Select the language you want to view the installer
in and click on the Install Ubuntu buon. is will start the installation
process.

Se você tem uma conexão com a Internet, o instalador lhe perguntará
se você gostaria de ”Baixar atualizações ao instalar”. Recomendamos
que faça isto. A segunda opção, ”Instalar soware de terceiros”, inclui o
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codec  Fluendo, e programas necessários para algumas placas de rede
sem fio. Se você não está conectado à Internet, o instalador lhe ajudará a
configurar uma conexão de rede sem fio.

A tela “ Preparando para instalar o Ubuntu” também irá permitir que
você saiba se tem espaço em disco suficiente e, se você estiver conectado a
uma fonte de energia (no caso de você instalar o Ubuntu num computador
portátil que esteja usando uma bateria). Depois de selecionadas suas
escolhas, clique em Continuar.

Conexão de internet

Se você não está conectado a internet, o instalador irá pedir pra você
escolher uma rede wireless (se disponível). Recomendamos que se conecte durante a

instalação, embora as atualizações e software
de terceiros possam ser instalados após a
conclusão.

. Selecione Conectar a esta rede, e então selecione a sua rede a partir da
lista.

. Se a lista não aparecer imediatamente, espere até um triângulo/seta
aparecer próximo ao adaptador de rede, e então clique na seta para
visualizar as redes disponíveis.

. No campo Senha, digite a chave  ou  da rede (se necessário).
. Clique no Conecte para continuar.
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Figura 1.2: Configurar rede sem fio.

Alocar espaço da unidade

Este próximo passo é frequentemente chamado de partition. Particiona- Se você está instalando o Ubuntu em uma
nova máquina que não possui nenhum sistema
operacional, a primeira opção não estará
disponível. A opção de atualização só está
disponível se você está fazendo a atualização a
partir uma versão prévia do Ubuntu.

mento é o processo de alocar porções do seu disco rígido para um propó-
sito específico. Ao criar uma partition, você está essencialmente dividindo
o seu disco rígido em seções que serão usadas para diferentes tipos de
informação. O particionamento pode parecer complexo para um usuá-
rio novo; porém isso não necessariamente ocorrerá. De fato, o Ubuntu
provê algumas opções que simplificam significativamente esse processo.
O instalador do Ubuntu irá automaticamente detectar qualquer sistema
operacional existente instalado na sua máquina e apresentar opções de
instalação baseadas no seu sistema. As opções listadas abaixo dependem
do seu sistema específico e podem não estar disponíveis:
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‣ Instalar ao lado de outros sistemas operacionais
‣ Instalar dentro do Windows
‣ Atualizar o Ubuntu … para .
‣ Apagar… e instalar o Ubuntu
‣ algo mais

Instalar ao lado de outros sistemas operacionais.

Se você é um usuário de Windows ou Mac e está tentando instalar Ubuntu O Ubuntu fornece a você a opção de ou
substituir seu sistema operacional existente,
ou instalar o Ubuntu ao lado de seu sistema
existente. O último é chamado dual-booting.
Quando você ligar ou reiniciar seu computador,
terá a opção de selecionar qual sistema
operacional você quer usar para aquela sessão.

pela primeira vez, selecione a opção Instalar ao lado de outros sistemas
operacionais. Esta opção permitirá que você escolha qual sistema operaci-
onal você deseja usar quando seu computador iniciar. O Ubuntu automa-
ticamente detectará o outro sistema operacional e instalará o Ubuntu ao
lado dele.

Para configurações mais complicadas de dupla-inicialização, você precisará
configurar as partições manualmente.
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Figura 1.3: Escolha onde você gostaria de
instalar o Ubuntu.

Atualize o Ubuntu … para a versão 12.04

Esta opção irá manter todos os seus documentos, músicas, imagens e ou-
tros arquivos pessoais. Os programas instalados serão mantidos quando
possível (nem todos os programas atualmente instalados podem ser supor-
tados pela nova versão). As configurações de sistema serão apagadas.

Apagar o disco e instalar o Ubuntu

Utilize esta opção se você quer apagar o disco inteiro. Isto ira apagar os
sistemas operacionais que estão instalados no disco, como o Windows
, e instalar o Ubuntu em seu lugar. Esta opção também é útil se você
tem um disco vazio, uma vez que o Ubuntu criará para você as partições
necessárias automaticamente.

Formatar uma partição irá destruir todos os dados que estão atualmente nessa
partição. Certifique-se de efetuar uma cópia de segurança de todos os dados que
você deseja guardar antes de Formatar.
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Mais opções

is option is for advanced users and is used to create special partitions,

Ubuntu installs a home folder where your
personal files and configuration data are
located by default. If you choose to have your
home folder on a separate partition, then in
the event that you decide to reinstall Ubuntu
or perform a fresh upgrade to the latest
release, your personal files and configuration
data won’t be lost.

or format the hard drive with a file system different to the default one.
Depois de escolher o tipo de instalação, clique em Continuar, ou Insta-

Mais informações e instruções detalhadas
sobre o particionamento estão disponíveis
em: https://help.ubuntu.com/community/
HowtoPartition.

lar agora.

Confirmar as escolhas da partição e iniciar a instalação

Se você escolheu a opção Avançado, configure as partições que você pre-
cisa. Se estiver satisfeito com a maneira como as partições estão criadas,
clique no botão Instalar agora na parte inferior a direita para seguir em
frente.

Para reduzir o tempo necessário de instalação, o Ubuntu continuará
o processo de instalação em segundo plano enquanto você configura
importantes detalhes de usuário—como seu nome de usuário, senha,
configurações de teclado e fuso horário padrão.

Onde você está?

M I S S I N G S C R E E N S H O T
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Figura 1.4: Tell Ubuntu your location.

e next screen will display a world map. Using your mouse, click
your geographic location on the map to tell Ubuntu where you are. Al-
ternatively, you can use the drop-down lists underneath the map. is
allows Ubuntu to configure your system clock and other location-based
features. Click Forward when you are ready to move on.

Layout do teclado

A seguir, você precisa dizer ao Ubuntu que tipo de teclado você está
usando. Na maioria dos casos, você achara a opção sugerida satisfatória.
Se você não estiver certo de que opção de teclado selecionar, pode clicar o
botão Detectar Layout de Teclado para que o Ubuntu determine a escolha
correta te pedindo para pressionar uma série de teclas. Você também pode
escolher manualmente seu layout de teclado da lista de opções. Se quiser,
digite algum texto na caixa embaixo da janela para assegurar que esteja
feliz com sua seleção, então clique Continuar.

https://help.ubuntu.com/community/HowtoPartition
https://help.ubuntu.com/community/HowtoPartition
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Figura 1.5: Verifique se o layout de seu teclado
está correto.

Quem é você?

Ubuntu precisa saber algumas informações sobre você para que possa
configurar a conta do usuário principal no seu computador. ando
configurado, o seu nome aparecerá na tela de login, bem como no menu
do usuário, que discutiremos em Capítulo : O Ubuntu Desktop.

Nesta tela você precisará informar ao Ubuntu:

‣ seu nome
‣ como deseja chamar o seu computador
‣ seu nome de usuário desejado
‣ sua senha desejada
‣ como você quer que o Ubuntu inicie a sua sessão em

M I S S I N G S C R E E N S H O T
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Figura 1.6: Configurar sua conta de usuário.

Digite o seu nome completo abaixo de ”Seu nome?”. O próximo campo
é para o nome que o seu computador utiliza para terminais e redes. Você
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pode alterá-lo para o que quiser ou manter o nome predeterminado. A
seguir vem o seu nome, que é usado no menu do usuário, na sua pasta
pessoal e para uso interno. Você vai ver esse campo preenchido automa-
ticamente com o seu primeiro nome. A maioria das pessoas acha melhor
manter assim. Entretanto, ele pode ser alterado, se você preferir.

A seguir, escolha uma senha e a digite no campo de senha à esquerda,
e repita a digitação no campo de senha à direita. ando as duas senhas
digitadas forem iguais, uma avaliação de complexidade de senha vai apa-
recer à direita que indicará que sua senha é “muito curta”, “fraca”, “boa”
ou “forte”. Você poderá continuar o processo de instalação independente
da qualidade da sua senha, mas por motivos de segurança é melhor es-
colher uma senha forte. Para isto deve-se escolher uma senha com pelo
menos  caracteres, composta por uma mistura de letras maiúsculas e mi-
núsculas, números e símbolos. Evite escolher senhas óbvias que incluam
sua data de aniversário, nome do cônjuge ou o nome do seu animal de
estimação.

Opções de login

Finalmente, na parte inferior da tela existirão três opções para escolher
como você deseja iniciar a sessão no Ubuntu.

‣ Iniciar sessão automaticamente
‣ Solicitar minha senha para entrar
‣ Criptografar minha pasta pessoal

Iniciar sessão automaticamente

O Ubuntu vai entrar automaticamente na sua conta principal quando
você iniciar o computador, então você não terá que digitar seu nome de
usuário e senha. Isto torna a sua experiência em iniciar sessão mais rápida
e conveniente, mas se privacidade ou segurança são importantes para
você, essa opção não é recomendada. alquer um que possa acessar
fisicamente o seu computador será capaz de ligá-lo e também acessar seus
arquivos.

Solicitar minha senha para iniciar sessão

Esta opção é selecionada por padrão, uma vez que irá impedir que pessoas
não autorizadas acessem seu computador sem saber a senha que você
criou anteriormente. Esta é uma boa opção para aqueles que, por exemplo,
compartilham o computador com outros membros da família. Uma vez
que o processo de instalação foi concluída, uma conta adicional de login
pode ser criada para cada membro da família. Cada pessoa terá então o
seu próprio nome de login e senha, preferências de conta, favoritos da
Internet e espaço de armazenamento pessoal.

Criptografar minha pasta pessoal

Esta opção provê a você uma nova camada de segurança. Seu diretó-
rio home é onde os seus arquivos pessoais são gravados. Selecionando
esta opção, o Ubuntu irá automaticamente habilitar a criptografia do seu
diretório home, o que significa que os arquivos e diretórios devem ser
descriptografados usando a sua senha antes deles poderem ser acessados.
Por isso, se alguém tiver acesso físico ao seu disco rígido (por exemplo,
se seu computador foi roubado e teve seu disco rígido removido), ele não
conseguirá ver seus arquivos sem saber sua senha.
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Se você escolher essa opção, tome cuidado para não habilitar o login automático
em uma data posterior. Isso causará complicações com o seu diretório home
criptografado e potencialmente bloqueará o acesso a arquivos importantes.

FInalizando a instalação

Ubuntu will now finish installing on your hard drive. As the installation
progresses, a slideshow will give you an introduction to some of the
default applications included with Ubuntu. ese applications are covered
in more detail in Capítulo : Trabalhando com o Ubuntu. e slideshow
will also highlight the Ubuntu support options:

M I S S I N G S C R E E N S H O T
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Figura 1.7: Ubuntu community support
options. Where to get help for Ubuntu.

Após cerca de vinte minutos, a instalação será concluída e você será
capaz de clicar em Reiniciar agora para reiniciar o seu computador e
iniciar o Ubuntu. O  será ejetado, retire o  do drive e pressione Enter
para continuar.

Aguarde enquanto o computador reinicia, e então você verá a janela de
login (a não ser que você tenha selecionado o login automático).
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Figura 1.8: Agora você está pronto para
reiniciar seu computador.
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Tela de login

Aer the installation is over and the computer is restarted, you will be
greeted by the login screen of Ubuntu. e login screen uses LightDM
which is a light on resources and easy to customize display manager. e
login screen will present you with your username and you will have to
enter the password to get past it. Click your username and enter your
password. Once done, you may click the arrow or press Enter to get
into the Ubuntu desktop. Ubuntu’s login screen supports multiple users
and also supports custom backgrounds for each user. In fact, Ubuntu
automatically will pick up your current desktop wallpaper and set it
as your login background. Ubuntu’s login screen also lets you select
the different environments to login. In a default Ubuntu installation,
you will have two environments; Ubuntu and Ubuntu-D. If you want
to login to Ubuntu-D, click on the Ubuntu icon and select Ubuntu-D
from the list and then enter your password to login. e login screen A guest session is also available at the login

screen. You can activate this session for guests
using your laptop or desktop.

allows you to update your keyboard language, volume intensity and
enable/disable accessibility seings before you log in to your desktop. It
also displays date/time and baery power for laptops. You can also shut
down or restart your system from the login screen.
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Figura 1.9: Login Screen.

Instalador do Ubuntu para Windows

Você pode instalar e rodar o Ubuntu juntamente com sua instalação atual
do Windows:

. Baixar o instalador Ubuntu para Windows http://www.ubuntu.com/
download/ubuntu/windows-installer

. Executar o arquivo baixado
. Instalar Ubuntu

Baixar e executar o instalador

Após o arquivo wubi.exe ser baixado, execute-o para iniciar a instalação.
Se uma mensagem de segurança aparecer, clique em Continuar, para
prosseguir com a instalação:

http://www.ubuntu.com/download/ubuntu/windows-installer
http://www.ubuntu.com/download/ubuntu/windows-installer
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Figura 1.10: Tela de controle de contas de
usuário

Instalação

e Ubuntu Installer will start. Choose and enter a “Username” and “Pas-
sword.” e password must be entered twice to ensure accuracy. Aer
choosing a password, click Install. e Ubuntu Installer will download
and install Ubuntu. is process will take some time. e download file
size is Mb. Aer the installation is complete, click Finish on the
“Completing the Ubuntu Setup Wizard” screen to reboot the computer.
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Figura 1.11: Ubuntu Windows Installer

Instalação concluída

Após o seu computador reiniciar, você pode selecionar ”Ubuntu” no menu
de inicialização. Sua sessão no Ubuntu será iniciada e você será apresen-
tado ao sua nova área de trabalho!



2 O Ubuntu Desktop

Entendendo o Ubuntu Desktop

Initially, you may notice many similarities between Ubuntu and other Ubuntu 12.04 places an emphasis on “social
from the start” and features social network
integration in the desktop for sites like Twitter
and Facebook.

operating systems, such as Microso Windows or Mac  . is is be-
cause they are all based on the concept of a graphical user interface ()
—i.e., you use your mouse to navigate the desktop, open applications,
move files, and perform most other tasks. In short, things are visually-
oriented. is chapter is designed to help you become familiar with va-
rious applications and menus in Ubuntu so that you become confident in
using the Ubuntu .
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Figura 2.1: The Ubuntu 12.04 default desktop.

Unity

Toda base de sistemas opetacionais  usam um ambiente de trabalho.
Ambientes de trabalho englobam muitas coisas, como:

‣ A aparência e o comportamento do seu sistema
‣ A maneira como a área de trabalho é definida
‣ Como o usuário navega pela área de trabalho

Em distribuições linux (tal como o Ubuntu), uma série de ambientes de Para ler mais sobre outras variantes do
Ubuntu, veja Capítulo 8: Aprendendo mais.trabalho estão disponíveis. O Ubuntu usa o Unity como ambiente de tra-

balho padrão. Após instalar e iniciar sessão no Ubuntu, você verá a área
de trabalho do Unity. A visão inicial inclui o O plano de fundo da área de
trabalho e duas barras—onde uma é localizada horizontalmente no topo
da sua área de trabalho e é chamada A Barra de Menu, e a outra barra
está orientada verticalmente e está no canto esquerdo, sendo chamada the
Launer.
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Unity comes in two versions—Unity D and Unity D. By default, Ubuntu
installs the Unity D interface. is interface is a graphic intensive desktop
interface allowing for smooth transitions, stacking icons in the Launcher, and
transparent utility and shell windows, to name a few features. Unity D is a
less-graphic-intensive shell interface—equal in comparsion to its “big brother”.
Unity D is available as an additional download. Although the two variants of
Unity may show slight differences in the “look and feel” of the desktop, Unity
does not impact the functionality of the application or utility being displayed.
e details of how Unity came to replace GNOME, features of the Unity in-
terface, and how to install both types, can be found by searching Unity user
interface at http://en.wikipedia.org

.

O plano de fundo da área de trabalho

Abaixo da barra de menu existe uma imagem que cobre a área de trabalho
inteira. Este é o plano de fundo da área de trabalho, ou papel de parede,
ele pertece ao tema do Ubuntu . conhecido como Ambiance. Para
aprender mais sobre customização de sua área de trabalho (incluindo
mudar o seu plano de fundo), veja a seção em Personalizando a sua área
de trabalho baixo.

A Barra de Menu

e menu bar incorporates common functions used in Ubuntu .. e
icons on the far-right of the menu bar are called the indicator area. Each
installation of Ubuntu may contain slightly different types and quantities
of icons based on a number of factors, including type of hardware and
available on-board accessories. e most common indicators are (starting
from the le): For more about:

‣ the Messaging Indicator see Micro-
blogging;

‣ the Network Indicator see Obtendo
on-line;

‣ the Session Indicator see Opções de
sessão.

Indicador do teclado allows you to select the keyboard layout you would
like and change your keyboard preferences.

The keyboard indicator only shows when you
have chosen more than one keyboard layout in
the keyboard settings during installation.

Indicador de mensagens incorpora todos os seus aplicativos sociais. Por
aqui, você pode acessar seu cliente de mensagens instantâneas, o seu
cliente de e-mail, seu aplicativo de microblog, e até mesmo sua nuvem
pessoal, UbuntuOne!

Indicador de conexões permite você administrar suas conexões de rede e
conectar de maneira rápida e fácil à uma rede com fio ou sem fio.

Indicador de som provê uma forma fácil de ajustar o volume do som e
também acessar seu reprodutor de músicas e configurações de som.

Relógio mostra o horário atual e provê uma forma fácil de acessar o seu
calendário e suas configurações de data e hora.

User menu permite alternar facilmente entre diferentes usuários e acessa
às suas contas online e de usuário.

Indicador de sessão provê uma forma fácil de acessar Configurações do
sistema, Atualizações disponíveis, Impressoras e opções de sessão para
bloquear seu computador, encerrar sua sessão, reiniciar o computador
ou desligar completamente.

M I S S I N G S C R E E N S H O T
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Figura 2.2: The Indicators of the menu bar.

Every application has a menuing system where different actions can
be executed in an application (like File, Edit, View, etc.); the menuing
system for an application is appropriately called the application menu.
In Unity, the application menu isn’t on the titlebar of the application as is
commonly the case with other  environments. Instead, it is located to

Note that some older applications may still
display their menu within the application
window.

the le area of the menu bar. To show an application’s menu, just move
your mouse to the Ubuntu desktop’s menu bar. While your mouse is

http://en.wikipedia.org
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positioned here, the active application’s menus will superimpose itself
over the Ubuntu desktop’s menu bar, allowing you to use the application’s
menus. Moving your mouse away from the menu bar will allow Ubuntu
desktop’s menu bar to reappear. is capability of Unity to only show the
application’s menu when needed is especially beneficial for netbook and
laptop users as it provides you with more free work space.

O Lançador
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Figura 2.3: The Ubuntu 12.04 Launcher on the
left with a sample of applications on it.

e vertical bar of icons on the le side of the screen is called the
Launcher. e Launcher provides easy access to applications, mounted
devices, and the Trash. All running applications on your system will place
an icon in the Launcher while the application is running. e first icon at
the top of the Launcher is the Dash, a major innovation and core element
of Unity—we will explore the Dash in a later section of this chapter. By
default, other applications appear on the Launcher, including applications
such as LibreOffice and Firefox, the workspace switer lens, any moun-
ted devices, and, of course, the always-important Trash lens at the boom
of the Launcher. workspace switcher helps you to select the

workspace or the window you want. Trash
contains deleted files.

Tip: Pressing Super+Swill show the content of
the workspaces on one screen.

Usando o Lançador

Executando aplicativos

To run an application from the Launcher (or cause an already-running If you hold the Super key, a number will appear
on each of the first ten applications, along
with a margin containing useful shortcuts. You
can launch an application with a numbern on
it by typing Super+n.

application to appear), just click on the application’s icon. Running ap-
plications will have one or more triangles on the le side of its icon,
indicating the number of application windows open for this application.
e application in the foreground (meaning on top of all other open appli-
cation windows) is indicated by a single white triangle on the right side of
its icon. You can also run an application through the Dash. We will talk
about the Dash, in the O Painel section.

Adicionando e removendo aplicativos do Lançador

Existem duas maneiras de adicionar um aplicativo no Lançador:
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Figura 2.4: Logo abaixo do ícone ”Pasta
pessoal”, você verá o ícone do Firefox. Perceba
que o triângulo no canto direito está indicando
que o aplicativo está no primeiro plano
(no topo de todos os outros aplicativos) e
o triângulo no canto esquerdo indica que
existe uma janela associada com o Firefox no
momento.

‣ Abra o Painel, encontre o aplicativo para adicionar, e arraste para o
lançador e solte

‣ Execute o aplicativo desejado para adicioná-lo ao Lançador, clique
com o botão direito no ícone do aplicativo no Lançador e selecione
Bloquear no lançador.

Para remover um aplicativo do Lançador, clique com o botão direito no
ícone do aplicativo e selecione Desbloquear do lançador.

O Painel

e Dash is a tool to help you access and find applications and files on The Dash allows you to search for information,
both locally (installed applications, recent files,
bookmarks, etc.) as well as remotely (Twitter,
Google Docs, etc.). This is accomplished by
utilizing one or more lenses, each responsible
for providing a category of search results for
the Dash. For more information about the
Dash and its lens, see: https://wiki.ubuntu.
com/Unity

your computer quickly. If you are a Windows user, you’ll find the Dash to
be a more advanced Start Menu. If you are a Mac user, the Dash is similar
to Launchpad in the dock. If you’ve used a previous version of Ubuntu
or another  Linux distribution, the Dash replaces the  
menus. To explore the Dash, click on the top-most icon on the Launcher;
the icon has the Ubuntu logo on it. Aer selecting the Dash icon, another
window will appear with a search bar on the top as well as grouping
of recently accessed applications, files, and downloads. e search bar
provides dynamic results as you enter your search terms. e five lenses
at the boom are links to your Home lens, Applications lens, Files lens, and
Music and Videos lenses. Lenses act as specialized search categories in the
Dash.

Procurar por arquivos e aplicativos com o Painel

O Painel é uma ferramenta extremamente poderosa que permite que você
procure em seu sistema inteiro por aplicativos e arquivos baseados nos
seus termos de pesquisa.

Encontrar arquivos/pastas

Dash can help you find the names of files or folders. Simply type in what
you remember of the name of the file or folder, and as you type, results
will appear in the Dash. e Files lens can also assist you in finding files

https://wiki.ubuntu.com/Unity
https://wiki.ubuntu.com/Unity
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Figura 2.5: The Dash

or folders. e Files lens shows you the most recent files accessed, as well
as recent downloads. You can use the filter results buon in the top-right
corner of the Dash to filter results to your requirements by file or folder
modification times, by file type (.odt, .pdf, .doc, .tex., etc.), or by size.

Encontrar aplicativos

e standard Ubuntu installation comes with many applications. Users
can also download thousands more applications from the Ubuntu So-
ware Center. As you collect an arsenal of awesome applications (and get Ubuntu Software Center and software

management will be discussed in detail at
Capítulo 5: Gerenciamento de Programas.

a bonus point for alliteration!), it may become difficult to remember the
name of a particular application. Simply use the Application lens on the
Dash. is lens will automatically categorize installed applications under
“Recently Used,” “Installed,” or “Apps Available for Download.”You can If you are new to the world of Ubuntu, be sure

to read the Capítulo 3: Trabalhando com o
Ubuntu. It will provide you help in choosing
the application(s) that suit your needs.

also enter a name of the application (or a part of it), in the search bar in
the Dash, and the names of applications matching your search criteria will
appear. Even if you don’t remember the name of the application at all,
type a keyword that is relevant to that application, and the Dash will find
it. For example, type music, and the Dash will show you the default music
player any any music player you’ve used).

Espaços de trabalho

Espaços de trabalho são também conhecidos como áreas de trabalho virtu-
ais. Essas visões separadas de sua área de trabalho lhe permitem agrupar
aplicativos, e fazendo isto, ajudam a reduzir o excesso de elementos numa
mesma tela e melhoraram sua navegação na área de trabalho. Por exem-
plo, em um espaço de trabalho, você pode abrir todos seus aplicativos
de mídia; sua suíte de escritório em outra, e seu navegador web em um
terceiro espaço de trabalho. Ubuntu tem quatro espaços de trabalho por
padrão.

Alternando entre espaços de trabalho

Para alternar entre espaços de trabalho, clique no alternador de espaços
de trabalho localizado no Lançador. Este utilitário ajuda alternar entre
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Figura 2.6: You can see the default results
when you press Application lens, and also the
criteria on the right side.

as áreas de trabalho (se eles possuem aplicativos abertos ou não), e então
escolha o que você deseja usar.

Gerenciando janelas

When opening a program in Ubuntu (such as a web browser or a text edi-
tor—see Capítulo : Trabalhando com o Ubuntu for more information on
using applications)—a window will appear on your desktop. e windows
in Ubuntu are very similar to those in Microso Windows or Mac  .
Simply stated, a window is the box that appears on your screen when
you start a program. In Ubuntu, the top part of a window (the titlebar)
will have the name of the application to the le (most oen, the title will
be the name of the application). A window will also have three buons
in the top-le corner. From le to right, these buons represent close,
minimize window, and maximize window. Other window management
options are available by right-clicking anywhere on the title bar.

Fechando, maximizando, restaurando e minimizando janelas

To close a window, click on the in the upper-le corner of the window
—the first buon on the le-hand side. e buon immediately to the
right of the is the minimize buon ( ) which removes the window
from the visible screen and places it in the Launcher. is buon doesn’t
close the application, it just hides the application from view. When an
application is minimized to the Launcher, the le-side of the icon in the
Launcher will display a triangle showing you the application is still run-
ning. Clicking the icon of the application that is minimized will restore
the window to its original position. Finally, the right-most buon ( ) is
the maximizar buon, which makes the application window fill the entire
screen. Clicking the maximizar buon again will return the window to its
original size. If a window is maximized, its top-le buons and menu are
automatically hidden from view. To make them appear, just move your
mouse to the menu bar.
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Figura 2.7: This is the top bar of a window,
named titlebar. The close, minimize, and
maximize buttons are on the top-left corner of
window.

Movendo e redimensionando as janelas

Para mover a janela pelo espaço de trabalho, posicione o ponteiro do Você também pode mover uma janela segu-
rando a tecla Alt e arrastando a janela.mouse sobre a barra de título da janela, e então clique e arraste enquanto

continua a segurar o botão esquerdo do mouse. Para redimensionar uma
janela, posicione o ponteiro do mouse em um canto ou quina da janela
para que o ponteiro se transforme em uma seta maior de dois lados (co-
nhecida como ícone de redimensionamento). Você pode então clicar e
arrastar para redimensionar a janela
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Figura 2.8: O alternador de espaços de trabalho
no Lançador.

Alternando entre janelas abertas

In Ubuntu there are many ways to switch between open windows.

Super key is also known as the Windows key
(Win key). Press Super+D to hide all window
and display the desktop, the same works to
restore all windows.

. Se a janela está visível na sua tela, você pode clicar em qualquer parte
dela para fazê-la se elevar acima de todas as outras janelas.

. Use Alt+Tab para selecionar a janela que você deseja trabalhar. Se-
gure a tecla Alt, continue pressionando Tab até que a janela que você
procura apareça na popup.

. Clique no ícone correspondente no Lançador. Mova o seu mouse para
o lado esquerdo da sua tela para visualizar o Lançador, e clique com o
botão direito no ícone do aplicativo. Se o aplicativo possuir múltiplas
janelas abertas, clique duplamente no ícone para selecionar a janela
desejada.

Movendo uma janela para uma área de trabalho diferente

Para mover uma janela para uma área de trabalho diferente, esteja certo
que a janela não está maximizada. Se ela estiver maximizada, clique com
o botão direito no lado esquerdo da barra de título para restaurá-la ao seu
tamanho original. Então clique com o botão direito na barra de título da
janela e selecione:

‣ Mover para a área de trabalho à esquerda, para mover a janela para a
área de trabalho à esquerda

‣ Mover para a área de trabalho à direita, para mover a janela para a
área de trabalho à direita
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‣ Mover para outra área de trabalho, e então escolha a área de trabalho
para a qual você deseja mover a janela.

Janela sempre no topo ou na área de trabalho visível

At times, you may want to have a window always on top so that it can be
seen or monitored while you work with other applications. For example,
you may want to browse the web and, at the same time, view and answer
to any incoming instant message. To keep a window on top, right-click
on the window’s titlebar, then select Always On Top. Note that this
window will be on the top of all windows that are opened in the current
workspace. If you want to have a window always on the top regardless of
the workspace, right-click on the window’s titlebar, then select Always on
Visible Workspace. is window will now be on top of all other windows
across all workspaces.

Buscando arquivos no seu computador

Há duas maneira de localizar arquivos no seu computador—pesquisar Você pode abrir a sua pasta pessoal a partir do
lançador.por eles ou acessá-los diretamente nas suas pastas. Você pode pesquisar

por um arquivo via Painel ou Arquivos & Pastas no Lançador. Você pode
usar também a ferramenta Arquivos & Pastas para acessar as pastas
mais utilizadas (como Documentos, Música, Downloads), bem como os
arquivos acessados mais recentemente.

Ir

To access Go, move your mouse over the top bar and select Go. You can If you do not see the desktop menu, click
somewhere on the desktop and it will appear.browse the files on your computer by clicking Computer in this menu. If

you set up a home network, you will find a menu item to access shared
files or folders.

Sua pasta pessoal

O diretório pessoal é usado para gravar seus arquivos pessoais. Seu dire-
tório pessoal tem o mesmo nome da sua conta de usuário. ando você
abrir seu diretório pessoal, você verá que existem muitos diretórios dentro
dele, incluindo: Área de Trabalho (que contém todos os arquivos que estão
visíveis na área de trabalho), Documentos, Downloads, Música, Imagens,
Público, Modelos e Vídeos. Eles são criados automaticamente durante o
processo de instalação. Você pode adicionar mais arquivos e diretórios
quando quiser à qualquer hora.

Gerenciador de arquivos Nautilus

Assim como o Windows possui o Windows Explorer e o Mac   possui
o Finder para navegar entre arquivos e diretórios, o Ubuntu usa o gerenci-
ador de arquivos Nautilus por padrão.

A janela do gerenciador de arquivos Nautilus

ando você seleciona o atalho Pasta pessoal no Lançador, ou clica em
um diretório no Painel, ou clica duplamente em um diretório na área de
trabalho, uma janela do gerenciador de arquivos Nautilus se abrirá. A
janela padrão contém as seguintes funcionalidades:
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barra de menu A barra de menu que está localizada no topo da tela é
chamada de menu global. Esses menus permitem que você modifique
o layout do seu navegador, navegue, adicione aos favoritos diretórios e Se você adicionar um diretório aos favoritos,

ele irá aparecer no menu Favoritos e no painel
esquerdo.

arquivos frequentemente usados, e veja diretórios e arquivos ocultos.
barra de título A barra de título mostra o nome do diretório atualmente

selecionado. Ela também contém os botões Fear, Minimizar e Maxi-
mizar.

toolbar e toolbar contains tools for navigation. On the right is the
search icon (which looks like a magnifying glass); clicking on this icon
opens a field so you can search for a file or folder by name. Just below If you start typing a location in the toolbar

starting with a / character, Nautilus will
automatically change the navigation buttons
into a text field labeled Location. It is also
possible to convert the navigation buttons into
a text field by pressing Ctrl+L.

the toolbar, you will see a representation of your current browsing.
is is similar to the history function in most browsers; it keeps track
of where you are and allows you to backtrack if necessary. You can
click on the locations to navigate back through the file browser.

painel esquerdo O painel esquerdo do navegador de arquivos tem atalhos
para as pastas mais utilizadas. ando uma pasta estiver marcada, ela
aparece no painel esquerdo. Não importa que pasta esteja aberta, o pai-
nel esquerdo sempre irá conter as mesmas pastas. Este painel esquerdo
pode ser alterado para exibir diferentes recursos (como informações,
árvore, histórico, etc.) clicando na seta para baixo ao lado de ”Locais”,
no topo.

painel central O maior painel mostra os arquivos e diretórios no diretório
que você está atualmente.

M I S S I N G S C R E E N S H O T

ss:nautilus-home

The file screenshots/pt_BR/02-homefolder.png does not exist!

Figura 2.9: Gerenciador de arquivos Nautilus
mostrando a sua Pasta pessoal.

Navegando no Nautilus

Para navegar entre as pastas, use os marcadores no painel esquerdo do O que é um diretório? Ou uma pasta? Um
diretório é uma divisão do espaço em um
sistema de arquivos que você pode usar para
organizar arquivos. Uma pasta é um nome
dado a um diretório em um ambiente de
interface gráfica do usuário (GUI) como o
Nautilus.

gerenciador de arquivos Nautilus. Você pode também retornar seus passos
clicando no nome de uma pasta na barra de caminho. Dê um clique duplo
sobre uma pasta visível para navegar nela.

Abrindo arquivos

Um arquivo, na sua forma mais simples, são dados. Dados podem repre-
sentar um documento de texto, uma informação de banco de dados ou
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podem ser usados para produzir música ou vídeo. Para abrir um arquivo,
você pode ou clicar duplamente em seu ícone ou clicar com o botão direito
e selecionar uma das opções de Abrir com. O Ubuntu tenta determinar
qual aplicativo usar para o arquivo que está sendo aberto e, na maior parte
do tempo, ele escolhe corretamente. Porém, se você deseja abrir um ar-
quivo usando um aplicativo diferente do que está selecionado, escolha
Abrir com outro aplicativo. Uma seleção de aplicativos instalados irá
aparecer. Faça sua seleção e o arquivo irá abrir o aplicativo desejado.

Criando novas pastas

Para criar um novo diretório com o Nautilus, clique em Arquivo ‣Criar
nova pasta. Então, o nome do diretório deverá ser substituído do padrão
”Pasta sem título” para o rótulo desejado (e.g., ”Finanças pessoais”). Você
também pode criar um novo diretório pressionando Ctrl+Shift+N ou
clicando com o botão direito na janela do navegador de arquivos e seleci-
onando Criar nova pasta no menu pop-up (esta ação também funcionará
na área de trabalho).

Arquivos e pastas ocultos

Se você deseja ocultar alguns diretórios ou arquivos, digite um ponto(.) na Você pode facilmente visualizar arquivos
ocultos, clicando em Ver ‣Mostrar arquivos
ocultos ou pressionando Ctrl+H. Arquivos
ocultos com um ponto(.) não são uma medida
de segurança—eles simplesmente providen-
ciam uma maneira de manter os diretórios
organizados e arrumados.

frente do nome (e.g., ”.Finanças pessoais”). Em alguns casos é impossível
de ocultar arquivos e diretórios sem digitar um ponto na frente de seus
nomes. Ao abrir o Nautilus, o diretório não estará mais visível.

Copiando e movendo arquivos e pastas

You can copy files or folders in Nautilus by clicking Edit ‣Copy, or by You can also use the keyboard shortcuts
Ctrl+X, Ctrl+C and Ctrl+V to cut, copy, and
paste (respectively) files and folders.

right-clicking on the item and selecting Copy from the popup menu.
When using the Edit menu in Nautilus, make sure you’ve selected the
file or folder you want to copy first (by le-clicking on it once). Multiple
files can be selected by le-clicking in an empty space (i.e., not on a file or
folder), holding the mouse buon down, and dragging the cursor across
the desired files or folders. is “click-drag” move is useful when you
are selecting items that are grouped closely together. To select multiple
files or folders that are not positioned next to each other, hold down
the Ctrl key while clicking on each item individually. Once multiple
files and/or folders are selected, you can use the Edit menu to perform
actions just like you would for a single item. When one or more items When you “cut” or “copy” a file or folder,

nothing will happen until you “paste” it
somewhere. Paste will only affect the most
recent item that was cut or copied.

have been “copied,” navigate to the desired location then click Edit ‣ Paste
(or right-click in an empty area of the window and select Paste) to copy
them to the new location. While the copy command can be used to make In the Nautilus Editmenu, you will also find

the Copy To andMove To buttons. These can
be used to copy or move items to common
locations and can be useful if you are using
panes (see below). Note that it is unnecessary
to use Pastewhen using these options.

a duplicate of a file or folder in a new location, the cut command can be
used to move files and folders around. at is, a copy will be placed in a
new location, and the original will be removed from its current location.
To move a file or folder, select the item you want to move then click Edit ‣
Cut. Navigate to the desired location, then click Edit ‣ Paste. As with If you click on a file or folder, drag it, and then

hold down the Alt key and drop it to your
destination folder, a menu will appear asking
whether you want to copy, , move, or link the
item. Notice that the symbol of the mouse
cursor changes from an arrow into a question
mark as soon as you hold down the Alt key.

the copy command above, you can also perform this action using the
right-click menu, and it will work for multiple files or folders at once. An
alternative way to move a file or folder is to click on the item, and then
drag it to the new location.

Usando múltiplas abas e múltiplas janelas do Nautilus

Opening multiple Nautilus windows can be useful for dragging files and
folders between locations. e option of tabs (as well as panes) is also
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available in Nautilus. To open a second windows when browsing a folder When dragging items between Nautilus
windows, tabs, or panes, a small symbol will
appear over the mouse cursor to let you
know which action will be performed when
you release the mouse button. A plus sign
(+) indicates you are about to copy the item,
whereas a small arrow means the item will be
moved. The default action will depend on the
folders you are using.

in Nautilus, select File ‣New Window or press Ctrl+N. is will open
a new window, allowing you to drag files and/or folders between two
locations. To open a new tab, click File ‣New Tab or press Ctrl+T. A new
row will appear above the space used for browsing your files containing
two tabs—both will display the directory you were originally browsing.
You can click these tabs to switch between them to click and drag files
or folders between tabs the same as you would between windows. You
can also open a second pane in Nautilus so you can see two locations
at once without having to switch between tabs or windows. To open
a second pane, click View ‣Extra Pane, or press F3 on your keyboard.
Again, dragging files and folders between panes is a quick way to move or
copy items.

Pesquisando arquivos e pastas em seu computador

Você pode procurar por arquivos ou diretórios usando o Painel ou o Nau- Pesquise rapidamente por arquivos e pastas
pressionando Ctrl+F no Nautilus e, então,
digitando o que você deseja encontrar.

tilus.

Pesquisar usando o Painel

No Painel, simplesmente digite os termos de busca na barra de pesquisa
no topo do Painel.

Pesquisar usando o Nautilus

No Nautilus, clique em Ir ‣ Pesquisar por arquivos… ou pressione Ctrl+F.
Isso irá abrir um campo de pesquisa onde você pode digitar o nome do
arquivo ou diretório que você quer encontrar.

Personalizando a sua área de trabalho

M I S S I N G S C R E E N S H O T
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Figura 2.10: You can change most of your
system’s settings here.

One of the advantages to a windowed environment through Unity is
the ability to change the look and feel of your desktop. Don’t like the
default Ubuntu theme? Do you have a picture of your third cousin’s
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aunt’s uncle’s nephew’s pet chihuahua that you’d love to see on your
desktop as wallpaper? All of this (and more) is possible through desktop
customizations in Unity. Most customizations can be reached via the
Session Indicator and then selecting System Settings to open the System
Seings application window. e Dash, desktop appearance, themes,
wallpapers, accessibility, and other configuration seings are available
here. For more information see Opções de sessão.

Aparência

M I S S I N G S C R E E N S H O T
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Figura 2.11: Você pode mudar o tema na aba
Aparência da janela “Aparência”.

Você pode mudar o plano de fundo, fontes e tema para modificar a
aparência e comportamento do seu ambiente de trabalho. Para começar,
abra Aparência ou clicando com o botão direito no seu plano de fundo
e selecionando Alterar plano de fundo, ou selecionando Indicador de
sessão ‣Configurações do sistema… ‣Aparência.

Tema

A janela “Aparência” mostrará o plano de fundo e tema atualmente sele-
cionados. Os temas controlam a aparência de suas janelas, botões, barras
de rolagem, painéis, ícones e outras partes do seu ambiente de trabalho.
O tema Ambiance é usado por padrão, mas existem outros que você pode
escolher. Apenas clique em algum dos temas listados para testar um novo.
O tema irá mudar a aparência do seu ambiente de trabalho imediatamente.

Plano de fundo da área de trabalho

Under Baground, you may choose from Wallpapers, Pictures Folder,
and Colors and Gradients. When Wallpapers is selected, you will see
Ubuntu’s default selection of backgrounds. To change the background
simply click the picture you would like to use. You’re not limited to this
selection though. To use one of your own pictures, click the +… buon,
and navigate to the image you would like to use, double-click the image,
and the change will take effect immediately. is image will then be
added to your list of available backgrounds. If you want to choose from a
larger selection of desktop backgrounds, click the “Get More Backgrounds
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Online” link at the boom of the ”Appearance Preferences” window. is
link will open your web browser, and direct you to the http://art.gnome.
org/backgrounds website.

Acessibilidade

Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can find these tools by opening the
Dash and searching for “Universal Access.” On the Seeing tab you can
manage the text size, the contrast of the interfaces, enable a zoom tool and
even a screen reader. Selecting high-contrast themes and larger on-screen
fonts can assist those with vision difficulties. You can activate “Visual
Alerts” though the Hearing tab, if you have hearing impairment. Also you
can adjust keyboard and mouse seings to suit your needs through the
Typing and Pointing and Cliing tabs respectively.

M I S S I N G S C R E E N S H O T

ss:universal-access

The file screenshots/pt_BR/02-universal-access.png does not exist!

Figura 2.12: Universal allows you to enable
extra features to make it easier to use your
computer.

Orca leitor de telas

Orca is a useful tool for people with visual impairments. Orca comes
preinstalled in Ubuntu. To run Orca, click on the Dash in the Launcher
and type Orca, and click on the displayed result. Orca is the ”Screen Re-
ader” part of Universal Access and can be launched once the “Screen
Reader” is activated. Orca’s voice synthesizer will activate and assist you
through the various options such as voice type, voice language, Braille,
and screen magnification. Once you have finished selecting your seings,
you will need to log out of the computer (Orca will offer to do this for
you). When you log back in, the Orca seings you selected will automati-
cally run every time you use your computer.

Opções de sessão

ando você terminar de trabalhar no seu computador, você pode esco-
lher finalizar sessão, suspender, reiniciar ou desligar através do Indicador
de Sessão que está no canto direito do painel do topo.

http://art.gnome.org/backgrounds
http://art.gnome.org/backgrounds
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Encerrando a sessão

Encerrar a sessão irá deixar o computador funcionando e retornar para a
tela de início de sessão. Isto é útil para alternar usuários, quando pessoas
diferentes querem acessar suas contas, ou quando você for solicitado a
”reiniciar a sessão”. Você também pode reiniciar a sessão pressio-

nando as teclas Ctrl+Alt+Del.
Antes de encerrar a sessão, você deve sempre
verificar se seus trabalhos em aplicativos
abertos estão salvos.

Suspender

Para economizar energia, você pode colocar o seu computador no modo
suspenso, no qual ele salva a condição atual na memória interna, desliga
todos os dispositivos e permite que você inicie novamente de forma mais
rápida. Enquanto estiver no estado suspenso, o computador irá usar
somente um pouquinho de energia; ela é necessária porque a sessão está
sendo salva na memória interna, e caso nenhuma energia flua na memória
interna, os dados serão perdidos.

Reiniciando

Para reiniciar seu computador, selecione Desligar… do ”Indicador de
Sessão” e clique em Reiniciar.

Desligar

Para desligar o computador definitivamente, selecione Desligar… do
”Indicador de Sessão”.

Outras opções

Do Indicador de sessão, você pode selecionar Bloquear tela para que o Você pode rapidamente bloquear sua tela
usando o atalho do teclado Ctrl+Alt+L. Essa
opção é recomendada caso você se afaste do
seu computador por um período de tempo.

computador requisite uma senha antes de você usá-lo novamente—isso
é útil se você precisa deixar seu computador sozinho por um período de
tempo. Você também pode usar o Indicador de sessão para configurar
uma ”sessão convidado” para um amigo ou para alternar conta de usuário,
ou seja, fazer o login em outra conta de usuário sem fechar seus aplicati-
vos.

Obtendo ajuda

Ajuda geral

Ubuntu, just like other operating systems, has a built-in help reference Many applications have their own help section
which can be accessed by clicking the Help
menu within the application window.

called the Ubuntu Desktop Guide. To access it, click on the Dash and type
Help. Alternatively, you can select Ubuntu Help from the Help menu in
the menu bar.

Ajuda do Heads-Up Display

e  (heads-up display) is a new help feature introduced in Ubuntu
.. is is a keyboard-friendly utility to help you find commands,
features, and preferences embedded deep within the menu structure
of an application. Activate the  by pressing the le Alt key on the
keyboard. If you want to search a menu item, such as creating a new
message in underbird, then just type message in the  and the option
for composing a new email message will come up in the list of matching
results. You can press the Enter key to active the command. e  The HUD feature may not be available in

all applications as this is a new capability in
Ubuntu 12.04. Your mileage may vary!

works for almost all applications that are natively installable in Ubuntu; it
also works for some applications running under WINE.

WINE is an acronym forWine Is Not an Emula-
tor. It allows you to run someWindows-based
applications in Ubuntu. Discussion of how to
use WINE is beyond the scope of this manual,
but it is worth checking out if you need to run
Windows applications under Ubuntu.



   

M I S S I N G S C R E E N S H O T

ss:HUD-message

The file screenshots/pt_BR/02-HUD-message.png does not exist!

Figura 2.13: The HUD (heads-up display) shows
application-specific help information based on
your general input.

Ajuda on-line
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Figura 2.14: The built-in system help provides
topic-based help for Ubuntu.

If you can’t find an answer to your question in this manual or in the
Ubuntu Desktop Guide, you can contact the Ubuntu community through
the Ubuntu Forums (http://ubuntuforums.org). Many Ubuntu users open We encourage you to check any information

you find on other websites with multiple
sources when possible, but only follow
directions if you understand them completely.

an account on the forums to receive help, and in turn provide support
to others as they gain more knowledge. Another useful resource is the
Ubuntu Wiki (https://wiki.ubuntu.com), a website maintained by the
Ubuntu community.

http://ubuntuforums.org
https://wiki.ubuntu.com




3 Trabalhando com o Ubuntu

Todos os aplicativos que você precisa

Se você está migrando de uma plataforma Windows ou Mac, você pode
estar se perguntando se os programas que você usava antes estão dispo-
níveis para o Ubuntu. Alguns dos programas que você usava já possuem
versões Linux nativas. E, para aqueles que não possuem, existem aplica-
tivos gratuitos e de código aberto que irão satisfazer suas necessidades.
Esta seção recomendará algumas alternativas que funcionarão bem no
Ubuntu. A maioria dos aplicativos listados nesta seção estão disponíveis Você pode procurar por mais aplicativos

na Central de programas do Ubuntu pela
categoria desejada.

via Central de programas. Aqueles seguidos de um asterisco (*) podem ser
baixados diretamente de suas páginas web oficiais.

Suites de Escritório

‣ Windows: Microso Office, LibreOffice
‣ Mac  : iWork, Microso Office, LibreOffice
‣ Linux: LibreOffice, KOffice,  Office, Kexi (aplicativo de banco de

dados)

No Ubuntu você pode escolher entre muitas suítes de escritório. A
suíte mais popular é o LibreOffice (anteriormente OpenOffice). Incluído
nesta suíte:
‣ Writer—processador de textos
‣ Calc—planilha eletrônica
‣ Impress—gerenciador de apresentações
‣ Draw—programa para desenhar
‣ Base—banco de dados
‣ Math—editor de equações

A Suíte LibreOffice é instalada por padrão. Note que o Base não é ins-
talado por padrão mas pode ser instalado através da Central de programas
do Ubuntu.

Aplicativos de Email

‣ Windows: Microso Outlook, Mozilla underbird
‣ Mac  : Mail.app, Microso Outlook, Mozilla underbird
‣ Linux: Mozilla underbird, Evolution, KMail

Assim como com as suítes de escritório, há diversas opções para apli-
cativos de email. Um aplicativo muito conhecido é o Mozilla underbird,
que também está disponível para Windows. O underbird é o aplicativo
padrão no Ubuntu. Outra opção é o Evolution—que de maneira similar ao
Microso Outlook, fornece uma agenda.

Navegadores web

‣ Windows: Microso Internet Explorer, Mozilla Firefox, Opera, Chro-
mium, Google Chrome

‣ Mac  : Safari, Mozilla Firefox, Opera, Chromium, Google Chrome
‣ Linux: Mozilla Firefox, Opera*, Chromium, Google Chrome*, Epiphany

A maioria dos navegadores web populares podem ser instalados direta-
mente da Central de programas do Ubuntu.

OOpera está disponível para download em
http://www.opera.com/browser/download/. O
Google Chrome está disponível para download
em https://www.google.com/chrome/.

http://www.opera.com/browser/download/
https://www.google.com/chrome/
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Leitores de PDF

‣ Windows: Adobe Reader
‣ Mac  : Adobe Reader
‣ Linux: Evince, Adobe Reader, Okular

O Evince é um leitor amigável e minimalistico, e ele é o leitor de PDFs
padrão. Se o Evince não satisfazer suas necessidades, o Adobe Reader
também está disponível para o Ubuntu.

Reprodutores Multimídia

‣ Windows: Windows Media Player, VLC
‣ Mac  : icktime, VLC
‣ Linux: Totem, VLC, MPlayer, Kaffeine

Em se falando de multimídia, os usuários de Ubuntu contam com uma
grande variedade de opções de reprodutores multimídia de alta qualidade.
Dois dos mais populares e poderosos reprodutores multimídia para o
Ubuntu são o VLC e o Mplayer. Entretanto, o clássico e amigável Totem é
o reprodutor multimídia padrão do Ubuntu.

Reprodutores de música e podcasts

‣ Windows: Windows Media Player, iTunes, Winamp
‣ Mac  : iTunes
‣ Linux: Rhythmbox, Banshee, Amarok, Audacity, Miro

Existem diferentes opções para escutar música com o Ubuntu: Rhythm-
box (instalado por padrão), Rhythmbox e Amarok, entre outros. Com eles
você pode escutar músicas e seus podcasts favoritos. O Audacity é simi-
lar ao Winamp. Para quem assiste podcasts em vídeo e séries de TV da
internet existe o Miro.

Gravação de CDs e DVDs

‣ Windows: Nero Burning ROM, InfraRecorder
‣ Mac  : Burn, Toast Titanium
‣ Linux: Brasero, Kb, Gnome-baker

Existem muitos aplicativos de gravação de discos, como o Gnome-
baker, o Brasero, o gravador padrão de CDs do Ubuntu e o Kb. Esses
aplicativos são ferramentas poderosas, que oferecem interfaces amigáveis,
muitas funcionalidades e todas elas são de código aberto e gratuitas!

Gerenciamento de fotos

‣ Windows: Microso Office Picture Manager, Picasa
‣ Mac  : Aperture, Picasa
‣ Linux: Shotwell, gumb, Gwenview, F-Spot

Você pode ver e gerenciar suas fotos favoritas com o Shotwell, gerenci-
ador de fotos padrão do Ubuntu, ou com o gumb, Gwenview ou F-Spot.

Editores Gráficos

‣ Windows: Adobe Photoshop, GIMP
‣ Mac  : Adobe Photoshop, GIMP
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‣ Linux: GIMP, Inkscape

GIMP is a very powerful graphics editor. You can create your own
graphics, taper your photographs, modify your pictures. GIMP, a powerful
alternative to Photoshop, covers the needs of novice users, professional
photographers, and designers.

GIMP is not loaded by default, but can be installed via the Soware Center.

Mensageiro instantâneo

‣ Windows: Windows Live Messenger, AIM, Yahoo! Messenger, Google
Talk

‣ Mac  : Windows Live Messenger, AIM, Yahoo! Messenger, Adium,
iChat

‣ Linux: Empathy, Pidgin, Kopete, aMSN

Nenhuma das outras plataformas de mensageiros () possui versões
para Linux. Porém, você pode usar o Pidgin, o Empathy ou o Kopete para
se comunicar via diferentes protocolos, incluindo: AIM, MSN, Google
Talk (Jabber/XMPP), Facebook, Yahoo! e ICQ. Isso significa que você só
precisa de um cliente para se comunicar com todos os seus amigos. A
desvantagem é que alguns desses clientes possuem limitações de suporte
de vídeo. Se você está usando somente o MSN, o aplicativo aMSN vale
uma olhada.

Aplicativos VoIP

‣ Windows: Skype, Google Video Chat
‣ Mac  : Skype, Google Video Chat
‣ Linux: Ekiga, Skype, Google Video Chat

Tecnologias VoIP lhe permitem conversar com outras pessoas via
Internet. A ferramenta mais popular do tipo é o Skype, que está disponível
para o Linux. Uma alternativa de código aberto é o Ekiga que suporta
comunicação de voz usando o protocolo SIP. Note que o Ekiga não é
compatível com o Skype.

Clientes BitTorrent

‣ Windows: µTorrent, Azureus
‣ Mac  : Transmission, Azureus
‣ Linux: Transmission, Deluge, Azureus, KTorrent, Flush, Vuze, BitStorm

Lite

Existe um grande número de clientes BitTorrent para o Ubuntu: o
Transmission, cliente padrão do Ubuntu, é simples e leve, o Deluge, o
Azureus e o KTorrent oferecem muitas funcionalidades e satisfazem os
usuários mais exigentes.

Obtendo on-line

Esta seção do manual irá ajudá-lo a verificar a sua conexão com a Internet
e configurá-la quando necessário. O Ubuntu pode se conectar com a
Internet através de uma conexão com fio, sem fio ou discada. O Ubuntu
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. também suporta métodos de conexão mais avançados, que serão
discutidos no final desta seção.

Uma conexão com fio é quando seu computador se conecta à Inter-
net usando um cabo Ethernet. Normalmente conectado à um plugue na
parede ou a um dispositivo de rede—como um switch ou um roteador.

A conexão sem-fio is when your computer connects to the Internet In order to connect wirelessly, you must be in
a location with a working wireless network.
To set up your own wireless network, you will
need to purchase and install a wireless router
or access point. Some locations may already
have a publicly accessible wireless networks
available. If you are unsure whether your
computer has a wireless card, check with your
manufacturer.

using a wireless radio network—usually known as Wi-Fi. Most routers
now come with wireless capability, as do most laptops and netbooks.
Because of this, Wi-Fi is the most common connection type for these
types of devices. Wireless connectivity makes laptops and netbooks more
portable when moving to different rooms of a house and while traveling.

Conexão discada é quando o seu computador usa um modem para
conectar à Internet através de uma linha telefônica.

Gerenciador de rede
(a) (b) (c)

Figura 3.1: Os estados da conexão de rede: (a)
desconectado, (b) com fio, e (c) sem fio

Para se conectar à Internet usando o Ubuntu, você precisa usar o utilitário
NetworkManager. O NetworkManager lhe permite ativar e desativar co-
nexões de rede, gerenciar redes com e sem fio, e realizar outras conexões
de rede, como discada, banda larga móvel, e s.
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Figura 3.2: Aqui você pode ver que a conexão
ativa atualmente é ”Wired connection 1”.

Você pode acessar o Gerenciador de redes usando o seu ícone encon-
trado no painel superior. Este ícone pode ser diferente dependendo do seu
estado atual de conexão. Clicando neste ícone, uma lista de conexões de
rede disponíveis irá aparecer. A conexão atual (se houver alguma) terá a
palavra ”desconectar” logo abaixo dela. Você pode clicar em ”desconectar”
para manualmente se desconectar daquela rede.

Este menu também lhe permite visualizar detalhes técnicos sobre sua
atual conexão ou editar todas suas configurações de conexão. Na imagem
à direita você verá uma pequena marca próxima à ”Habilitar rede”. Clique
na pequena marca para desabilitar todas as conexões de rede. Clicando
uma segunda vez você habilitará a rede novamente. Isso pode ser muito
útil quando é necessário desligar todas as comunicações sem fio, como em
um avião.

Estabelecendo uma conexão com fio

If you have an Ethernet cable running from a wall socket or networking Are you already online? If the NetworkMana-
ger icon in the top panel shows a connection
then you may have successfully connected
during the Ubuntu setup process. You can also
simply open a browser and see if you have
access to the Internet. If so, you do not need
to do anything for the rest of this section.

device, such as a switch or router, then you will want to setup a wired
connection in Ubuntu.

Para conectar-se à Internet via conexão com fio, você precisa saber se
sua rede suporta  (Dynamic Host Configuration Protocol, em portu-
guês, Protocolo de configuração dinâmica de host). O  é uma forma do
seu computador automaticamente ser configurado para acessar sua rede
e/ou conexão com a Internet. O  é geralmente configurado automa-
ticamente no roteador. Essa é geralmente a forma mais fácil e rápida de
se estabelecer uma conexão com a Internet. Se você não está certo se o
seu roteador está configurado para usar , você pode querer contac-
tar a linha de serviço ao consumidor de seu  (Internet Service Provider,
em português, fornecedor de acesso à Internet). Se o seu roteador não está
configurado para usar  então eles estarão aptos a lhe dizer quais
configurações você precisa para conseguir ficar on-line.

Conexões automaticas com DHCP
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Figura 3.3: This window displays your IP
address and other connection information.

If your network supports  then you may already be set up for online
access. To check this, click on the NetworkManager icon. ere should
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be a “Wired Network” heading in the menu. If “Wired connection ” ap-
pears directly underneath, then your machine is currently connected and
probably setup for . If “Disconnected” appears in gray underneath
the wired network section, look below to see if an option labeled “Wired
connection ” appears in the list. If so, click on it to aempt to establish a
wired connection.

To check if you are online, click on the NetworkManager icon in the An IP (Internet Protocol) address is a unique
number assigned to your machine so that your
router can identify you on the network. Think
of it like a phone number for your computer.
Having this unique address allows the router
to speak to your computer, and therefore
send/receive data. If you are still not online
after following these steps, you may need
to try setting up your network connection
manually using a static IP address.

top panel and select the Connection Information option. You should
see a window showing details of your connection. If your  address is
displayed as ... or starts with ., then your computer was not
successfully assigned connection information through . If it shows
another address (e.g., ...), then it is likely that your 
connection to the router was successful. To test your Internet connection,
you may want to open the Firefox web browser to try loading a web page.
More information on using Firefox can be found later in this chapter.

Configuração manual com endereço estático

Se sua rede não suporta  então você precisa saber de algumas infor-
mações antes que você consiga ficar on-line. Se você desconhece essas
informações, então ligue para o seu .

‣ Um endereço de  —é um endereço único utilizado para identificar
seu computador na rede. Um endereço de  é sempre dado em quatro
grupos de números, separados por pontos, por exemplo, ....
Ao conectar usando , esse endereço irá mudar periodicamente
(daí o nome ”dinâmico”). Porém, se você configurou um endereço de 
estático, seu endereço de IP nunca mudará.

‣ Uma máscara de rede—Diz ao seu computador o tamanho da rede que
ele está conectado. Ela está formatada da mesma maneira do endereço
, mas geralmente parecerá com algo do tipo: ....

‣ A gateway—is is the  address of the device that your machine
looks to for access to the Internet. Usually, this will be the router’s 
address.

If you do not know your ISP’s DNS

server addresses, Google has DNS

servers that anyone in the world

can use for free. The addresses of

these servers are: Primary—8.8.8.8

Secondary—8.8.4.4

‣  server—is is the  address of the  (Domain Name Service)
server.  is what your computer uses to resolve  addresses to
domain names. For example http://www.ubuntu.com resolves to
.... is is the  address of the Ubuntu website on the Inter-
net.  is used so you don’t have to remember  addresses. Domain
names (like ubuntu.com) are much easier to remember. You will need
at least one  server address but you can enter up to three addresses
in case one server is unavailable.

Para configurar manualmente uma conexão com fio, clique no ícone
do Gerenciador de redes e selecione Editar conexões…. Tenha certeza de
estar olhando para a aba ”Com fio” dentro da janela “Conexões de rede”.
A lista pode já possuir uma entrada, por exemplo: ”Conexão com fio ” ou
um nome similar. Se a conexão está listada, selecione-a e clique no botão
Editar…. Se nenhuma conexão está listada, clique no botão Adicionar.

Se você está adicionando uma conexão, você precisa adicionar um
nome para ela. O nome irá distinguir a conexão que está sendo adicionada
de outras que podem ser criadas no futuro. No campo ”Nome da conexão”,
escolha um nome como ”Com fio Casa”.
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Figura 3.4: Nesta janela você pode editar
manualmente uma conexão.

Para configurar uma conexão:

. Tenha certeza que a opção Conectar automaticamente está selecio-
nada, ela está localizada logo abaixo do nome da conexão.

http://www.ubuntu.com
ubuntu.com
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. Mude para a aba Configurações v.
. Mude o Método para “Manual”.
. Clique no botão Adicionar ao lado da lista vazia de endereços.
. Digite seu endereço  no campo abaixo do cabeçalho Endereço
. Clique à direita do endereço , bem abaixo do cabeçalho Máscara de

rede e digite sua máscara de rede. Se você não tiver certeza, ”...”
é a mais comum.

. Clique à direita da máscara de rede, bem abaixo do cabeçalho Gateway
e digite o endereço de seu gateway.

. No campo Servidores  abaixo, digite o endereço de seu(s) servi-
dor(es) . Se você digitar mais de um, separe-os com vírgulas—por
exemplo, ”..., ...”.

. Clique Aplicar para salvar suas alterações.

A  address is a hardware address for your computer’s network card. En-
tering this information is sometimes important when using a cable modem
connection. If you know the  address of your network card, this can be
entered in the appropriate text field in the Wired tab of the editing window.
To find the MAC addresses for all installed networking devices, open a terminal
window, and at the command line prompt, type ifconfig. is will display a
lot of information about each of the network devices installed on the computer.
e wired devices will be labeled as LAN, LAN, etc. e wireless devices will
appear as WLAN,WLAN, etc.

When you have returned to the Network Connections screen, your
newly added connection should now be listed. Click Close to return to the
desktop. If your connection was configured correctly, the NetworkMana-
ger icon should have changed to show an active wired connection. To test
if your connection is properly set up, simply open a web browser. If you
can access the Internet, then you are connected!

Sem fio

Se seu computador estiver equipado com um cartão sem fio(Wi-fi) e você
tiver uma rede sem fio por perto, você deve ser capaz de configurar uma
conexão sem fio no Ubuntu.

Conectando a uma rede sem fio pela primeira vez

Se o seu computador possui uma placa de rede sem fio, você pode se Para melhorar a velocidade e estabilidade da
sua conexão sem fio, tente ficar mais perto do
seu roteador ou ponto de acesso da rede sem
fio.

conectar a uma rede sem fio. A maioria dos laptops e netbooks possuem
uma placa de rede sem fio embutida.

Ubuntu is usually able to detect any wireless network in range of your
computer. To see a list of wireless networks, click on the NetworkMana-
ger icon. Under the “Wireless Networks” heading you should see a list of
available wireless networks. Each network will be shown by its name and
a signal meter to the le showing its relative signal strength. e signal
meter looks like a set of bars similar to what is seen when viewing sig-
nal strength of a cell phone. Simply put, the more bars, the stronger the
signal.

Uma rede sem fio pode ser aberta a qualquer um, ou pode ser protegida
por senha. Um pequeno cadeado será exibido na barra de sinal se uma
rede sem fio dentro de alcance for protegida por senha. Você precisará
saber a senha correta para se conectar a essas redes sem fio seguras.

Para se conectar a uma rede sem fio, selecione a rede desejada clicando
em seu nome na lista. Este será o nome o nome que foi usado na instala-
ção do roteador sem fio ou ponto de acesso. A maioria do provedores de
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acesso (s ) pré-configuram e colocam uma etiqueta nos roteadores de-
talhando o nome da rede e a senha. A maioria das redes sem fio de acesso
público será facilmente identificável pelo nome usado para a rede sem fio
—por exemplo ”Starbucks-Wireless”.

If the network is unprotected (i.e., the signal meter does not show
a padlock), a connection should be established within a few seconds—
and without a password required. e NetworkManager icon in the top
panel will animate as Ubuntu aempts to connect to the network. If the
connection is successful, the icon will change to display a signal meter.
An on-screen notification message will also appear informing you that the
connection was successful.

Se a rede for protegida por senha, o Ubuntu irá exibir uma janela cha-
mada “Autenticação de rede sem fio requerida” quando tentar fazer a
conexão. Isto significa que uma senha válida é necessária para efetuar a
conexão. É assim que a tela deve se parecer:

M I S S I N G S C R E E N S H O T
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Figura 3.5: Digite a senha da sua rede sem fio.

If you know the password, enter it in the Password field and then click
on the Connect buon. As you type the password, it will be obscured
from view to prevent others from reading the password as you type it. . To verify the characters you are entering for

the password, you can view the password by
selecting the Show Password check box. Then,
you can make the password obscure again by
selecting the Show password check box again

Once the password is entered, click on the Connect buon. e Network-
Manager icon in the top panel will animate as Ubuntu aempts to connect
to the network. If the connection is successful, the icon will change to
display a signal meter. An on-screen notification message will also appear
informing you that the connection was successful.

If you entered the password incorrectly, or if it doesn’t match the
correct password (for example if it has recently been changed and you
have forgoen), NetworkManager will make another aempt to connect
to the network, and the “Wireless Network Authentication Required”
window will re-appear so that you can re-type the password. You can hit
the Cancel buon to abort the connection. If you do not know the correct
password, you may need to call you ’s customer support line or contact
your network administrator.

Uma vez que você tenha estabelecido com sucesso uma conexão de
rede sem fio, o Ubuntu irá armazenar essas configurações (inclusive a
senha) para facilitar a conexão a esta mesma rede sem fio futuramente.
Você pode também ser solicitado a selecionar uma senha para o chaveiro
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aqui. O chaveiro armazena senhas em um lugar para que você possa
acessá-las no futuro lembrando-se apenas da senha do chaveiro.

Conectando-se a uma rede sem fio salva

Se você já estabeleceu uma conexão à uma rede sem fio anteriormente,
essa informação de conexão será gravada pelo Ubuntu. Isso também irá
permitir que você se conecte à rede novamente sem ter que re-digitar a
senha.

Além disso, o Ubuntu também tentará automaticamente se conectar à
uma rede sem fio por perto se suas configurações estiverem salvas. Isso
funciona tanto para redes sem fio abertas e seguras.

Se existem várias redes sem fio por perto que estão salvas no seu com-
putador, o Ubuntu pode escolher conectar à uma rede enquanto você pode
querer conectar à outra. Para remediar essa ação, clique no ícone do Ge-
renciador de Redes. Uma lista de redes sem fio irá aparecer junto com os
seus medidores de sinais. Simplesmente, clique na rede com a qual você
deseja se conectar e, o Ubuntu irá desconectar você da rede atual e tentará
conectar na outra que você selecionou.

Se sua rede é segura e o Ubuntu possui os detalhes dela salvos, ele
irá automaticamente se conectar à ela. Se os detalhes dessa rede não
estiverem salvos, ou estiverem incorretos ou modificados, então você
será solicitado a digitar a senha da rede novamente. Se a rede é aberta
(nenhuma senha necessária), tudo isso irá acontecer automaticamente e a
conexão será estabelecida.

Conectando à uma rede sem fio oculta

In some environments, you may need to connect to a hidden wireless
network. ese hidden networks do not broadcast their names, and,
therefore, their names will not appear in the list of available wireless
networks even if they are in range. In order to connect to a hidden wire-
less network, you will need to get its name and security details from your
network administrator or .

Para conectar-se a uma rede sem fio oculta:

. Clique em Gerenciador de redes no painel superior.
. Selecione Conectar-se a uma rede sem fio oculta. O Ubuntu irá abrir o

a janela “Conectar a rede sem fio oculta”.
. No campo Nome da rede, digite o nome da rede. Ele também é co-

nhecido como  (Service Set Identifier). Você deve digitar o nome
exatamente como lhe foi dado. Por exemplo, se o nome for ”Ubuntu-
Sem-fio”, digitar ”ubuntu-sem-fio” não irá funcionar, porque as letras
”U” e ”S” são maiúsculas no nome correto.

. No campo Segurança sem fio, selecione as opções. Se a rede é uma
rede aberta, deixe o campo definido como ”nenhum”. Se você não
sabe a configuração correta para o campo, você não será capaz de se
conectar a uma rede oculta.

. Clique no botão Conectar. Se a rede for segura, será solicitada a senha.
Uma vez que você tenha digitado todos os detalhes corretamente,
a rede deve ser conectada e você receberá uma notificação na tela
informando que a conexão foi bem-sucedida.

Assim como no caso das redes visíveis sem fio, as configurações das
redes sem fio ocultas serão salvas uma vez que a conexão for feita e a rede
sem fio irá aparecer na lista de conexões salvas no Gerenciador de redes.
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Ativando e desativando sua placa de rede sem fio

Por padrão, o acesso à rede sem fio é ativado se você possui uma placa de Muitos laptops modernos também têm um
botão físico no chassis que fornece uma
maneira de ativar e desativar a placa de rede
sem fio rapidamente.

rede sem fio instalada no seu computador. Em alguns ambientes (como em
aviões), você precisará desligar temporariamente a sua placa de rede sem
fio.

Para desativar a placa de rede sem fio, clique no ícone Gerenciador de
redes se desmarque a opção Habilitar rede sem fio. O seu sinal de rádio
da rede sem fio será então desligado e o seu computador não irá mais
procurar por redes sem fio.

To reactivate your wireless card, simply reverse the process above.
Ubuntu will then begin to search for wireless networks automatically. If
you are in range of a saved network, you will automatically be connected.

Alterando uma rede sem fio existente

Algumas vezes você pode querer mudar as configurações de uma rede sem
fio salva—por exemplo, quando a senha da sua rede sem fio é modificada.

Para editar uma conexão de rede sem fio salva:

. Clique no ícone do Gerenciador de redes e selecione Editar conexões…
. Uma janela “Conexões de rede” irá se abrir. Clique na aba Sem fio.
. Por padrão, redes salvas estão em ordem cronológica com as mais

recentemente conectadas no topo. Encontre a rede que você deseja
editar, clique nela e clique no botão Editar…

. O Ubuntu irá agora abrir uma janela chamada “Editando 〈nome da sua
conexão〉”, onde 〈nome da sua conexão〉 é o nome da conexão que você
está editando. Esta janela irá mostrar algumas abas.

. Acima das abas, existe um campo chamado Nome da conexão onde
você pode mudar o nome da conexão dando à ela um nome mais facil-
mente reconhecível.

. Se a opção Conectar automaticamente não estiver selecionada, o
Ubuntu irá detectar a rede sem fio, mas não irá estabelecer uma co-
nexão até que ela seja selecionada no menu do Gerenciador de redes.
Selecione ou não selecione esta opção quando necessário.

. Na aba Sem fio, você pode precisar editar o campo . Um  é o
nome da conexão de rede sem fio. Se este campo for definido incorreta-
mente, o Ubuntu não será capaz de se conectar com a rede sem fio em
questão.

. Abaixo do  está o campo Mode. O modo ”infraestrutura” quer dizer
que você irá se conectar a um roteador sem fio ou ponto de acesso. O
modo ”ad-hoc” é para conexões computador-a-computador (quando um
computador compartilha a conexão de outro) e é usado frequentemente
em casos avançados.

. Na aba Segurança sem fio, você pode modificar o campo Segurança.
Selecionar ”Nenhum” significa que você está usando uma rede aberta
que não necessita de uma senha. Outra seleção nessa aba pode requerer
informações adicionais:
Chave  de / bits é uma configuração antiga de segurança

que é utilizada por alguns dispositivos antigos de rede sem fio. Se
sua rede usa esse método de segurança, você precisa digitar uma
chave no campo Chave que irá aparecer quando este modo for
selecionado.

Frase secreta do  de  bits é uma configuração tão antiga quanto a
acima. Porém, ao invés de possuir uma chave, seu administrador de
rede deve ter lhe dado uma frase secreta para conectar à rede.
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 &  pessoal é o modo de segurança mais comum para redes
sem fio. Uma vez selecionado este modo, você precisará entrar com
uma senha no campo Senha

Se o seu administrador de redes requer ,  dinâmico ou 
&  empresas, então você vai precisar que o administrador lhe
ajude com estes modos.

. Na aba Configurações v, você pode alterar o campo Método de
”Automático ()” para ”Manual” ou um dos outros métodos. Para
definir a configuração manual (também chamada de endereço está-
tico), favor consultar a seção acima sobre configuração manual para
conexões de rede sem fio.

. ando você terminar de fazer modificações na sua conexão, clique em
Salvar… para salvar suas mudanças e fechar a janela. Você pode clicar
em Cancelar a qualquer momento para fechar a janela sem salvar
nenhuma modificação.

. Finalmente, clique o botão Fear na janela “Conexões de rede” para
voltar à área de trabalho.

Após clicar em Salvar…, quaisquer mudanças feitas na conexão de rede
terão efeito imediatamente.

Outros métodos de conexão

Existem outras maneiras de estar conectado ao Ubuntu
With NetworkManager, you can configure “Mobile Broadband” con-

nections to connect to the Internet through your cellular data carrier.
Você pode conectar à redes  (Digital Subscriber Line, em português,

Linha Digital do Assinante), um método de conexão que usa a Internet
através da sua linha de telefone via modem.

Também é possível para o Gerenciador de redes estabelecer uma co-
nexão  (Virtual Private Network, em português, Rede Virtual Privada).
Estas são normalmente usadas para criar uma conexão segura com uma
rede de um ambiente de trabalho.

As instruções de como fazer conexões utilizando ”Banda larga móvel”,
 ou  estão além do escopo deste guia.

Navegando na internet

Uma vez que você está conectado na Internet, você poderá navegar na
web. O Mozilla Firefox é o aplicativo padrão no Ubuntu para essa finali-
dade.

Iniciando o Firefox

Existem diferentes maneiras de iniciar o Firefox. Por padrão, o Ubuntu
possui o ícone do Firefox no Lançador (a barra vertical do lado esquerdo
da tela). Selecione este ícone para abrí-lo. Ou, abra o Painel (o ícone no
topo do Lançador) e procure por firefox usando a barra de pesquisa. Se o
seu teclado possui um botão ””, você pode pressioná-lo para iniciar o
Firefox.

Navegando pelas páginas da internet

Vendo sua página inicial

ando iniciar o Firefox, você verá sua página inicial. Por padrão, esta é a
Página Inicial do Ubuntu.
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Figura 3.6: A página padrão do Ubuntu para o
navegador Firefox.

Para ir rapidamente para a sua página inicial, pressione Alt+Home no
seu teclado ou clique no ícone de uma casa no Firefox.

Navegando para outras páginas

Para navegar em uma nova página web, você precisa digitar seu endereço A URL (de Uniform Resource Locator), em
português Localizador Padrão de Recursos,
mostra ao computador como encontrar al-
guma coisa na Internet—como um documento,
página web ou endereço de e-mail. WWW (de
World Wide Web), em português literal teia
mundial, é a mesma coisa que as páginas web
com as quais a maioria das pessoas interage
com a Internet.

na Internet (também conhecido como ) na Barra de Localização. s
geralmente começam com ”hp://” seguidas de um ou mais nomes que
identificam os endereços. Um exemplo é ”http://www.ubuntu.com/”. (Nor-
malmente, você pode omitir a parte do ”hp://”. O Firefox irá preencher
essa parte para você.)
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Figura 3.7: Você pode inserir um endereço da
web ou pesquisar na Internet, digitando na
barra de localização.

Para navegar:

. Clique duplo na Barra de Localização ou pressione Ctrl+L para selecio-
nar a  que já está lá.

http://www.ubuntu.com/
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. Digite a  da página que deseja visitar. A  que você digitou
substituirá qualquer texto que já estiver na Barra de Localização.

. Pressione Enter.

Se você não conhece a  que você precisa, digite um termo de pes-
quisa na Barra de Pesquisas no centro da Barra de Localização. Sua fer-
ramenta de pesquisa favorita—Google, por padrão—irá retornar uma lista
de websites para você escolher. (Você também pode digitar sua consulta
diretamente na Barra de Localização).

Selecionando um link

A maioria das páginas web contém links que você pode selecionar. Eles
são conhecidos como ”hiperlinks”. Um hiperlink permite que você se
mova para outra página, baixando um documento, mudando o conteúdo
da página e muito mais.

Para selecionar um link:

. Mova o cursor do mouse até ele virar um dedo apontando. Isso acon-
tece sempre que o cursor está sobre um link. A maioria dos links são
textos sublinhados, mas botões e imagens em uma página web também
podem ser links.

. Clique no link uma vez. Enquanto o Firefox localiza a página do link,
uma mensagem de estado irá parecer na parte de baixo da janela.

Revendo seus passos

Se você deseja visitar uma página que você já visitou antes, existem mui- Para ir para trás e para frente você pode usar,
respectivamente, Alt+Left e Alt+Right.tas maneiras de se fazer isso.

‣ Para ir para uma página anterior ou para a próxima página, clique no
botão Anterior ou Próximo no canto esquerdo da Barra de Localização.

‣ Para voltar ou ir para frente mais de uma página, clique e segure no
botão respectivo. Você verá uma lista de páginas que você visitou
recentemente. Para retornar à uma página, selecione-a na lista.

‣ Para ver uma lista das s que você visitou na Barra de Localização,
pressione a seta para baixo no canto direito na Barra de Localização.
Escolha a página de uma lista.

‣ Para escolher a partir das páginas que você visitou durante a sessão
atual, abra o menu Histórico e escolha alguma das páginas que estão
listadas na parte mais baixa do menu.

‣ Para visualizar páginas que você visitou nos últimos meses, abra His-
tórico ‣Exibir todo o histórico (ou pressione Ctrl+Shift+H). O Firefox
irá abrir uma janela, de nome “Biblioteca”, mostrando uma lista de
diretórios, o primeiro deles é ”Histórico”. Selecione o sub-diretório
desejado ou digite um termo de busca na barra de pesquisa (no canto
superior direito) para encontrar páginas que você já visitou antes.
Clique duplamente em um resultado para abrir a página.

Parando e recarregando

Se a página estiver sendo carregada muito lentamente ou não for possível O botão Atualizar a página está no canto
direito da Barra de Localização.visualizá-la, pressione Esc para cancelar seu carregamento. Para atualizar

a página atual se ela tiver mudado da última vez que você a carregou,
clique no botão Atualizar a página ou pressione Ctrl+R.
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Abrindo uma nova janela

Algumas vezes, você pode querer ter mais de uma janela do navegador
aberta. Isso pode ajudá-lo a organizar melhor a sua sessão de navegação
ou para separar as páginas que você está vendo por diferentes motivos.

Existem quatro maneiras de criar uma nova janela:

‣ Na barra do topo, selecione Arquivo ‣Nova janela.
‣ Pressione Ctrl+N.
‣ Clique com o botão direito no ícone do Firefox no Lançador e selecione

Abrir nova janela.
‣ Clique no ícone do Firefox no Lançador usando o botão do meio do

mouse.

Uma vez que uma nova janela tenha sido aberta, você pode usá-la
da mesma maneira que você utiliza a primeira janela—incluindo para
navegação e abrir abas. Você pode abrir múltiplas janelas.

Abrindo um link em uma nova janela

Algumas vezes, você pode querer clicar em um link para navegar em outra
página web, mas não deseja que a atual seja fechada. Para fazer isso, você
pode abrir o link em uma nova janela independente.

Há duas maneiras de abrir um link em sua própria janela:

‣ Clique com o botão direito em um link e selecione Abrir em uma nova
janela.

‣ Pressione e mantenha pressionada a tecla Shift ao clicar em um link.

Navegação por abas

Uma alternativa para abrir novas janelas é usar a navegação com abas.
. A navegação por abas permite que você abra diferentes páginas web Uma nova aba é independente das outras abas

da mesma maneira que as novas janelas são
independentes umas das outras. Você pode
até misturá-las e combiná-las—por exemplo,
uma janela pode conter abas para os seus
e-mails, enquanto outra janela possui abas
para o seu trabalho

em uma única janela do Firefox, cada uma independente da outra. Isso
salva espaço no seu ambiente de trabalho porque você não tem que abrir
uma janela separada para cada página web nova. Você pode abrir, fechar
e recarregar páginas web em um só lugar sem ter que mudar para outra
janela.

Você pode alternar rapidamente entre diferentes abas usando o atalho
do teclado Ctrl+Tab.

Abrindo uma nova aba em branco

Existe três maneiras de criar uma nova aba em branco:

‣ Clique no botão Abrir uma aba (sinal de soma verde) no canto direito
da última aba.

‣ Na barra do topo, selecione Arquivo ‣Nova aba.
‣ Pressione Ctrl+T.

ando você cria uma nova aba, ela contém uma página em branco
com a barra de localização em foco. Digite o endereço de Internet () ou
outro termo de pesquisa para abrir um site na nova aba.

Abrindo um link na sua própria aba

Às vezes, você pode querer clicar em um link para navegar em outra
página web, mas não quer que a original seja fechada. Para fazer isso,
você pode abrir o link em sua própria aba.
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Existem diversas maneiras de abrir um link em uma aba própria.
A tab always opens “in the background”—in
other words, the focus remains on the original
tab. The last method (Ctrl+Shift) is an
exception; it focuses the new tab immediately.

‣ Clique com o botão direito em um link e selecione Abrir em nova aba.
‣ Pressione e segure a tecla Ctrl enquanto você clica em um link.
‣ Clique no link usando ou o botão do meio do mouse ou ambos os

botões direito e esquerdo do mouse simultaneamente.
‣ Arraste o link para um espaço em branco na barra da aba ou sobre o

botão Abrir nova aba
‣ Pressione e segure Ctrl+Shift ao clicar em um link.

Fechando a aba

Uma vez que você terminou de visitar uma página web em uma aba,
existem várias maneiras de fechá-la:

‣ Clique no botão Fear aba no canto direito da aba.
‣ Clique na aba com o botão do meio do mouse ou com a roda do mouse.
‣ Pressione Ctrl+W.
‣ Clique com o botão direito na aba e selecione Fear aba.

Restaurando uma aba fechada

Às vezes, você pode fechar uma aba errada por acidente ou querer ver no-
vamente uma aba fechada recentemente. Veja novamente a aba seguindo
uma das duas seguintes maneiras:

‣ Pressione Ctrl+Shift+T para reabrir a última aba fechada.
‣ Selecione Histórico ‣Reabrir aba, e então selecione o nome da aba a

ser restaurada.

Alterando a ordem das abas

Mova uma aba para uma posição diferente na barra de abas arrastando-a
para uma nova posição usando seu mouse. Enquanto você arrasta a aba, o
Firefox mostra um pequeno indicador da nova posição de sua aba.

Movendo uma aba entre janelas

Você pode mover uma aba para uma nova janela do Firefox ou, se uma já
estiver aberta, para uma janela do Firefox diferente.

Arraste uma aba para fora da barra de abas e ela será aberta em uma
nova janela. Arraste-a da barra de abas até outra barra de abas de outra
janela aberta do Firefox e ela irá se mover para lá.

Pesquisando

Você pode buscar algo na web com o Firefox sem ter previamente visitado
a página inicial da ferramenta de busca. Por padrão, o Firefox irá buscar
na web utilizando a ferramenta de busca do Google.

Pesquisando na internet

Para buscar algo na web no Firefox, digite algumas palavras na barra de
pesquisa do Firefox. Por exemplo, se você deseja encontrar informações
sobre o Ubuntu:

. Mova seu cursor para a Barra de Pesquisas usando o mouse ou pressi-
one Ctrl+K.
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. Digite a palavra Ubuntu. Ao digitar você irá substituir qualquer texto
que estiver escrito na Barra de Pesquisa.

. Clique na lupa ou aperte Enter para pesquisar.

Os resultados de busca do Google para ”Ubuntu” irão aparecer na
janela do Firefox.

Selecionando ferramentas de busca
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Figura 3.8: Essas são outras ferramentas de
busca que você pode usar—por padrão—na
barra de pesquisa do Firefox.

Se você não quiser usar o Google como seu provedor de busca na barra de
pesquisa, você pode mudar o provedor de buscas usado pelo Firefox.

Para modificar a sua ferramenta de busca preferida, clique no ícone
de pesquisa (na esquerda da Barra de Pesquisa—Google por padrão) e
escolha a ferramenta de busca desejada. Algumas ferramentas, como o
Bing, Google e Yahoo, procuram na web inteira; outras, como a Amazon e
a Wikipedia, buscam somente em locais específicos.

Pesquisando na web por palavras selecionadas em uma página

Algumas vezes você pode querer procurar por uma frase que você viu em
uma página web. Você pode copiá-la e colá-la na Barra de Pesquisa, mas
existe uma forma mais rápida.

. Selecione a palavra ou frase em uma página web usando o botão es-
querdo do mouse.

. Clique com o botão direito no texto selecionado e selecione Pesquisar
[Ferramenta de Busca] para [palavras que você selecionou].

O Firefox transfere o texto selecionado para a ferramenta de busca e
abre uma nova aba com os resultados.

Pesquisando dentro de uma página
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Figura 3.9: Você pode pesquisar nas páginas
da web utilizando a Barra de ferramentas
pesquisar.

Você pode estar procurando por um texto específico na página web que
você está visualizando. Para encontrar o texto na página atual no Firefox:

. Selecione Editar ‣ Localizar ou pressione Ctrl+F para abrir a Barra de
localização na parte de baixo do Firefox.
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. Digite seu termo de pesquisa no campo Localizar na barra de localiza-
ção. A pesquisa começa automaticamente assim que você digita algo
no campo.

. Assim que o texto tiver sido encontrado na página, você pode:
‣ Clique em Próxima para encontrar o texto que estiver abaixo da

posição atual do cursor na página.
‣ Clique em Anterior para encontrar o texto que estiver acima da

posição atual do cursor.
‣ Clique em Realçar tudo para realçar todas as ocorrências das pala-

vras pesquisadas na página atual.
‣ Selecione a opção Diferenciar maiúsculas/minúsculas para limitar a

pesquisa ao texto que tenha a mesma configuração de maiúsculas e
minúsculas que as palavras de sua busca.

Para procurar de maneira rápida a mesma palavra ou frase novamente,
pressione F3.

Você pode pular a abertura da Barrar de localização.

. Ative a opção de acessibilidade com Editar ‣ Preferências ‣Avançado ‣
Geral ‣Acessibilidade ‣ Localizar texto ao começar a digitar ‣Close

. Agora, uma vez que o cursor não esteja em uma caixa de texto, quando
você começar a digitar, será feita uma pesquisa do texto automatica-
mente.

Visualização de páginas web em tela cheia

Para exibir mais conteúdo na tela, você pode usar o modo de tela inteira.
Este modo oculta tudo que não for o conteúdo principal. Para ativar
o modo de tela inteira, selecione Exibir ‣Tela eia ou pressione F11.
ando estiver no modo de tela cheia, mova o seu mouse para o topo da
tela para revelar as barras de endereço e de pesquisa.

Pressione F11 para retornar ao modo normal.

Copiando e salvando páginas

Com o Firefox, você pode copiar parte de uma página para que você possa
colá-la em outro lugar, ou salvar a página ou parte de uma página como
um arquivo em seu computador.

Copiando parte de uma página

Para copiar texto, links ou imagens de uma página:

. Destaque o texto e imagens com seu mouse.
. Clique com o botão direito no texto selecionado e selecione Copiar ou

pressione Ctrl+C.

Para copiar somente uma imagem, não é necessário selecioná-la. É só
clicar com o botão direito nela e selecionar Copiar.

Você pode colar os resultados em outro aplicativo, como por exemplo
no LibreOffice.

Copiando um link

Para copiar um texto ou link para uma imagem () de uma página:

. Posicione o cursor sobre o texto, link ou imagem. Seu cursor do mouse
se transformará em um dedo apontando.
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. Clique com o botão direito no link ou na imagem para abrir um menu
pop-up.

. Selecione Copiar Link.

Você pode colar o link em outro aplicativo ou na Barra de Localização
do Firefox.

Salvando tudo ou parte de uma página

Para salvar uma página inteira no Firerox:

. Clique em Arquivo ‣ Salvar como… no barra superior ou pressione
Ctrl+S. O Firefox irá abrir uma janela de nome “Salvar como”.

. Selecione uma localização para a página salva.
. Digite um nome de arquivo para a página.
. Clique em Salvar.

Para salvar uma imagem de uma página:

. Posicione o ponteiro do mouse acima da imagem.
. Clique com o botão direito na imagem e selecione Salvar imagem

como…. O Firefox irá abrir a janela de nome “Salvar Imagem”.
. Selecione uma localização para a imagem salva.
. Digite um nome de arquivo para a imagem.
. Clique em Salvar.

Alterando sua página inicial

O Firefox exibe a página inicial quando é aberto. Por padrão, esta é a
página inicial do Ubuntu. Você pode alterar a sua página inicial padrão
por outra, ou mesmo várias outras.
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Figura 3.10: Mude as configurações do Firefox
nesta janela.

Para mudar a sua página inicial:

. Navigate to the page that you would like to become your new home
page. If you want Firefox to open more than one tab when it starts,
open a new tab and navigate to the extra page as many times as you
would like. The home page can also be set by entering the

addresses that should be open in the Home
Page, with a pipe (“|”) separating pages to be
opened in separate tabs.

. Escolha Editar ‣ Preferências ‣Geral ‣ Iniciar ‣Usar as páginas aber-
tas ‣ Fear.
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Configurações para baixar

In Edit ‣ Preferences ‣General ‣Downloads, you can hide or show the The Downloads window shows the progress
of currently downloading files, and lists files
downloaded in the past. It can be used to open
or re-download files.

Downloads window, tell Firefox where to place downloaded files, and
whether or not to ask where each time.

Marcadores

Ao navegar na web você pode querer voltar para algumas páginas web
novamente sem ter que lembrar suas . Para fazer isso é só adicionar
aos favoritos cada página. Esses favoritos serão salvos no navegador web,
você pode usá-los para reabrir essas páginas web.

Marcando uma página

Após navegar em uma página web, você pode salvar seu endereço adicionando-
a aos favoritos. Existem duas maneiras de fazer isso:

‣ Na barra do topo, escolha Favoritos ‣Adicionar página ou pressione
Ctrl+D. Uma janela irá se abrir, permitindo que você digite um nome
descritivo para o favorito e um endereço para salvá-la. Clique em
Concluir para salvar.

‣ Clique na estrela no canto direito da Barra de Localização. Ela ficará
amarela e a página será salva no diretório Não organizados.

Navegando para a página marcada

Para navegar em uma página que está nos seus favoritos, abra o menu
Favoritos na barra do topo e escolha o favorito desejado. Ele será aberto
na aba atual do Firefox.

Você pode visualizar os favoritos, incluindo os ”Não organizados”, em uma
barra lateral na esquerda da janela do navegador. Selecione Exibir ‣ Painel ‣
Favoritos, ou pressione Ctrl+B. Repita o mesmo passo ou pressione o botão de
fear no topo, para esconder a barra lateral.

Excluindo ou editando um favorito

Para excluir ou editar um favorito, faça uma das seguintes coisas:

‣ Se você ainda está visualizando a página, observe que a estrela na Barra
de Localização está amarela. Clique nela. O Firefox irá abrir uma janela
pop-up, na qual você poderá tanto Excluir ou editar o favorito.

‣ Selecione Favoritos ‣Exibir todos os favoritos ou pressione Shift+Ctrl+O.
Na janela que irá se abrir, você pode navegar nos favoritos. Selecione
aquele que você deseja modificar. Para excluí-lo, clique nele com o bo-
tão direito e selecione Excluir ou pressione Delete no seu teclado. Para
editar, mude os detalhes exibidos na parte inferior da janela.

Histórico

Sempre que você estiver pesquisando na web, o Firefox salva o seu his-
tórico de pesquisa. Isso lhe permite voltar à uma página web que você
tenha visitado recentemente sem a necessidade de lembrar ou adicionar
aos favoritos a página .

Para visualizar o seu histórico mais recente, abra o menu Histórico
na barra do topo. O menu irá mostrar muitas das páginas web que você
visualizou recentemente. Escolha uma das páginas para retornar à ela.

Para ver o histórico completo, siga uma das seguintes opções:
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‣ Selecione Exibir ‣ Painel ‣Histórico ou pressione Ctrl+H para visu-
alizar o histórico no painel lateral. Isto substitui o painel lateral de
favoritos, se este estiver aberto. Repita isto, ou pressione o botão Fe-
ar painel no seu topo para ocultar o painel.

‣ Selecione Histórico ‣Exibir todo o histórico ou pressione Shift+Ctrl+H
para visualizar o histórico em uma janela pop-up.

Your browsing history is categorized as “Today,” “Yesterday,” “Last 
days,” “is month,” the previous five months by name, and finally “Older
than  months.” If history for a category does not exist, that category will
not be listed. Select one of the date categories in the sidebar to expand it
and reveal the pages that you visited during that time. Once you find the
page you want, select it to re-display it.

Você também pode procurar por uma página pelo seu título ou .
Digite algumas letras ou uma ou mais palavras ou, opcionalmente, a
 no campo Localizar no topo da barra lateral. A barra lateral mostra
uma lista de páginas web que correspondem às palavras procuradas.
Selecione a página desejada. (Você pode até mesmo fazer isso na Barra
de Localização, economizando o tempo de ter que abrir a barra lateral do
Histórico ou a janela pop-up.)

Limpando dados privativos

O Firefox grava todos os seus dados somente no seu computador. Entre-
tanto, se você compartilhar o seu computador, você pode muitas vezes
querer excluir todos os dados privados.

Selecione Ferramentas ‣ Limpar dados pessoais… ou pressione
Shift+Ctrl+Delete. Escolha dentre as opções de Limpar este período,
e logo abaixo Detalhes quais itens serão apagados, e clique em Limpar
agora.

Impedir que o Firefox grave dados privativos

Você pode iniciar a ”navegação privada”, que significa que o Firefox não
irá gravar nada permanentemente. Isso durará até você desligar ou reini-
ciar o Firefox.

Escolha Ferramentas ‣ Iniciar navegação privativa or press Shift+Ctrl+P.
Clique no botão Iniciar navegação privativa para confirmar. Enquanto
você permanecer neste modo, o Firefox não irá gravar histórico de na-
vegação, download, histórico de formulários ou de busca, ou cookies,
também não gravará arquivos em cache. Porém, se você adicionar algo
aos favoritos ou baixar arquivos, eles serão mantidos.

Repita Ferramentas ‣ Iniciar navegação privativa ou Shift+Ctrl+P, ou
reinicie o Firefox para finalizar a navegação privada.

Usando um navegador web diferente

Caso você deseje instalar um navegador web diferente no seu computador,
você pode querer usá-lo como navegador padrão ao clicar em endereços
a partir de e-mails, programas de mensagens instantâneas e de outros
lugares. A Canonical suporta o Firefox e o Chromium (Versão do Google
Chrome para Linux), mas existem muitos outros navegadores que você
pode instalar.

Para modificar o seu navegador web padrão, clique no Indicador de
Sessão, localizado no canto direito do painel do topo e selecione Con-
figurações do sistema… ‣Detalhes ‣Aplicativos padrões. E escolha o
navegador web desejado no menu Web.
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Figura 3.11: Os Aplicativos padrão onde você
pode alterar o seu navegador preferencial.

Lendo e compondo e-mails

Introdução ao Thunderbird

O underbird é um cliente de e-mail desenvolvido pelo Mozilla e é fácil
de configurar e usar. Ele é gratuito, rápido, e contém muitos recursos
úteis. Mesmo que você conheça pouco o Ubuntu o underbird, ele estará
pronto para funcionar rapidamente, verificando sua conta de e-mail e
mantendo contato com seus amigos e família.

Configurando o Thunderbird

No canto direito do topo da área de trabalho do Ubuntu você verá um
ícone de envelope na área de notificação. Este é o Menu de mensagens. A
partir daí, você pode carregar o underbird clicando em E-mail. De ma-
neira alternativa, você pode clicar no botão do Ubuntu no canto esquerdo
do topo da tela, no topo do Lançador, para visualizar o Painel e digitar a
palavra thunderbird na caixa de busca. Uma vez aberto o underbird,
você receberá as boas-vindas de uma janela perguntando se você deseja
configurar sua conta de e-mail.

Digite seu nome na primeira caixa de texto, seu endereço de e-mail na
segunda (por exemplo, nomedeusuario@dominio.com) e a senha do seu
e-mail na terceira.

Once completed, click the continue buon. underbird will auto-
matically set up your email account for you. When underbird finishes
detecting your email seings, click create account and underbird will
do the rest. You can also set underbird as your default news and  re-
ader by checking the boxes in the pop-up box that appear aer you click
create your account. If you don’t want to see this message box every time
you start underbird, simply deselect Always perform this e when
starting underbird. You are now ready to start using underbird.

No espaço de trabalho do Thunderbird

Now that you have your email account set up, lets get to know the un-
derbird workspace. underbird is designed to be very user-friendly and
easy to navigate. When you open the application, you will see the main
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Figura 3.12: Configurando o Thunderbird

workspace with your email folders (all folders window) on the le. On
the right of the screen, you will see two windows. e top-right window
displays a list of your received email, and the boom-right window dis-
plays the current email you are viewing. e size of these windows can be
easily resized to suit your viewing environment. To resize the windows,
simply le-click and hold the dividing bar that separates the two win-
dows and drag the bar up or down to the desired position. e All Folders
window is where you can see your mail folders. is window can also
include:

Caixa de entrada Onde o seu e-mail é gravado e acessado
pasta de endereço de email Você irá ver uma dessas pastas para cada conta

que você tiver configurado
Rascunhos Onde os seus rascunhos de e-mails são armazenados
Enviados Onde os e-mails que você enviou são armazenados
Spam É aqui que e-mails suspeitos de serem spams são armazenados,

dessa forma, você pode verificá-los e ter certeza que nenhum e-mail
importante foi perdido.

Lixeira É aqui que as mensagens que você deletou são armazenadas,
assim, você pode verificar novamente para ter certeza de que nenhum
e-mail importante (ou alguma das pastas locais) foi deletado

Importante Aqui é onde são armazenados os e-mails que você marcou
como importantes

Com estrela Aqui é onde são armazenados os e-mails que você marcou
com um estrela

Pessoal Aqui é onde são armazenados os e-mails que você marcou como
pessoais

Destinatários Você pode mover destinatários importantes para esta pasta.
Viagem Você pode usar esta pasta para armazenar e-mails de viagem

como horários de voo e reservas.
Trabalho You can store work emails in this folder to keep them separate

from your personal email
Saída Onde são armazenados os e-mails que está para enviar (também

uma das pastas locais)

No topo da área de trabalho do underbird, você verá quatro botões
de controle, Receber, Nova msg, Catálogo e Tags. Eles são usados para
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receber seu e-mail, acessar o seu catálogo de endereços e adicionar tags às
suas mensagens de e-mail.

No canto direito do topo da janela de Todas as Pastas, você verá um
conjunto de botões de filtragem rápida, não lidas, com estrela, pessoas
de seu catálogo de endereços, com tags e com anexos. Você pode usar
esses botões para filtrar suas mensagens de e-mail de forma que você só
veja seus e-mails não lidos, seus e-mails favoritos (com estrela), e-mails de
pessoas de seu catálogo de endereços, e-mails que possuam tags e e-mails
que incluam anexos.

Se você está acostumado a um ambiente de trabalho mais tradicional
e está com o underbird maximizado em tela cheia, você pode se ques-
tionar sobre a localização dos menus. Eles ainda estão aí e se você quiser
acessá-los, mova o seu mouse para o topo da tela e você verá os menus já
familiares: Arquivo, Editar, Exibir, Ir, Mensagem, Ferramentas e Ajuda.

No topo da janela que mostra seu e-mail, você pode ver cinco botões de
ação: Responder, Encaminhar, Arquivar, Spam e Excluir. Eles são muito
úteis para responder rapidamente e-mails, encaminhar seus e-mails para
outra pessoa, arquivar (executar cópia de segurança) seu e-mail, marcar
um e-mail como spam e facilmente excluir um e-mail. À esquerda desses
botões de ação rápida, você pode ver informações sobre o e-mail que você
está visualizando, incluindo o nome do remetente, o assunto do e-mail, o
endereço para resposta e o destinatário do e-mail.

Utilizando o seu catálogo de endereços

No topo da área de trabalho principal, você verá o botão Catálogo. Clique
nele para acessar o seu catálogo de endereços. Uma vez aberto, você verá
uma janela com o catálogo de endereços. A partir dela, você pode organi-
zar facilmente seus contatos. No topo da janela do catálogo de endereços
você encontrará cinco botões: Novo contato, Nova lista, Propriedades,
Nova msg e Excluir. Seguem suas explicações de funcionamento:

Novo contato Esse botão lhe permite adicionar um novo contato e adici-
onar o máximo de detalhes que você deseje gravar para ele, incluindo
nome, apelido, endereço, e-mail, e-mail alternativo, nome de exibição,
telefone de trabalho, telefone de casa, fax, pager e número de celular.

Nova Lista Este botão lhe permite adicionar listas para os seus contatos,
por exemplo: família, amigos, conhecidos, etc.

Propriedades Este botão lhe permite renomear o seu catálogo de endere-
ços. O nome padrão é Catálogo pessoal, mas você pode mudá-lo para o
nome que desejar.

Nova msg Este botão lhe permite enviar rapidamente um e-mail para
um contato selecionado sem necessidade de voltar para o ambiente de
trabalho principal do underbird. Simplesmente selecione um contato
de seu catálogo de endereços e clique no botão Enviar agora para
enviar um e-mail a ele.

Excluir Este botão lhe permite excluir rapidamente um contato de seu
catálogo de endereços. Apenas selecione o contato que você deseja ex-
cluir e clique no botão Excluir para remover o contato de seu catálogo
de endereços.

Verificando e lendo mensagens

underbird will automatically check your email account for new messa-
ges every ten minutes, but if you need to manually check for new messa-
ges at any time, le-click the get mail button in the top le corner of the
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workspace. underbird will then check your email account for new mes-
sages and download them. As they are downloaded, you will see the new
email appear in the message window on the right side of the workspace.
When you click on one of your emails, it will appear in the window below
your email list. If you want to view your email in a full window, double-
le-click your chosen email, and underbird will display the email in
a full window in its own tab. At the top of the open email, you will see
information about the email and the five quick action buons, reply,
forward, arive, junk and delete as previously discussed. If an email has
remote content, you will see a message asking if you want to display the
email or not. You may want to filter your emails from time to time; this is Remote content represent parts of an email

that may be hosted elsewhere. Remote
content might consist of video or audio, but
most often is graphics or HTML content. For
security purposes, Thunderbird will as you if
you wish to view this remote content.

easily done with underbird. When you have an email selected and you
want to tag the email, simply click the tag buon and a drop down list
will be displayed. In this drop down list, you have the options to Remove
All Tags or Mark as…, Important, Work, Personal, To Do, Later. You can
also create a new tag more suited to your own personal requirements.

Compondo e respondendo à mensagens

Para compor um novo e-mail, clique no botão ”Nova msg” no canto su-
perior direito do seu ambiente de trabalho. Uma nova janela se abrirá,
nela você poderá compor o seu novo e-mail. No campo Para:, digite o
endereço de e-mail do destinatário—o contato para quem você está envi-
ando esse e-mail. Se você está escrevendo para mais de um contato, separe
os múltiplos destinatários com vírgulas. Se um dos contatos estiver no
seu catálogo de endereços, você pode adicioná-lo à lista pelo seu nome.
Comece digitando o nome do contato; o underbird irá exibir uma lista
de contatos de e-mail logo abaixo do seu texto. Uma vez que você ver o
contato que deseja adicionar, clique no seu endereço de e-mail ou use a
seta para baixo e pressione Enter para selecionar um endereço. Se você
deseja copiar alguns contatos (Cc), clique no campo Para: e selecione Cc:.
Os contatos listados nas linhas Para: e Cc: irão receber o e-mail e verão o
todos os contatos para quem o e-mail foi enviado. Se você deseja enviar
um e-mail para alguns contatos sem que eles saibam para quem o e-mail
foi enviado, você pode enviar uma cópia oculta ou Cco:. Para habilitar o
Cco, selecione Cco: clicando no campo Para: e selecionando Cco:. al-
quer contato adicionado ao campo Cco: irá receber a mensagem, mas
nenhum dos destinatários irá ver os nomes ou e-mails dos contatos da
linha Cco:. Ao invés de digitar os endereços de e-mail ou nome dos con-
tatos que para quem você irá enviar a mensagem, você pode selecionar
os contatos do seu Catálogo de endereços. Comece digitando algumas
letras do nome ou sobrenome de seu contato no campo Para: para filtrar
a lista e mostrar somente os contatos de e-mail. Uma vez identificado o
contato para o qual você deseja enviar a mensagem, clique no seu nome
na lista. Se você adicionou um contato por um erro, exclua o seu ende-
reço e digite o endereço correto. Você pode adicionar um assunto para
o e-mail no campo Assunto. Mensagens devem ter assunto para ajudar o
destinatário a identificar conteúdos gerais do e-mail ao olhar para a sua
lista de mensagens. Digite o conteúdo da sua mensagem no grande campo Se você não incluir um assunto no seu e-mail, o

Thunderbird irá avisá-lo sobre esta omissão.de texto abaixo do assunto. Praticamente não há limite de quantidade de
texto que você pode incluir na sua mensagem. Por padrão, o underbird
irá detectar automaticamente o formato correto do seu e-mail, mas você
pode mudá-lo clicando em Opções então coloque o mouse sobre a opção
Formatação e selecione a opção desejada de uma lista. Você pode escolher
entre: Selecionar automaticamente, Sem formatações, Formatação HTML e
Ambos os formatos. ando você terminar de escrever seu e-mail, clique
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no botão Enviar agora na barra de ferramentas da janela. Sua mensagem
será colocada na Saída e será enviada para os destinatários desejados.

Anexar arquivos

Às vezes, você pode querer enviar arquivos para os seus contatos. Para
enviar arquivos, você precisará anexá-los à sua mensagem de e-mail. Para Você pode anexar diferentes tipos de arquivos

aos seus e-mails, mas preste atenção no
tamanho dos anexos! Se eles foremmuito
grandes, alguns sistemas de e-mails irão
rejeitar os e-mails que você está mandando e o
destinatário nunca os receberá!

anexar um arquivo a um e-mail que você está compondo, clique no botão
Anexar. ando a nova janela se abrir, selecione o arquivo que você
deseja enviar e clique em Abrir. Pronto, o arquivo que você selecionou
será anexado ao e-mail quando você enviá-lo.

Respondendo à mensagens

Além de compor novas mensagens, você pode querer responder às mensa-
gens que você recebeu. Veja três tipos de respostas para e-mails:

Responder ou Responder ao remetente envia a sua resposta somente ao
remetente da mensagem ou para quem você está respondendo.

Responder a todos manda a sua resposta para o remetente da mensagem e
também para todos os endereços que estiverem nas linhas Para: ou Cc:.

Encaminhar permite que você envie mensagens, com qualquer comentá-
rio que você queira adicionar, para outros contatos.

Para usar qualquer um desses métodos, clique na mensagem que você
deseja responder e então clique em dos botões: Responder, Re: Todos
ou Encaminhar na barra de ferramentas da mensagem. O underbird
abrirá uma janela de resposta. Essa janela se parecerá muito com a janela
de compor novas mensagens, mas os campos Para:, Cc:, Cco:, Assunto: e
o campo de mensagem principal estarão preenchidos com o que você está
respondendo. Edite os campos Para:, Cc:, Cco:, Assunto: e a mensagem
principal como lhe for conveniente. ando você terminar de responder,
clique no botão Enviar agora na barra de ferramentas. Sua mensagem
será colocada na Saída e será enviada.

Usando mensageiro instantâneo

Mensageiros instantâneos permitem que você se comunique com pessoas
em tempo real on-line. O Ubuntu inclui o aplicativo Empathy que permite
que você use funcionalidades de mensagens instantâneas para manter
contato com diversas pessoas. Você pode iniciar o Empathy, abrindo o
Menu de mensagens (o ícone de envelope na barra de menu) e selecio-
nando Bate-papo.

O Empathy permite que você se conecte a muitas redes de mensagens
instantâneas. Você pode se conectar às seguintes: Facebook Chat, Google
Talk, Jabber, People Nearby, , Gadu-Gadu, Groupwise, , , ,
mxit, myspace, , sametime, silc, , , Yahoo! e Zephyr.

Executando o Empathy pela primeira vez

ando você abre o Empathy pela primeira vez, você precisará configurá-
lo com os detalhes da sua contas de mensagens instantâneas.

ando Empathy iniciar você verá a janela “Bem-vindo ao Empathy”.
Escolha a opção correspondente com sua situação.
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Você possui uma conta anterior

If you have an account that you have used previously with another instant
messaging program, then select the Yes, I’ll enter my account details
now option. en, click Forward to continue.

Na próxima tela, escolha o tipo de sua conta a partir da lista suspensa
e tipo de conta você possui?. Depois, informe nos campos abaixo os
detalhes da conta que você está usando .

Dependendo do tipo de conta que você escolher, o Empathy pode
requisitar que você digite um nome de usuário ou um  para sua conta,
seguido de uma senha.

M I S S I N G S C R E E N S H O T
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Figura 3.13: Criando sua nova conta de
mensageiro instantâneo no Empathy.

Se você não se lembra das informações de sua conta, você terá que
visitar a página web do serviço de mensagem instantânea que você deseja
obter essas informações. (É sugerido que você visite as páginas web dos
mensageiros instantâneos que você possui contas, antes de você iniciar o
Empathy, assim você pode obter todas as credenciais de cada conta sua.)

If you have another account to add then select the Yes option, and click
Forward to repeat the above process. When you have entered all of your
accounts leave the No, that’s all for now option selected, and click Apply
to finish the setup process.

Next, Empathy should display the “Please enter personal details”
screen. If you choose to fill in this information, you will be able to com-
municate with people who are on your local network either at home or
from the office.

Digite o seu primeiro nome no campo Primeiro nome e seu sobrenome
no campo Sobrenome. Digite o apelido que você quer usar na sua rede
local no campo Apelido. ando você preencher todas essas informações,
clique em Conectar

If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option, and click
Apply.
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Você não possui uma conta anterior

Se você não tiver uma conta que queira utilizar, crie uma selecionando a
opção Não, eu quero uma nova conta. Clique em Avançar para exibir o
próximo conjunto de opções.

Escolha o tipo de conta que você deseja criar na lista ao lado de al
tipo de conta de bate-papo você possui? Você pode criar tanto uma conta
Jabber ou uma do Google Talk. Note: Se você deseja criar algum tipo de conta

diferente de um desses, você precisa visitar
seu site e criar uma conta primeiro. Depois
seguir as instruções da seção ”Você já possui
uma conta”.

Next, enter the account name that you would like in the text field, and
in the following text field enter a password of your choice. If you would
like to set up another account then select the Yes option, and repeat the
above process.

ando você tiver inserido todas as contas, deixe a opção Não, isto é
tudo por enquanto selecionada, e clique Avançar.

Empathy deve exibir a janela “Por favor entre com seus detalhes pes-
soais”. Provendo estas informações permite a você se comunicar com
pessoas que estão na sua rede local, tanto em casa quanto no ambiente de
trabalho.

Insira o seu Primeiro Nome no campo de texto, e insira seu Sobrenome
no campo de texto seguinte. No campo Apelido insira um apelido pelo
qual você gostaria de ser identificado. ando você tiver preenchido
todos os campos clique Aplicar para salvar suas configurações.

Se você não quiser conversar com pessoas na sua rede local, então
selecione a opção Eu não quero habilitar este recurso no momento e
clique em Aplicar.

Você quer falar com as pessoas próximas

Se você apenas desejar se comunicar com pessoas na sua rede local seja no
trabalho ou em casa, então você pode selecionar a opção Não, Eu apenas
quero ver pessoas online próximas no momento.

Clique Avançar para mostrar o próximo conjunto de opções. Então
insira seu Primeironome no campo de texto, e insira seu Sobrenome no
campo de texto seguinte. No campo Apelido insira um apelido pelo qual
você gostaria de ser identificado. ando você tiver preenchido todos os
campos clique em Avançar.
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Figura 3.14: Você pode conversar com pessoas
próximas, inserindo suas informações.



    

Alterando configurações de conta

Se você precisa adicionar mais contas após a primeira execução, abra o
menu Editar e selecione Contas. O Empathy irá mostrar a janela “Contas
de Mensagem e VoIP”.

Adicionando uma conta

Para adicionar uma nova conta, clique no botão + no canto inferior es-
querdo da janela “Contas de Mensagem e VoIP”. O Empathy deve mostrar
algumas opções no canto direito da janela. Escolha o seu tipo de conta
na lista de Protocolos. Feito isso, digite o nome da sua conta no primeiro
campo. Depois, digite a senha no campo Senha. Finalmente clique no
botão Aplicar para salvar e verificar suas configurações.

Editando uma conta

Pode ser necessário editar uma conta se você mudou a senha ou digitou
errado sua senha. Felizmente, isso é uma coisa muito fácil de se fazer.
Selecione a conta que você deseja modificar no canto esquerdo da janela
“Contas de Mensagem e VoIP”. O Empathy deve mostrar as informações
atuais da conta. Uma vez que você fez as mudanças, clique em Aplicar.

Removendo uma conta

Para remover uma conta, selecione-a no lado esquerdo da janela e clique
no botão -. O Empathy deverá abrir a janela “Você deseja remover?”.
Clique no botão remover para confirmar que você deseja remover a conta
ou clique em Cancelar para manter a conta.

Editando contatos

Adicionando um contato

Para adicionar um contato abra o menu Bate-papo e selecione Adicionar
Contato…. O Empathy abrirá uma janela de nome “Novo contato”.

Na lista Conta, selecione a conta que você deseja adicionar o contato.
Ao criar um contato você deve selecionar um serviço que seja compatível
com o serviço que o contato está usando.

Por exemplo, se o endereço do seu contato termina com ”@google-
mail.com”, então você precisa adicioná-lo à uma conta que termine com
”@googlemail.com”. Da mesma forma, se o e-mail do seu contato termina
com ”@hotmail.com” você precisa adicioná-lo à uma conta terminada em
”@hotmail.com”

Após escolher a conta que você quer adicionar o seu contato, entre com
seu  de login, seu nome de usuário, seu apelido ou endereço de email no
campo de texto Identificação. Feito isso, no campo Apelido, digite o nome
de exibição do seu contato na sua lista de contatos. Clique em Adicionar
para adicioná-lo à sua lista.

Removendo um contato

Clique no contato que você deseja remover, então na barra do Unity no
topo da tela, abra o menu Editar, selecione Contato e então Remover. Isso
irá abrir uma janela de nome “Removendo contato”.

Clique no botão Excluir para confirmar que você deseja remover este
contato ou clique no botão Cancelar para manter o contato.
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Comunicando com contatos

Texto

Para se comunicar com um contato, selecione o contato na janela princi-
pal do Empathy e clique duas vezes em seu nome. O Empathy deve abrir
uma nova janela onde você pode digitar mensagens para seus contatos, e
ver um histórico das mensagens trocadas anteriormente.

Para enviar uma mensagem para o contato, digite-a no campo de texto
abaixo do histórico de conversa. ando você terminar de digitar a men-
sagem, pressione a tecla Enter para enviá-la para o seu contato. Se você
está se comunicando com mais de uma pessoa, então todas as conversas
serão mostradas em abas na sua janela do Empathy.

Áudio

Se o seu contato tem recursos de áudio, então haverá um ícone de um
microfone perto de seu nome. Clique no ícone de microfone para abrir um
menu pop-up. Selecione a opção Chamada de áudio do menu. O Empathy
deverá abrir uma janela de “Chamada”.

Está janela apresentará sua imagem na direita e a imagem do seu con-
tato à esquerda. Garanta que seu microfone e alto-falantes estão co-
nectados, e proceda com a conversação em áudio. Você pode finalizar a
conversação clicando no botão Desligar

Vídeo

If your contact has video chat capabilities then there will be a webcam
icon next to their name. Click on the icon to open a popup menu. Select
the Video call option from the menu. Empathy should then open the
“Call” window. is window shows your webcam view in the top right
and your contact’s webcam will be in the middle. If you don’t have a
webcam then your picture will be shown instead. You can finish the call
by clicking on the Hang up buon.

Enviando e recebendo arquivos

Enviando um arquivo

ando você está em uma conversa com um contato e deseja mandar um
arquivo para ele, abra o menu Editar e depois Contato, selecione Enviar
arquivo. O Empathy deverá abrir a janela de “Selecionar um arquivo”.
Encontre o arquivo que você deseja enviar e clique no botão Enviar. Uma
janela de “Transferências de arquivo” irá se abrir mostrando o arquivo e o
progresso de sua transferência. ando a transferência do arquivo estiver
completa, você pode fechar a janela de “Transferências de arquivo”.

Recebendo um arquivo

When a contact wants to send you a file, the status icon to the le of the
contact’s name will flash with an icon of a paper plane. To receive the
file, double-click the contact’s name. Empathy will open the “Select a
destination” window. Choose the location where you would like Empathy
to save the file, and click Save. Empathy should open the “File Transfers”
window. e “File Transfers” window shows you the progress of current
file transfer. You can stop the file transfer by clicking on the Stop buon,
open transferred files by clicking on the Open buon, and clear the list of
completed transfers by clicking on the Clear buon.
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Alterando seu estado

Você pode usar o seu status para mostrar para seus contatos o quão ocu-
pado você está ou o que você está fazendo. Você pode usar os status
padrões, que são:

‣ Disponível
‣ Ocupado
‣ Ausente
‣ Invisível
‣ Desconectado

ese can be changed in one of two ways. e first method is in the
main Empathy window from the drop-down list at the top of the window.

A mesma lista permite que você defina um status customizado esco-
lhendo ”Mensagens personalizadas…” próximo ao ícone que coincide com
o seu status. Digite a mensagem que você quer deixar no seu status e
clique na marca verde.

e second method is to click the Messaging Icon on the top Unity
Bar. >From this menu, you will see all of the same options that Empathy
presents, but accessible without having to open the application window.

Alterando sua imagem

Your picture is what your contacts will see next to your name in their
contact list. e default picture is the outline of a person. You can change
your picture by opening the Edit menu, then choosing Personal Infor-
mation. Empathy should open the “Personal Information” window. From
the Account drop-down list choose the account that you want to change,
then click on the picture on the right-hand side of the window. Empathy
should open the “Select Your Avatar Image” window. Find the file con-
taining your picture, and click Open. If you would like to return it to the
default avatar, click on the No Image buon, instead.

Compartilhamento da área de trabalho

Desktop sharing is a very niy feature available with Ubuntu. It can be
used for a lot of purposes like troubleshooting, online meetings or just
showing off your cool desktop to your friend. It is very easy to get remote
desktop sharing working between two Ubuntu machines.

. Click on System ‣ Preferences ‣Remote Desktop and select Allow
remote desktop. It is strongly recommended you add a password, for
security reasons.

. Open Empathy and login using your Google/Jabber client 
. Clique duplamente no usuário com quem você deseja compartilhar seu

ambiente de trabalho
. From the new window, click on Contact ‣ Share your desktop.

Deve ser notado que o outro usuário irá obviamente ser capaz de ver as
informações exibidas na sua tela. Lembre-se disto se você tem documen-
tos ou arquivos de natureza privada abertos na sua área de trabalho.

Micro-blogging

O Gwibber é o aplicativo de microblog padrão que permite a você acessar
várias contas de redes sociais sem ter que abrir o navegador de Internet.
O Gwibber pode ser usado para acessar e postar no Twier, Facebook,
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Identi.ca, Ping.fm, Flickr, Digg, Status.net, Foursquare, Qaiku e Friend-
Feed.

Atualizações de versão e complementos

Before you begin using Gwibber, go to Ubuntu Soware Center and se-
arch for Gwibber. Select Gwibber; press More Info; check each add-on
that you want (or just select all of them); and press Apply Changes. You
need add-ons for Ping.fm, Flickr, Digg, Status.net, Foursquare, Qaiku and
FriendFeed. Wait for the them to finish installing. You need to log out and
in again to activate the add-ons.
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Figura 3.15: Use a Central de programas do
Ubuntu para obter complementos do Gwibber.

Trabalhando com contas de redes sociais no Gwibber

Pull down the Message menu from the top panel bar and select Broadcast.
is starts the app.
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Figura 3.16: The Gwibber pull-down menu
shows you a quick overview of your feeds.
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Se você não entrou anteriormente com uma conta, o Gerenciador de
Contas irá se abrir automaticamente. Caso contrário, selecione Editar ‣
Contas para abri-lo.
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Figura 3.17: Adicionando uma conta para usar
no Gwibber através do Gerenciador de Contas.

Para adicionar uma nova conta, clique no botão +; selecione o tipo de
conta (e.g., Facebook, Twier); clique em Adicionar. Defina as configura-
ções de conta e clique em Autorizar; e siga as instruções para autorizar a
conta.

Você pode adicionar mais de uma conta de um
provedor de serviços.Remover contas do Gwibber também é fácil. Vá para a janela do Ge-

renciador de Contas e selecione a conta a ser removida. Clique no botão -
para removê-la.

Using Gwibber to follow streams

Gwibber displays feeds from each service provider as streams. You can
list them in either ascending or descending order by selecting View ‣ Sort.
You can separate the feeds as messages, replies, and private messages.
In addition the aachments from the feed are sorted as images, links
and videos. Click the image, link or the video to take you to the website
in a new tab in your default browser; images can be previewed within
Gwibber.

Notificações

Você pode personalizar como as fontes de notícias são exibidas na bolha
de notificação e a frequência com que o Gwibber atualiza, em preferências
(Editar ‣ Preferências).

Reponder, curtir e retuitar

Each tweet can be liked, retweeted or replied from within Gwibber’s
window by clicking on the Twier icon at the top right of each post.

Atualizando o seu estado

To update your status using Gwibber, select Update Status from the You can prevent an account from posting from
Gwibber; Edit ‣Accounts ‣Account Settings.
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Figura 3.18: A stream in Gwibber. Clicking on
the image should open the Facebook page in a
browser.
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Figura 3.19: Uma notificação do Gwibber. As
notificações podem ser personalizadas a partir
do menu de preferências do Gwibber.

message icon in the top panel; this opens a new window. Type your
status message and post it to all your accounts with one click. Press Esc to
cancel.

You can customize each account in Gwibber to have its own color. You can
also shorten URLs as you post from Gwibber using a list of URL shortening
services. Play with Gwibber and discover other cool things it can do. Open
http://gwibber.com/docs/user-guide/current/master_social_networking_with_
gwibber.pdf for more information.

Visualizando e editando fotos

Shotwell Photo Manager is the default photo application in Ubuntu. is
application allows you to view, tag, edit, and share your photos. To start
Shotwell, click on the Ubuntu icon near the top-le of the screen, then
select the Shotwell icon labeled View Photos.

http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
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Figura 3.20: De maneira semelhante, você
pode ”curtir” ou comentar uma atualização a
partir do Gwibber.
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Figura 3.21: Manage your photo collection,
enhance your photos while keeping the
original, and share your memories online using
Shotwell Photo Manager.

Importando fotos

When you launch Shotwell for the first time, you will be greeted by the
“Import” window. Aer the first launch, you can import more photos by
dragging the photos into the Shotwell window. You can also import pho-
tos by connecting your camera or external storage device to the computer.

De uma câmera digital Connect your camera to the computer using
the data cable and power it on. If your camera is properly detected, you
will see a new window prompting you to launch an application. Select
Shotwell in the drop-down menu then click OK. Your camera will be
listed in the Shotwell sidebar. Select your camera in the sidebar. You
will see a preview of the camera’s contents. Select individual photos by
pressing and holding Ctrl and clicking on each photo you want to import,
and then clicking Import Selected on the boom bar of the window. Or,
you can choose to import all photos by clicking Import All.
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Do seu computador Você pode importar fotos para o Shotwell arrastando-
as do gerenciador de arquivos para dentro da janela do Shotwell. Alterna-
tivamente, você pode clicar em Importar de pasta…, ‣ selecionar a pasta
contendo as fotos que você quer importar.

De um HD externo, pendrive , ou / A importação de fotos de
dispositivos de armazenamento externo é semelhante à importação de fo-
tos de seu computador. O seu dispositivo de armazenamento externo pode
aparecer também abaixo do rótulo Câmera na barra lateral do Shotwell.
Siga as instruções para importação a partir da câmera ou do computador.

Escolhendo onde o Shotwell salva as fotos

e default location for the Shotwell Library is your Pictures folder.
When importing pictures in the “Import” window, you will be given the
option to copy the files to your Library, or keep the files in place.

If you have your photos stored on your computer, the option Import
in Place will be suitable so photos aren’t duplicated. If you are importing
photos from an external source, such as a portable hard drive,  flash
drive, or /, you should select Copy into Library so the photos are
copied to your computer—otherwise they won’t appear when you remove
the external source.

Visualizando fotos

Choose Library or any collection in the sidebar to display photos from
your selection. Use the slider on the boom bar to adjust the size of the
thumbnails. To view a full-window image, double-click an individual
photo. In the full-window view, you can navigate through the collection
using the back and forward arrows, zoom on the image using the slider,
pan by clicking and dragging the image, and exit the full-window view by
double-clicking the image.

To view the collection in full-screen mode, press F11 or go to View ‣
Fullscreen. You can navigate through the collection using the toolbar
that is available by moving your mouse to the boom of the screen. To
view a slideshow presentation of the collection, press F5 or go to View ‣
Slideshow. Press the Esc key to exit the Fullscreen or Slideshow views.

Organizando as fotos

Shotwell makes finding photos of the same type easier by using tags. You
can apply as many tags to a photo as you like. To apply tags to photos,
first select the photos. en right-click on the photos and select Add Tags.
Enter the tags you want into the text field, separated by commas. If you
are adding new tags, these will appear in the side bar on the right under
the Tags label.

Editando imagens

You may want to edit some of the photos you import into Shotwell. For
example, you may want to remove something at the edge, adjust the
color, reduce the red-eye effect, or straighten the image. To edit a photo,
double-click on the photo that you want to edit and then click on one of
the following buons:
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Girar

Click Rotate to rotate the image ° clockwise. You can click the buon
more than once and it will rotate the image clockwise in ° intervals.

Crop

Click Crop to change the framing of the photo. e image will darken
and a selection will appear. Adjust the selection to your desired crop by
dragging a corner or side. If you want to choose a specific aspect ratio,
use the drop-down menu to select one of the preset ratios or enter your
own custom ratio. A pivot buon is provided to change your selection
from landscape to portrait and vice versa. Once you are happy with the
selection, click OK to apply the crop or Cancel to discard it.

Redução de olhos-vermelhos

Se você tirou uma foto e o flash fez com que a pessoa na imagem fi-
casse com os olhos vermelhos, você pode consertar esse problema com
o Shotwell.

Clique no botão Olhos vermelhos buon. Um círculo irá aparecer
Arraste esse círculo até o olho que você quer editar e então use a barra

deslizante para ajustar o tamanho do círculo.
When the circle is over the eye, click Apply to fix the red eye. You will

need to repeat this for each individual eye. Use caution when adjusting
the size of the circle. A circle too large and covering the skin may cause
discoloration when applying the red-eye reduction.

Ajustar

Clicar no botão Ajustar irá trazer uma janela que permite você fazer
algumas coisas:

Nível Semelhante ao contraste
Exposição O quanto de brilho a foto possui
Saturação O quanto de cores a foto possui
Matiz A coloração geral
Temperatura Se a imagem é quente (mais amarelada) ou fria (mais azu-

lada)
Sombras O quanto as sombras são escuras

Para alterar esses valores, arraste as barras deslizantes até ficar satis-
feito com a imagem. Clique em OK para aplicar as alterações, Restaurar
para desfazer as alterações e iniciar novamente, ou Cancelar para descar-
tar as alterações.

Auto-ajuste com Ajustar

Click Enhance to let Shotwell automatically adjust the color, levels, expo-
sure, contrast and temperature to make a more pleasing image.

Restaurando uma foto editada ao original

ando você edita uma foto no Shotwell, a imagem original permanece
intocada. Você pode desfazer todas as alterações e reverter para a versão
original clicando com o botão direito do mouse na foto e selecionando
Reverter para o original. Esta opção está disponível para as fotos que
você editou.
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Compartilhando suas fotos

Você pode compartilhar facilmente suas fotos na web usando a funci-
onalidade de publicação do Shotwell. Selecione as fotos que você quer
compartilhar e clique no botão Publicar localizado na barra inferior. Es-
colha entre Facebook, Flickr ou Picasa Web Albums na caixa de seleção
e inicie a sessão com suas credenciais. Alguns serviços poderão requerer
que você autorize o Shotwell antes que o aplicativo possa publicar fotos.
Siga as instruções na janela, selecione as opções desejadas e clique no
botão Publicar para fazer o upload das suas imagens para a web.

Informações adicionais

Nós só falamos superficialmente das funcionalidades do Shotwell. Para
obter mais ajuda, selecione Ajuda ‣Conteúdo. Isso irá carregar o manual
on-line, onde você poderá obter instruções mais detalhadas sobre como
usar o Shotwell de maneira efetiva.

Assistindo vídeos e filmes

Para assistir vídeos ou s no Ubuntu, você pode usar o aplicativo Re-
produtor de filmes. Para iniciar o Reprodutor de filmes, clique no Dash,
procure por ”Reprodutor de filmes” e selecione-o. Isso irá fazer a janela do
“Reprodutor de filmes” se abrir.
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Figura 3.22: O reprodutor de filmes (Totem)
toca músicas e vídeos.

Codecs

Assistir a s pode requerer quo o Ubuntu tenha instalado um “codec,”
que consiste em uma parte de soware que permite ao seu computador
compreender o conteúdo do , e mostrar o vídeo.

Aviso Legal: patentes e direitos autorais operam de forma diferente dependendo
de qual país você está. Por favor, obtenha aconselhamento jurídico se você
estiver incerto se uma patente específica ou restrição se aplica a um formato de
mídia que deseja usar em seu país.
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Para você conseguir tocar todos os vídeos e s, você terá que instalar
alguns codecs. Eles estão localizados no repositório Multiverse. e está
habilitado por padrão.

Para instalar os codecs, abra a Central de programas do Ubuntu, ou
através do Dash ou do Lançador. ando a janela da “Central de progra-
mas do Ubuntu” se abrir, use a barra de pesquisa no canto superior direito
e procure pelo seguinte:

‣ ubuntu-restricted-extras
‣ libdvdread
‣ libdvdnav

ando você achar cada um, selecione clicando duas vezes e então
clique no botão Instalar. Isso deve abrir uma janela de “Autenticar”. En-
tão, digite sua senha e clique em Autenticar para iniciar o processo de
instalação.

Reproduzindo vídeo de um arquivo

Abra o menu Filme e selecione Abrir…. Isso irá abrir a janela de “Seleci-
onar filmes ou listas de reprodução”. Encontre o arquivo ou arquivos que
você deseja reproduzir e clique no botão Adicionar. O vídeo ou os vídeos
serão reproduzidos.

Reproduzindo um DVD

ando você insere um  no computador, Ubuntu deve abrir a janela
“Você tem que inserir um  de vídeo. Escolha qual aplicativo para
executar”. Certifique-se de que Open Movie Player está escolhido na lista
suspensa e então clique em OK. A janela do “Movie Player” vai abrir e o
filme começará a ser exibido.

If the “Movie Player” window is already open, open Movie menu, then
select Play Disc… and the movie will start.

Ouvindo sons e músicas

O Ubuntu vem com o reprodutor de músicas Rhythmbox para que você
ouça suas músicas, rádios da Internet e gerencie listas de reprodução e
podcasts. O Rhythmbox também pode ajudá-lo a gerenciar inscrições de
suas fontes de notícias de  preferidas.

Iniciando o Rhythmbox

Existem muitas maneiras de iniciar o Rhythmbox.

‣ Abra o Painel, selecione Ouvir música, e escolha qualquer dos arquivos
de música exibidos (se você tiver algum).

‣ Abra o Painel, digite Rhythmbox e clique no ícone do Reprodutor de
músicas Rhythmbox.

‣ O Ubuntu . vem com um indicador de menu na barra superior para
aplicativos relacionados com dispositivos de áudio. Este menu inclui
um link para iniciar o Rhythmbox, e controles básicos de reprodução e
volume.

If you close Rhythmbox by pressing Alt+F4 or clicking the red close
buon ( ), it will disappear from view but continue to play in the back-
ground. You can still control your music or reopen from the Sound indica-
tor. To quit Rhythmbox completely, press Ctrl+Q.
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Figura 3.23: Reprodutor de músicas Rhythm-
box

Reproduzindo música

To play music, you must first import music into your library. Choose
Music ‣ Import Folder… or press Ctrl+O on your keyboard to import a
folder of media, a single file, an Amazon  purchase or media from an
iOS or Android device. e Rhythmbox toolbar contains most of the con-
trols that you will use for browsing and playing your music. If you want
to play a song, double-click a track or click it and press the Play buon
on the toolbar (you can also choose Control ‣ Play from the menubar or
press Ctrl+Space). When a song is playing, the Play buon will become a
Pause buon. Clicking on it will pause the song. Next and Previous but-
tons are next to the Play/Pause buon. You can click on these buons to
play the next and previous songs in your library or playlist. Rhythmbox
also has options to toggle Repeat or Shuffle modes. Rhythmbox offers
two different types of shuffling, both of which can be accessed by clicking
on the drop-down menu next to Next buon or by using the global menu-
bar (Control ‣ Shuffle). Repeat controls are located in boom right hand
corner and through the global menubar (Control ‣Repeat).

Tocando CDs de Áudio

To play your CD, insert it into your CD drive. It will automatically appear
within Rhythmbox in the Side Pane beneath your Music Library. You can
click the  (named Audio , or the name of the album) and double-click
a track in it to play the tracks on the .

Importando (extraindo) CDs de áudio

Begin by inserting a . Rhythmbox will automatically detect it and add
it to the side menu. If you have an active Internet connection, Rhythmbox
will try to find the album details via the web. Click the . Uncheck any
tracks you don’t want imported. Press the Extract buon, located near
the upper-le corner of Rhythmbox. Rhythmbox will begin importing the
. As it finishes each track, it will appear in your Music Library.
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Ouvindo transmissão de áudio

Rhythmbox is pre-configured to enable you to stream audio from various Streaming audio stations are “radio stations”
that broadcast over the Internet. Some of
these are real radio stations that also stream
over the Internet, and others broadcast only
over the Internet.

sources. ese include Internet broadcast stations (Radio from the Side
Pane), Last.fm and Libre.fm. To listen to an Internet radio station, click
in the Radio icon in the Side Pane for a list of pre-configured stations. You
can filter by genre in the middle pane. To add a new radio station, select
Add and enter the radio station . You can browse a selected list of radio stations

at http://en.wikipedia.org/wiki/List_of_
Internet_stations or you can use your browser
to search for “Internet radio stations.”Conecta com reprodutor de áudio digital

O Rhythmbox pode se conectar a vários reprodutores de mídia digital
conhecidos. Os reprodutores conectados irão aparecer na Lista de dispo-
sitivos. Os recursos irão variar dependendo do reprodutor (e também de
o quanto o reprodutor é conhecido), mas as tarefas comuns como transfe-
rência de músicas e listas de reprodução devem ser suportadas.

M I S S I N G S C R E E N S H O T
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Figura 3.24: Rhythmbox conectado a um
dispositivo Android

Ouça músicas compartilhadas

If you are on the same network as other Rhythmbox users (or most other DAAP stands for “Digital Audio Access
Protocol,” and is a method designed by Apple
Inc. to let software share media across a
network.

music player soware), you can share your music and listen to their sha-
red music. To do this, click Music ‣Connect to DAAP Share… en enter
the IP address and the port number. en click OK. Clicking a shared
library will enable you to browse and play songs from other computers.

Gerencia podcasts

Rhythmbox can manage all of your favorite podcasts. Select Podcasts
from the Side Pane to view all added podcasts. e toolbar will display
additional options to Browse, Show All, Add and Update. Choose Add on
the toolbar and enter the URL of the podcasts to save it to Rhythmbox.
Podcasts will be automatically downloaded at regular intervals or you
can manually update feeds. Select an episode and click Play. You can also
delete episodes.

http://en.wikipedia.org/wiki/List_of_Internet_stations
http://en.wikipedia.org/wiki/List_of_Internet_stations
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View

Rhythmbox comes with the option of a party mode. To enter party mode
press F11 on your keyboard or use the global menubar (View ‣ Party
Mode); to exit from party mode press F11 again. Rhythmbox also has a
browser bar that is enabled by default (this area is the top-right half of the
program window). It gives you the option to search your music by artist
(upper-right) or album.

Preferências do Rhythmbox

e default configuration of Rhythmbox may not be exactly what you
want. Choose Edit ‣ Preferences to alter the application seings. e
Preferences tool is broken into four main areas: General, Playback Music
and Podcasts.

Geral includes how you want Rhythmbox to display artist and track
information. You can also adjust the columns visible in your library
and how the toolbar icons are displayed.

Opções de reprodução permitem que você ative a transição suave e a
duração da transição entre as faixas.

Música inclui onde você gostaria de colocar seus arquivos de música e a
estrutura de biblioteca para as novas faixas adicionadas ao Rhythmbox.
Você pode também definir seu formato de áudio preferido.

Podcasts designa onde os podcasts são armazenados no seu computador
e possibilita alterar a frequência de atualização das informações dos
podcasts.

Plug-ins

Rhythmbox supports a wide array of plugins, which add functionality to
Rhythmbox. Many of the plugins provide basic audio playback, and you
may check a few more boxes, for example, to access the Magnatune Store.
To view or change the activated plugins, use the global menubar (Edit ‣
Plugins).

Gerenciando suas músicas

Rhythmbox supports creating playlists. Playlists either are static lists
of songs to be played in order, or can be smart playlists based on filter
criteria. Playlists contain references to songs in your library. ey do not
contain the actual songs, but only reference them. So, if you remove a
song from a playlist (right-cli on the song ‣Remove from Playlist), the
song will remain in your library and on your hard drive.

Para criar uma lista de reprodução, selecione Música ‣ Lista de re-
produção ‣Nova lista de reprodução, pressione Ctrl+N, ou clique com
o botão direito do mouse na parte de baixo, em branco, da barra lateral
e selecione Nova lista de reprodução. Ela aparece na barra lateral como
”Nova lista de reprodução”. Clique com o botão direito do mouse e seleci-
one Renomear para dar à nova lista um nome que você escolher. Arraste
músicas da sua biblioteca para a nova lista de reprodução no painel late-
ral ou ou clique com o botão direito do mouse nas músicas e e selecione
Adicionar à lista de reprodução e escolha a lista.

Smart Playlists are created in a similar way. Choose Music ‣ Playlist ‣
New Automatic Playlist or right-click in the lower blank area of the side
bar and select New Automatic Playlist. Define the filter criteria. You
can add multiple filter rules and select a name. Save. You can update any
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playlist (including the predefined ones) by right-clicking on the name and
choosing Edit.

O Rhythmbox tem suporte a avaliação de músicas. Clique com o bo-
tão direito do mouse em uma música na sua biblioteca ‣ Propriedades ‣
Detalhes e clique no número de estrelas. Para remover a avaliação, seleci-
one zero estrelas. Outras informações sobre a música, como título, artista
e álbum podem ser alterados. Clique com o botão direito do mouse em
uma música na sua biblioteca ‣ Propriedades ‣Básico.

Para remover uma música, clique com o botão direito do mouse ‣
Remover. Para excluir uma música do seu HD, clique com o botão direito
do mouse ‣Mover para a lixeira. Se você quiser mover uma música,
selecione a música (ou um grupo delas) a partir de sua biblioteca e arraste
para uma pasta ou para a sua área de trabalho. Isso irá fazer uma cópia do
arquivo de áudio no novo local.

Lojas de música

O Rhythmbox tem uma loja integrada que lhe dá acesso a um catálogo
enorme de músicas, com várias opções de licenciamento. A Ubuntu One
Music Store (veja na figura abaixo) vende músicas de grandes e pequenos
selos musicais. A loja oferece músicas sem  (sem proteção contra có-
pias), codificadas em alta qualidade no formato MP. Você pode navegar
pelo catálogo, reproduzir amostras e comprar músicas da Ubuntu One
Music Store. Como o nome sugere, a Ubuntu One Music Store se integra
com o serviço do Ubuntu One. Todas as aquisições são transferidas para
a sua nuvem pessoal e são automaticamente copiadas para todos os seus
computadores. Por esta razão, uma conta do Ubuntu One é necessária
(a inscrição é rápida e gratuita). O catálogo de músicas disponíveis para
aquisição irá depender de em que lugar do mundo você mora. Mais in-
formações sobre a Ubuntu One Music Store podem ser encontradas em
https://one.ubuntu.com/music/.
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Figura 3.25: Ubuntu One Music Store

Codecs de áudio

Diferentes arquivos de áudio (, , , , etc.) requerem ferra-
mentas únicas para decodificar e reproduzir seus conteúdos. Essas ferra-

https://one.ubuntu.com/music/
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mentas são chamadas de codecs. O Rhythmbox tenta detectar quaisquer
codecs faltantes no seu sistema, para que você possa reproduzir todos os
seus arquivos de áudio. Se um codec está faltando, ele automaticamente
tenta achá-lo na internet e guia você ao longo de sua instalação.

Suporte Rhythmbox

Rhythmbox é utilizado por vários usuários em todo o mundo. Há uma
variedade de recursos de suporte disponíveis em vários idiomas.

‣ Ajuda ‣Conteúdo ou F1 para a ajuda principal.
‣ Ajuda ‣Obter ajuda on-line… para fazer perguntas e reportar bugs.
‣ O website do Rhythmbox http://www.rhythmbox.org/.
‣ Fórum do Ubuntu sobre a categoria Multimídia & Vídeo: http://

ubuntuforums.org/forumdisplay.php?f=

Gravando CDs e DVDs

Para criar um  ou  abra o Dash e procure por Gravador de discos
Brasero, abra-o. Com o Brasero aberto, cinco opções de gravação serão
mostradas. Cada uma delas será explicada abaixo.
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Figura 3.26: O Brasero grava músicas, vídeos e
dados em DVDs e CDs.

Introdução

Antes de você poder usar o Brasero, você precisa Criar um no projeto.
Existem três tipos de projetos disponiveis: Projeto de áudio, Projeto de da-
dos e Projeto de vídeo. Faça sua escolha baseada nos seus requerimentos.

Até o presente momento, o Brasero não
suporta Blu-Ray.As seguintes opções se aplicam para todos os projetos, exceto Cópia de

disco e Gravar imagem

Adicionando arquivos ao projeto

Para adicionar arquivos à lista, clique no botão + Verde, que abrirá a ja-
nela de “Selecionar arquivos”. Navegue até o arquivo que você deseja
adicionar, clique no arquivo desejado e então clique no botão Adicionar.

http://www.rhythmbox.org/
http://ubuntuforums.org/forumdisplay.php?f=334
http://ubuntuforums.org/forumdisplay.php?f=334
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Repita esse processo para cada arquivo até que todos os arquivos deseja-
dos tenham sido adicionados.

Removendo arquivos

Se você deseja remover um arquivo do projeto, clique no arquivo na lista Ícones de uma vassoura são frequentemente
usados no Ubuntu para representar limpeza
em um campo de texto ou retornar alguma
coisa para o seu estado padrão.

ou clique no botão - Vermelho. Para remover todos os arquivos da lista
clique no botão com a forma de uma vassoura.

Salvando o projeto

Para salvar um projeto não terminado, escolha Projeto ‣ Salvar como….
A janela “Salvar o projeto atual” será aberta. Escolha onde você gostaria
de salvar o projeto. Digite no campo de texto Nome: o nome do projeto.
Agora clique no botão Salvar.

Gravando o disco

ando você clicar no botão Gravar…, você verá a janela “Propriedades
de …”.

Você pode especificar a velocidade de gravação na lista suspensa Velo-
cidade de gravação. É melhor escolher a velocidade mais alta.

Para gravar seu projeto diretamente no disco, selecione a opção Gravar
imagem diretamente sem salvar no disco. Com esta opção selecionada,
nenhum arquivo de imagem será criado e nada será salvo no seu disco
rígido. Todos os dados serão gravados em um CD ou DVD em branco.

e Simulate before burning option is useful if you encounter pro- Temporary files are saved in the /tmp folder
by default. Should you wish to save these files
in another location, you will need to change
the setting in the Temporary files drop down
menu. Under normal conditions, you should
not need to change this setting.

blems burning discs. Selecting this option allows you to simulate the
disc burning process without actually writing data to a disc—a wasteful
process if your computer isn’t writing data correctly. If the simulation
is successful, Brasero will burn the disc aer a ten second pause. During
those ten seconds, you have the option to cancel the burning process.

Limpando o disco

Se você está usando um disco que possui as letras  escritas nele e RW significa Re-Writable, em português,
regravável, o que significa que o disco pode ser
usado mais de uma vez.

você já utilizou-o antes, você pode apagá-lo para reutilizá-lo. Isto irá
apagar todos os dados atuais do disco. Para apagar um disco, abra o menu
Ferramentas e selecione Apagar…. A janela de “Apagar disco” será aberta.
No lista Selecione um disco, selecione o disco que você deseja apagar.

Você pode marcar que a opção Apagar rápido se você desejar reduzir
o tempo total gasto para o processo de apagar o disco. Entretanto, mar-
cando esta opção os arquivos não serão removidos completamente; se
você tiver algum dado sensível em seu disco, o melhor modo é não marcar
a opção Apagar rápido.

Uma vez que o disco tenha sido apagado (estiver vazio), você verá O
disco foi apagado com sucesso. Clique no botão Fear para encerrar.

Projeto de áudio

Se você grava suas próprias músicas, então você pode querer transferi-las
para um  de áudio, dessa forma, seus amigos e família poderão ouví-
las. Você pode iniciar um projeto de áudio clicando em Projeto ‣Novo
projeto ‣Novo projeto de áudio.

Ao gravar um CD de música, é importante lembrar que CDs comerciais
de musica geralmente possuem um intervalo de dois segundos entre as
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músicas. Para garantir que suas músicas tenham o mesmo intervalo,
clique em um arquivo e então clique no botão de pausa.

Você pode dividir os arquivos em partes clicando no botão de uma
Faca. Ele irá abrir uma janela de nome “Dividir faixa”. A caixa de seleção
Método lhe dá quatro opções, cada uma delas deixa você dividir a faixa de
uma maneira diferente. Uma vez que a faixa foi dividida, clique no botão
OK.

Na caixa de seleção na parte de baixo da janela principal do “Brasero”,
tenha certeza de ter selecionado o disco aonde você deseja gravar os
arquivos. Então, clique no botão Gravar.

Projeto de dados

Se você deseja fazer uma cópia de segurança dos seus documentos ou
fotos, o melhor a fazer é criar um projeto de dados. Você pode criar um
projeto de dados clicando em Projeto ‣Novo projeto ‣Novo projeto de
dados.

Se você quer adicionar um diretório você pode clicar na imagem de
uma Pasta e, então, digitar o nome do diretório.

Na lista que está na parte de baixo da janela principal do “Brasero”, te-
nha certeza de ter selecionado o disco que você deseja gravar os arquivos.
Então, clique no botão Gravar.

Projeto de vídeo

Se você deseja criar um  com seus vídeos de família, o melhor a fazer
seria criar um projeto de vídeo. Você pode criar um clicando em Projeto ‣
Novo Projeto ‣Novo projeto de vídeo.

Na caixa de seleção na parte de baixo da janela principal do “Brasero”,
tenha certeza de ter selecionado o disco aonde você deseja gravar os
arquivos. Então, clique no botão Gravar.

Cópia de disco

Você pode copiar um disco clicando em Projeto ‣Novo projeto ‣Copiar
disco…. Isso abrirá a janela “Copiar /”.

Se você tiver duas unidades / você pode copiar de um disco
para o outro, o disco que você deseja copiar precisa estar na unidade 
/. Se você tiver apenas uma unidade você vai precisar fazer
uma imagem e depois gravá-la em um disco. No menu suspenso Selecione
o disco para copiar escolha o disco para copiar. No menu suspenso Sele-
cione um disco para gravar escolha arquivo de imagem ou o disco para
onde deseja copiar.

Arquivo de imagem

Você pode alterar onde o arquivo de imagem é gravado clicando em Pro-
priedades. Isto irá exibir a janela “Localização para o arquivo de imagem”.
Você poderá editar o nome do arquivo no campo de texto Nome:

e default save location is your home folder, you can change this by
clicking the + buon next to Browse for other folders. Once you have
chosen where you want to save the photo or image, click Close.

Back in the “Copy /” window click Create Image. Brasero will
open the “Creating Image” and will display the job progress. When the
process is complete, click Close.
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Gravar imagem

Para gravar uma imagem, abra Projeto ‣Novo projeto ‣Gravar imagem…
O Brasero irá abrir a janela de “Preferências de gravação de imagem”.
Clique no botão Clique aqui para selecionar uma imagem de disco e a ja-
nela de “Selecionar imagem de disco” irá aparecer. Navegue até encontrar
a imagem que você deseja gravar, clique nela e então clique em Abrir.

No menu suspenso Selecione um disco para gravar, clique no disco no
qual você gostaria de escrever, em seguida, clique em Criar Imagem.

Trabalhando com documentos, planilhas e apresentações

LibreOffice suite is the default office suite when working with: word
documents, spreadsheets, and slide presentations.

Trabalhando com documentos

If you need to work with documents, you can use the LibreOffice Word The LibreOffice Word Processor is also known
as the LibreOffice Writer. Spreadsheet is also
known as Calc, and Presentation is known as
Impress.

Processor. To start the word processor, open the Dash home of the Laun-
cher, search for LibreOffice Writer and select it. Ubuntu should then
open the main window for the word processor.

Trabalhando com planilhas

If you need to work with spreadsheets, you can use the LibreOffice Spre-
adsheet. To start the spreadsheet application, click on the Dash home,
type LibreOffice Calc and select LibreOffice Calc.

Trabalhando com apresentações

If you need to work with slides for a presentation, you can use the Libre-
Office Impress. To start the presentation application, open the Dash home
menu, type LibreOffice Impress, and then click on it.

Obtendo mais ajuda

Cada uma dessas aplicações vem com uma coleção compreensiva de
telas de ajuda. Se você está procurando por mais assistência para essas
aplicações, pressione a tecla F1 após iniciar a aplicação.

Ubuntu One

O que é Ubuntu One?

Ubuntu One é um serviço para armazenamento de arquivos on-line—na
sua Nuvem Pessoal do Ubuntu One. Ela é o seu espaço de armazenamento
pessoal on-line; ela pode ser acessada a partir de qualquer navegador web
ou usando um aplicativo do Ubuntu One, como aqueles desenvolvidos
para Ubuntu, Windows, iPhone ou Android. Pelo fato do Ubuntu One
armazenar on-line os seus arquivos, ele é a forma perfeita para fazer có-
pias de segurança de seus arquivos para prevenir perda de dados. Você
também pode usar o Ubuntu One para compartilhar arquivos com outras
pessoas—isso faz o Ubuntu One ser uma ótima ferramenta para amigos,
familiares e times colaborativos. O Ubuntu One também oferece serviços
para executar cópias de segurança dos seus contatos e reproduzir músi-
cas em dispositivos móveis. O serviço do Ubuntu One é fornecido pela
Canonical.
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Quão seguro é o Ubuntu One?

Antes de usar o Ubuntu One, você deve ter os seguintes pontos em mente:

‣ Enviar, baixar e sincronizar suas informações com o Ubuntu One são
operações feitas em uma conexão criptografada, que previne que al-
guém bisbilhote as suas informações enquanto elas estão sendo transfe-
ridas.

‣ Os arquivos não são armazenados pela Canonical na sua forma cripto-
grafada. É importante ter isso em mente ao decidir o que enviar para
o Ubuntu One. Você pode utilizar outros meios de criptografar os seus
dados, como um arquivo zip criptografado.

‣ A informação enviada para o Ubuntu One pode potencialmente ser
acessada pela Canonical. Assim como serviços e websites on-line
similares, você está implicitamente confiando que ela irá respeitar sua
privacidade, então se de alguma forma você sente que não pode confiar
à ela certas informações, não envie-as para o Ubuntu One.

‣ Se você violar os termos e condições do Ubuntu One e armazenar ma-
terial ilegal, a Canonical pode ser requisitada a entregar a informação
para agências de aplicação da lei, sem o seu consentimento.

‣ Sua informação on-line pode ser acessada por qualquer um que souber
(ou conseguir adivinhar) seu nome de usuário e senha. Por esta razão,
você deve escolher uma boa senha e mantê-la segura.

Introdução ao Ubuntu One

Para usar o Ubuntu One, você precisa criar uma conta gratuita do Ubuntu 5GB é espaço suficiente para armazenar
1.500 arquivos de música ou 5.000 fotografias
(dependendo do tamanho).

One usando um endereço de e-mail. Essa conta lhe dará acesso ao ar-
mazenamento de GB on-line e o serviço de sincronização de contatos;
o acesso a um armazenamento maior e a um serviço de reprodução de
música on-line requer uma inscrição paga.

Há duas maneiras de criar um conta do Ubuntu One. Você pode se
registrar usando o Painel de controle do Ubuntu One (pré-instalado no
Ubuntu), ou você pode se registrar no site do Ubuntu One https://one.
ubuntu.com clicando no link Sign Up.
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Figura 3.27: Este ícone do Lançador abre o
Painel de Controle do Ubuntu One.

Criando uma conta no Ubuntu One usando o Painel de Controle do Ubuntu One

No Lançador, clique no ícone do Ubuntu One, como mostrado na Figura
.. Isso irá abrir a caixa de diálogo da Figura ..

Clique no botão Eu ainda não tenho uma conta - quero me inscrever.
Preencha os detalhes solicitados. Tenha certeza de estar usando um Se você não possui um endereço de e-mail,

você pode obter um gratuitamente em
gmail.com.

endereço de e-mail válido que somente você possui acesso.
Você deve ler os Termos do serviço e a Política de privacidade antes

O captcha atua como um verificador que
checa se é realmente uma pessoa que está
preenchendo o formulário (porque um
computador não conseguiria ler o texto do
captcha).

se inscrever. ando você estiver satisfeito, clique em Configurar conta.
Dentro de poucos minutos, você irá receber um e-mail contendo o

código de verificação. Digite o código de verificação na caixa como mostra
a Figura . e clique em Próximo.

Se tudo ocorrer bem, você verá uma janela dizendo: ”Você está auten-
ticado no Ubuntu One.”; nesta janela clique no botão Finalizar. Agora que
você está conectado ao Ubuntu One, você pode configurar sua máquina
com o Ubuntu para a sincronização de arquivos do Ubuntu One.

Configurar a sua máquina com o Ubuntu para sincronizar arquivos

e Ubuntu One desktop application syncs your Ubuntu One Personal Sync is short for Synchronize; implying that
the contents of your Ubuntu One local file
system and your Ubuntu One Personal Cloud
will always be identical.

Cloud with files on your local file system. Aer logging into the Ubuntu

https://one.ubuntu.com
https://one.ubuntu.com
gmail.com
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Figura 3.28: A tela de boas vindas do Painel de
controle do Ubuntu One.
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Figura 3.29: Preencha todos os campos com
seus dados para criar conta no Ubuntu One.

One desktop application the following dialog (Figure .) should appear,
allowing you to select which files to sync with your Ubuntu One Personal
Cloud.

If you have already used your Ubuntu One account, you may have
more folders in this view (Figure .). You can choose which Ubuntu One
cloud folders you would like synced with your local file system. If this is
the first time you are using Ubuntu One, just click the Next buon.

Você pode também alterar a sua configuração de sincronização do Ubuntu One
nesse momento clicando no botão Verificar configuração. Você pode alterar
configurações como a taxa máxima de upload e download, ou se notificações
são permitidas

In this dialog (Figure .), you can choose which of your local file sys-
tem folders you would like synced with your Ubuntu One cloud storage.
e folder Ubuntu One is implicitly synced, but you can select additional
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Figura 3.30: Digite o código de verificação no
campo.
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Figura 3.31: This setup dialog lets you select
which existing Ubuntu One folders you would
like synced with your machine.

folders you may like synced—your pictures, for instance. Once you’re
finished selecting folders, click the Finish buon to complete the setup
process. You are now ready to begin using Ubuntu One!

Usando o Ubuntu One com o gerenciador de arquivos Nautilus

O Ubuntu One se integra com o Nautilus, o programa que você usa para
visualizar o seu sistema de arquivos. Você pode adicionar, sincronizar e
compartilhar arquivos diretamente do Nautilus.
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Figura 3.32: This setup dialog lets you select
which folders of your local file system you
would like synced with your Ubuntu One cloud
storage.
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Figura 3.33: Esses símbolos indicam o estado
de sincronização de um arquivo ou diretório.
A marca de checagem indica que o arquivo ou
diretório já foi sincronizado e a seta circular
indica que o arquivo ou diretório está em
processo de sincronização.

Adicionando e modificando arquivos

M I S S I N G S C R E E N S H O T
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Figura 3.34: Ao adicionar arquivos a um
diretório sincronizado do Ubuntu One, eles
automaticamente são sincronizados com a sua
nuvem pessoal

. Você pode adicionar arquivos para o diretório do Ubuntu One (ou
qualquer outro diretório que você tenha selecionado para sincronização)
da mesma forma que faria normalmente, o Ubuntu One automaticamente
sincronizará eles com a sua nuvem pessoal. Por exemplo, se você adicio-
nou fotos de férias, você deveria ver uma tela similar à Figura ..

Após mover arquivos para o diretório sincronizado do Ubuntu One,
você deve receber uma notificação informando que a sincronização co-
meçou. Você também pode ver que cada arquivo se encontra com um
ícone de uma seta circular, indicando que ele está atualmente se sincroni-
zando com a sua nuvem pessoal. ando a sincronização terminar, a seta
circular será substituída por marcas de checagem.
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Sempre que você adicionar ou modificar arquivos nos seus diretórios
sincronizados com o Ubuntu One, eles irão ser automaticamente sincro-
nizados com a sua nuvem pessoal. Após o término da sincronização, você
pode ver os arquivos pela interface web do Ubuntu One e eles também es-
tarão sincronizados com qualquer outro computador ou dispositivo móvel
que estiver usando o Ubuntu One.

Adicionando pastas ao sync

Você pode adicionar outros diretórios para serem sincronizados com
sua Nuvem Pessoal do Ubuntu One, além de seu diretório do Ubuntu
One. Você pode adicionar diretórios para serem sincronizados através
do Nautilus clicando com o botão direito no diretório que você deseja
sincronizar. No menu que irá aparecer, escolha Ubuntu One ‣ Sincronizar
essa pasta, como mostra a Figura .. Você também pode interromper a
sincronização de um diretório através do mesmo menu.

M I S S I N G S C R E E N S H O T

ss:U1-naut-addfolder-rtclick

The file screenshots/pt_BR/03-U1-naut-addfolder-rtclick.png does not exist!

Figura 3.35: Use o menu que aparece ao clicar
em um diretório com o botão direito para
sincronizar ou interromper a sincronização
de um diretório com a sua Nuvem Pessoal do
Ubuntu One.

To view which files on your system are are currently syncing with
Ubuntu One, open the Ubuntu One Control Panel by clicking the Ubuntu
One Launcher icon, as shown in Figure .; a dialog similar to that in
Figure . should appear.

No Painel de controle do Ubuntu One você pode ver quais pastas estão
sincronizadas com a sua nuvem pessoal do Ubuntu One. Você também
pode adicionar arquivos a partir dali, clicando no botão Adicionar uma
pasta deste computador.

Utilizando o Ubuntu One com a interface web do Ubuntu One

You can access your files from any computer using the Ubuntu One Web AWeb UI (User Interface) is a web site that
you can go to and do the same things that you
do on your computer. Emails, for instance, are
commonly accessed through a Web UI.

UI at https://one.ubuntu.com. When you first reach the web page, you
will need to log in by clicking Log in or Sign up in the upper right-hand
corner of the page. On the following page, fill in your email address and
Ubuntu One password, then click the Continue buon.

Uma vez logado, você deverá ser levado para o seu Painel. O Painel lhe
mostrará um resumo do seu uso de dados e o manterá informado de novas
funcionalidades no Ubuntu One.

https://one.ubuntu.com
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Figura 3.36: The Ubuntu One Control Panel
shows you which folders in your file system are
synced with your Ubuntu One Personal Cloud.

Para visualizar seus arquivos, clique no link Arquivos na barra de
navegação, na porção superior da página.

Baixando e enviando arquivos

To access your files from the Ubuntu One Web UI, you can simply down-
load them from your personal cloud. To download a file, click More
shown to the right of the file, as shown in the browser, then click on
Download file, as shown in Figure .. Clicking Download file will
initiate a file download through your browser.

Se você fizer alterações no arquivo, ou quiser adicionar um novo ar-
quivo à sua nuvem pessoal, é só clicar no botão Upload file na parte
superior da página. Isto irá enviar o arquivo para o diretório atual e so-
brescrever quaisquer versões antigas do arquivo. Uma vez que você tenha
enviado o arquivo, ele estará disponível na sua nuvem pessoal, e irá sin-
cronizar com o sistema de arquivos de sua máquina local.
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Figura 3.37: Um botãoMais de um arquivo na
interface web lhe dá muitas opções.
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Tornando arquivos públicos

You can make a file public on the web by clicking More and choosing the
Publish file buon—this is also shown in Figure .. Aer clicking the
Publish file buon, the Web UI will generate a Public URL; you can share
this URL with anyone. By directing a browser to the Public URL of the
file, the browser should begin to download the file or it may display it,
depending on what type of file it is.

You can make the file private again at any time by clicking the Stop
publishing buon located to the le of the Public URL. Aer you click the
Stop publishing buon the Public URL field will go away, and the URL
will stop working. If someone tries to use a Public URL for a file that has
been made private they will receive an error message and the file will not
download or displayed.

Compartilhando arquivos

O Ubuntu One permite que você compartilhe arquivos com outros usuá-
rios do Ubuntu One, permitindo a fácil colaboração na edição de arquivos.
ando um usuário faz alterações em um arquivo compartilhado, as al-
terações são imediatamente sincronizadas com as nuvens pessoais dos
usuários e os sistemas de arquivo locais, de maneira que todos os usuários
têm a versão mais recente do arquivo.
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Figura 3.38: Compartilhando pastas com
outros usuários faz com que a colaboração em
arquivos seja simples.

To share files in Ubuntu One, you must share an entire folder. Before
you begin to share files, you should make sure only the files you want
to share are in this folder. en to share this folder, navigate to it in the
Ubuntu One Web UI, and click the More buon to the le of the folder
name. In the More menu, click on Share folder. A dialog box similar to
that shown in figure . should appear. Complete the fields in the dialog
box, and click the Share this folder buon when you are finished.

Uma vez que você tenha compartilhado uma pasta, o usuário com
quem você quer compartilhar a pasta irá receber um e-mail informando
que você gostaria de compartilhar a pasta. Ele então terá que aceitar o
pedido de compartilhamento. Se o endereço de e-mail que você forneceu
não tiver uma conta no Ubuntu One, o usuário terá primeiro que registrar
uma conta no Ubuntu One antes que possa acessar a pasta.
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Para parar de compartilhar uma pasta, navegue até ela, clique no botão
Mais, e clique em Parar de compartilhar.

Se um outro usuário compartilhar uma pasta com você, você receberá
um e-mail informando sobre o compartilhamento, e um link para clicar e
aceitar o pedido de compartilhamento. Pastas que são compartilhadas com
você por outros usuários irão aparecer na pasta Shared with me dentro da
pasta do Ubuntu One (~/Ubuntu One/Shared With Me/).

To stop syncing files that are shared with you, navigate to the folder in
the Ubuntu One Web UI, click the More buon, then click the Delete this
share buon.

Excedendo o seu limite de armazenamento no Ubuntu One

Se você exceder o limite de armazenamento da sua conta no Ubuntu
One,—limite gratuito de GB—, o Ubuntu One parará de sincronizar seus
arquivos com a sua Nuvem Pessoal do Ubuntu One.

Remediando um limite de armazenamento excedido

Você pode fazer diversas coisas para solucionar um limite de armazena-
mento excedido. Dentre elas estão:

‣ Exclua qualquer arquivo que não é mais necessário pois—é bom limpar
os arquivos antigos.

‣ Mova quaisquer arquivos que não precisam mais estar sincronizados
—para outra localização não sincronizada com o Ubuntu One.

‣ Compre espaço adicional de armazenamento—você pode comprar
espaço adicional de armazenamento em blocos de GB.

Comprando espaço adicional de armazenamento

Você pode comprar espaço adicional de armazenamento clicando no botão
Obter mais armazenamento no Painel de Controle do Ubuntu One ou
em https://one.ubuntu.com/services/. O armazenamento adicional está
disponível em blocos de GB e custa $./mês ou $./ano.
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Figura 3.39: Você pode comprar espaço
adicional de armazenamento no website do
Ubuntu One.

https://one.ubuntu.com/services/
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Figura 3.40: O Ubuntu One aceita cartões de
crédito e o PayPal para compras de espaço
adicional de armazenamento.

Obtendo o aplicativo do Ubuntu One para celular
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Figura 3.41: Este é o ícone para os aplicativos
do Ubuntu One para Android e iPhone.

O Ubuntu One possui aplicativos para dispositivos móveis como An-
droid e iPhone. Esses aplicativos permitem que você acesse, à qualquer
momento, seus arquivos pessoais na nuvem. Você pode obter mais infor-
mações sobre os aplicativos para Android e iPhone em https://one.ubuntu.
com/downloads/android/ e https://one.ubuntu.com/downloads/iphone/,
respectivamente.

Obtendo o Ubuntu One para Windows

O Ubuntu One também possui um aplicativo para Windows, que pode sin-
cronizar os arquivos da sua Nuvem Pessoal do Ubuntu One com o sistema
de arquivos de um sistema operacional Windows. Mais informação pode
ser encontrada em https://one.ubuntu.com/downloads/windows/.

Serviços adicionais do Ubuntu One

In addition to file syncing, Ubuntu One offers Contact Syncing and Music
Streaming services. ese services are not discussed in this book, but
additional information can be found at https://one.ubuntu.com/help/
tutorial/contact-sync-for-ubuntu--lts/ and https://one.ubuntu.com/
services/music/ respectively. e Music Streaming service requires a paid
subscription of $./month, and has a  day free trial period.

https://one.ubuntu.com/downloads/android/
https://one.ubuntu.com/downloads/android/
https://one.ubuntu.com/downloads/iphone/
https://one.ubuntu.com/downloads/windows/
https://one.ubuntu.com/help/tutorial/contact-sync-for-ubuntu-1004-lts/
https://one.ubuntu.com/help/tutorial/contact-sync-for-ubuntu-1004-lts/
https://one.ubuntu.com/services/music/
https://one.ubuntu.com/services/music/




4 Hardware

Usando seus dispositivos

O Ubuntu suporta uma ampla gama de hardware e o suporte a hardware
novo melhora a cada lançamento.

Identificação de hardware

Existem várias maneiras de identificar seu hardware no Ubuntu. A mais
fácil delas é instalar um aplicativo da Central de programas do Ubuntu,
chamada Sysinfo.

Primeiramente, abra a “Central de programas do Ubuntu”, então use
a caixa de pesquisa no canto superior direito para procurar por sysinfo.
Selecione o aplicativo e clique em Instalar. Digite a sua senha quando
solicitada para instalar o aplicativo.

Para executar o aplicativo, procure por Sysinfo na barra de pesquisas
do Painel. Clique no programa assim que você encontrá-lo. O programa
Sysinfo irá abrir uma janela que mostra informações sobre o hardware do
seu sistema.

Monitores

Drivers de hardware

Um driver é um pedaço de programa que diz para o seu computador como
se comunicar com uma peça de hardware. Cada componente em um
computador requer um driver para funcionar, seja ele uma impressora, um
reprodutor de , um disco rígido ou uma placa de vídeo.

e majority of graphics cards are manufactured by three well-known Your graphics card is the component in your
computer which outputs to the display.
Whether you are watching videos on You-
Tube, viewing DVDs, or simply enjoying the
smooth transition effects when you maxi-
mize/minimize your windows, your graphics
device is doing the hard work behind the
scenes.

companies: Intel, /, and  Corp. You can find your video
card manufacturer by referring to your computer’s manual, by looking for
the specifications of your computer’s model on the Internet, or by using
the command lspci in a terminal. e Ubuntu Soware Center houses
a number of applications that can tell you detailed system information.
SysInfo is one such program that you can use to find relevant information
about your System devices. Ubuntu comes with support for graphics
devices manufactured by the above companies, and many others, out
of the box. at means you don’t have to find and install any drivers
yourself, Ubuntu takes care of it all.

Keeping in line with Ubuntu’s philosophy, the drivers that are used by
default for powering graphics devices are open source. is means that
the drivers can be modified by the Ubuntu developers and problems with
them can be fixed. However, in some cases a proprietary driver (restricted
driver) provided by the company may provide beer performance or
features that are not present in the open source driver. In other cases,
your particular device may not be supported by any open source drivers
yet. In those scenarios, you may want to install the restricted driver
provided by the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install
restricted drivers by default but allows the user to make an informed
choice. Remember that restricted drivers, unlike the open source drivers
for your device, are not maintained by Ubuntu. Problems caused by those
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drivers will be resolved only when the manufacturer wishes to address
them. To see if restricted drivers are available for your system, press
the Super/Windows key on your keyboard to show the Dash or click the
Ubuntu icon on the Unity Launcher, and search for Additional Drivers.
If a driver is provided by the company for your particular device, it will
be listed there. You can simply click Activate to enable the driver. is
process requires an active Internet connection and it will ask for your
password. Once installation is complete you may have to reboot your
computer to finish activating the driver.

Os desenvolvedores do Ubuntu preferem drivers de código aberto,
porque eles permitem que qualquer problema seja identificado e conser-
tado por qualquer um com conhecimento na comunidade. O desenvolvi-
mento do Ubuntu é extremamente rápido, é provavel que seu dispositivo
seja suportado por drivers de código aberto. Você também pode usar o
Ubuntu Live  para verificar a compatibilidade dos seus dispositivos
com o Ubuntu antes de instalá-los, procurar on-line em fóruns do Ubuntu
ou perguntar em http://www.askubuntu.com sobre um dispositivo em
particular.

Um outro recurso muito útil é a documentação
oficial on-line (http://help.ubuntu.com), que
contém informações detalhadas sobre vários
drivers gráficos e problemas conhecidos. Essa
mesma documentação pode ser encontrada
procurando por Ajuda na barra de pesquisa do
Dash ou pressionando F1 no seu teclado.

Configurando sua resolução de tela

Uma das tarefas mais comuns relacionadas ao monitor é a configuração
de uma resolução correta de tela para o monitor de seu computador ou
laptop.

O Ubuntu identifica corretamente a resolução nativa de tela sozinho e Os monitores são feitos de milhares de
pequenos pixeis. Cada pixel exibe uma cor
diferente e ao serem combinados, eles
mostram a imagem que você vê. A resolução
nativa da tela é a medida da quantidade atual
de pixels do seu monitor.

a configura para você. Porém, devido a uma grande variedade de disposi-
tivos disponíveis, algumas vezes ele não irá identificar corretamente sua
resolução.

Para configurar ou verificar a resolução da sua tela, vá para Configura-
ções do sistema ‣Monitores. A janela “Monitores” detectará automatica-
mente o tipo de monitor e mostrará o seu nome e tamanho. A resolução
de tela e taxa de atualização estão configuradas por valores recomendados
pelo Ubuntu. Se você não gosta das configurações recomendadas, você
pode modificá-las na lista Resolução para a resolução de sua escolha.

Adicionando um monitor extra

Sometimes, you may want to add more than one display device to your
desktop, or may want to add an external monitor to your laptop. Doing
this is quite simple. Whether it’s an extra monitor, LCD TV, or a projec-
tor, Ubuntu can handle it all. Ubuntu supports the addition of multiple
displays by default, which is as easy as plug and play. Ubuntu recognizes
almost all the latest monitors, TVs and projectors by default. Sometimes
it may happen that your additional display is not detected when you con-
nect it to the machine. To resolve this, go to System Settings ‣Displays
and click on Detect Displays. is will detect the monitors connected to
the machine. is menu can also be found from the Power Off menu on
the top panel. You can also search for Displays at the Dash search bar.
Now, there are two modes which you can enable for your displays. One
option is to spread your desktop across two or more monitors. is is par-
ticularly useful if you are working on multiple projects and need to keep
an eye on each of them at the same time. e second option is to mirror
the desktop onto each of the displays. is is particularly useful when you
are using a laptop to display something on a larger screen or a projector.
To enable this option just check the box beside Mirror displays and click
Apply to save the seings. You will get a pop-up notification asking if you

http://www.askubuntu.com
http://help.ubuntu.com
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want to keep the current seing or revert to the previous seing. Click to
keep the current seing. Starting from Ubuntu ., you can also select
whether you want the Unity Launcher in both the displays or only in the
primary display.

Conectando e usando sua impressora

O Ubuntu suporta a maioria das impressoras novas. Você pode adicio-
nar, remover e modificar as propriedades da impressora navegando em
Configurações do sistema ‣ Impressão. Você também pode procurar por
Impressão na barra de pesquisas do Painel. Abrindo Impressão, uma ja-
nela “Imprimindo - localhost” será mostrada.

ando você quiser adicionar uma nova impressora, tenha certeza
que ela esteja ligada e conectada ao seu computador via cabo  ou
conectada na sua rede.

Adicionando uma impressora local

Se você tiver uma impressora que está conectada ao computador com um
cabo , então esta é chamado de impressora local. Você pode adicionar
uma impressora, clicando no botão Adicionar impressora.

No painel esquerdo da janela “Nova impressora” algumas impressoras
que você tenha instalado serão listadas. Selecione a impressora que você
gostaria de instalar e clique no botão Prosseguir.

You can now specify the printer name, description and location. Each If your printer can automatically do double
sided printing, it will probably have a duplexer.
Please refer to the instructions that came with
the printer if you are unsure. If you do have a
duplexer, make sure the Duplexer Installed
option is checked and then click the Forward
button.

of these should remind you of that particular printer so that you can
choose the right one to use when printing. Finally, click Apply.

Adicionando uma impressora de rede

Certifique-se de que sua impressora está ligada e conectada à sua rede por
um cabo Ethernet ou por dispositivo de rede sem fio. Você pode adicionar
uma impressora clicando no botão Adicionar impressora. A janela “Nova
impressora” irá abrir. Clique no sinal ”+” ao lado de Impressora de rede.

Se sua impressora é encontrada automaticamente, ela aparecerá em
Impressora de rede. Clique no nome da impressora e então clique no botão
Avançar. Nos campos de texto, você pode agora especificar o nome da
impressora, sua descrição e localização. Cada um destes pode relembrar
você de uma impressora em particular, em que você pode escolher uma
correta para uso quando imprimir. Finalmente, clique em Aplicar.

You can also add your network printer by entering the  address of
the printer. Select “Find Network Printer,” enter the  address of the
printer in the box that reads Host: and press the Find buon. Ubuntu
will find the printer and add it. Most printers are detected by Ubuntu
automatically. If Ubuntu cannot detect the printer automatically, it will
ask you to enter the make and model number of the printer.

The default printer is the one that is automa-
tically selected when you print a file. To set a
printer as default, right-click the printer that
you want to set as default and then click Set
As Default.

Alterando as opções da impressora

As opções da impressora permitem que você altere a qualidade da im-
pressão, o tamanho do papel e o tipo de mídia. Elas podem ser alteradas
clicando com o botão direito do mouse em uma impressora e selecionando
Propriedades. A janela “Propriedades da impressora” será exibida. No
painel esquerdo, selecione Opções da impressora.

Você pode agora especificar configurações mudando pelas entradas
suspensas. Algumas das opções que você pode ver são explicas.
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Tamanho da mídia

Este é o tamanho do papel que você colocou na bandeja da impressora.

Fonte de mídia

Esta é a bandeja que o papel vem.

Modelo de cor

Isto é muito útil se você pretende imprimir em Escala de cinza para eco-
nomizar tinta, ou imprimir em Cores, ou em Tons de cinza invertido.

Tipo da mídia

Dependendo da impressora, você pode mudar entre:

‣ Papel simples
‣ Automático
‣ Papel de foto
‣ Filme transparente
‣  ou  Midia

Qualidade de impressão

Isto especifica o quanto de tinta é usado quando imprimisse, Rascunho
rápido usa o mínimo de tinta e Foto em alta-resolução usa a maioria da
tinta.

Som

Ubuntu usually detects the audio hardware of the system automatically
during installation. e audio in Ubuntu is provided by a sound server
named PulseAudio. e audio preferences are easily configurable with the
help of a very easy to use  which comes preinstalled with Ubuntu.

Volume icon and Sound Preferences

A volume icon, siing on the top right corner of the screen, provides
quick access to a number of audio related functions. When you le-click
on the volume icon you are greeted with four options: A mute option at
the very top, a slider buon which you can move horizontally to incre-
ase/decrease volume, a shortcut to the default music player, Rhythmbox,
and an option for accessing the Sound Seings. Selecting Sound Seings
opens up another window, which provides access to options for changing
input and output hardware preferences for speakers, microphones and
headphones. It also provides options for seing the volume level for each
application. Sound Seings can also be found from System Settings. It is
known as Sound.

Saída e Output tab will have a list of all the sound cards available A microphone is used for making audio/video
calls which are supported by applications like
Skype or Empathy. It can also be used for
sound recording.

in your system. Usually there is only one listed; however, if you have a
graphics card which supports  audio, it will also show up in the list.
e Output tab is used for configuring the output of audio. You can incre- If you change your sound output device, it will

remain as default.ase/decrease and mute/unmute output volume and select your preferred
output device. If you have more than one output device, it will be listed
in the section which reads “Choose a device for sound output.” e de-
fault output hardware, which is automatically detected by Ubuntu during
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installation will be selected. is section also allows you to change the
balance of sound on the le and right speakers of your desktop/laptop.

Entrada e second tab is for configuring audio Input. You will be able You should note that by default in any Ubuntu
installation, the input sound is muted. You
will have to manually unmute to enable your
microphone to record sound or use it during
audio/video calls.

to use this section when you have an in-built microphone in your system
or if you’ve plugged in an external microphone. You can also add a Blue-
tooth headset to your input devices which can serve as a microphone. You
can increase/decrease and mute/unmute input volume from this tab. If
there is more than one input device, you will see them listed in the white
box which reads Choose a device for sound input.

By default, the volume in Ubuntu is set to
maximum during installation.

Efeitos sonoros e third tab is Sound Effects. You can enable, disable, or You can add new sound themes by installing
them from Software Center (e.g., Ubuntu
Studio’s GNOME audio theme.) You will get
the installed sound themes from the drop
down menu. You can also enable window and
button sounds.

change the existing sound theme from this section. You can also change
the alert sounds for different events.

Aplicativos e Applications tab is for changing the volume for running
The Ubuntu Design Team have made a few
changes to the volume icon post Ubuntu 11.10.applications. is comes in handy if you have multiple audio applications

running, for example, if you have Rhythmbox, Totem Movie Player and a
web-based video playing at the same time. In this situation, you will be
able to increase/decrease, mute/unmute volume for each application from
this tab.

Mais funcionalidade

e icon can control various aspects of the system, application volume
and music players like Rhythmbox, Banshee, Clementine and Spotify.
e volume indicator icon can now be easily referred to as the sound
menu, given the diverse functionality of the icon. Media controls available You can start and control the default music

player, Rhythmbox, by simply left clicking on
the sound menu and selecting Rhythmbox
from the list. Clicking the play button also
starts the player.

include play/pause, previous track, and next track. You can also switch
between different playlists from the Choose Playlist option. ere is also a
seek bar which you can manually drag to skip some portions of any song.
If the current playing song has album art, it will show up beside the name
of the current track, otherwise you will see only the details of the song.
It displays the track name, the artist name and the album name of the
current track.

Usando uma webcam

Webcams frequentemente vêm embutidas nos laptops e netbooks. Alguns
computadores de mesa, como o iMac da Apple, têm câmeras embutidas
em suas telas. Se você adquirir uma webcam, porque seu computador não
possui uma, é bem provável que ela possua uma conexão . Para usar
uma webcam , conecte-a a uma porta  livre de seu computador.

Almost all new webcams are detected by Ubuntu automatically. You There are several applications which are
useful if you have a webcam. Cheese can
capture pictures with your webcam and VLC
media player can capture video from your
webcam. You can install these from the
Ubuntu Software Center.

can configure webcams for individual applications such as Skype and
Empathy from the application’s setup menu. For webcams which do not
work right away with Ubuntu, visit https://wiki.ubuntu.com/Webcam for
help.

Digitalizando textos e imagens

Digitalizar um documento ou imagem é muito simples no Ubuntu. A di-
gitalização é realizada pelo aplicativo ”Digitalizador simples”. Na maioria
das vezes, o Ubuntu simplesmente irá detectar o seu scanner e você deve

https://wiki.ubuntu.com/Webcam


    .

estar apto para usá-lo. Para digitalizar um documento, siga os seguintes
passos:

. Coloque no digitalizador o que você quer copiar.
. Clique para abrir o Painel e digite digitalizador simples.
. Clique em Digitalizador simples.
. Clique para escolher entre Texto ou Foto em Documento ‣Digitalizar ‣

Texto.
. Clique em Digitalizar.
. Clique no Ícone de folha de papel para adicionar outra página.
. Clique em Salvar para salvar.

Você pode salvar os documentos digitalizados e imagens em .
Você pode salvar também no formato  para poder abrir com o Acrobat
Reader. Para fazer isso, adicione a extensão .pdf no final do nome do
arquivo.

Solucionando problemas do seu scanner

Se o seu scanner não foi detectado, o Ubuntu poderá mostrar a mensagem
”Nenhum dispositivo disponível” quando você tentar uma digitalização.
Pode haver um motivo pelo qual o Ubuntu não consegue encontrar seu
scanner.

‣ Apenas desconecte e reconecte o scanner. Se for um scanner  re-
cente, é provável que funcione.

‣ O driver de seu scanner não foi carregado automaticamente. Reinicie
seu sistema. Isso pode ajudar!

‣ O seu scanner não é suportado pelo Ubuntu. Os tipos mais comuns de
scanners não suportado são os que usam a antiga porta paralela ou os
Lexmark Tudo-em-um (impressora/digitalizador/fax).

‣ Lista de digitalizadores suportados pelo projeto . O projeto 
(Acesso ao Scanner Agora é Fácil) fornece a maior parte do suporte
para o soware de digitalização no Ubuntu.

‣ Verifique em https://wiki.ubuntu.com/HardwareSupportComponentsScanners
para descobrir quais scanners funcionam com o Ubuntu.

Outros dispositivos

USB

USB ports are available as standard on almost all computers available
now. ey are used to connect a multitude of devices to your compu-
ter. ese could include portable hard drives, flash drives, removable
//Blu-ray drives, printers, scanners and mobile phones. When con-
nected, flash drives and portable hard drives are automatically detected
—the file manager will open and display the contents of the drive. You can
then use the drives for copying data to and from the computer. All new
cameras, camcorders and mobile phone  cards are automatically detec-
ted by Ubuntu. ese SD cards have different types of data, so a window
will appear with a drop down menu to choose between video, audio im-
port and the file manager—you can choose your desired action from this
menu.

Firewire

Firewire is a connection on some computers that allows you to transfer Firewire is officially known as IEEE 1394. It
is also known as the Sony i.LINK and Texas
Instruments Lynx.

https://wiki.ubuntu.com/HardwareSupportComponentsScanners
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data from devices. is port is generally used by camcorders and digital
cameras.

If you want to import video from your camcorder you can do so by
connecting your camcorder to the Firewire port. You will need to install a
program called Kino which is available in the Ubuntu Soware Center. To find out more about Kino, visit http://www.

kinodv.org/.

Bluetooth

O Bluetooth é uma tecnologia sem fio que é muito usada por diferentes
dispositivos para se conectarem uns aos outros. É comum ver um mouse
ou teclado que suporta Bluetooth. Você também pode encontrar disposi-
tivos , telefones celulares, fones de ouvido, reprodutores de música e
muitos outros dispositivos que podem se conectar ao seu computador ou
laptop e deixar que você transfira dados, escute música ou jogue jogos,
por exemplo.

If your computer has Bluetooth support then you should see a Blue-
tooth icon in the top panel, usually near the volume icon. Click on the
Bluetooth icon to open a popup menu with several choices, such as an
option to Turn off Bluetooth.

M I S S I N G S C R E E N S H O T
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Figura 4.1: The Bluetooth applet menu.

As preferências do Bluetooth também podem ser acessadas a partir de
Configurações do sistema ‣Bluetooth. Se você quiser conectar um novo
dispositivo—por exemplo, para que um celular envie fotos e vîdeos para o
seu computador—selecione Configurar novo dispositivo….

Ubuntu will open a window for new device setup. When you click
Forward, Ubuntu will show you how many Bluetooth devices are present
near your computer. e list of available devices might take a minute or
so to appear on the screen as your system scans for these devices. Each
device will be displayed as soon as it is found by Ubuntu. Once a device
you’d like to connect with appears in the list, click on it. en, choose a
 number by selecting PIN options.

ree predefined  numbers are available, but you can also create When you pair two Bluetooth devices, you are
letting each device trust the other one. After
you pair two devices, they will automatically
connect to each other in the future without
requiring a PIN.

a custom . You will need to enter this  on the device you will be
pairing with Ubuntu.

Once the device has been paired, Ubuntu will open the “Setup comple-
ted” window. In Ubuntu, your computer is hidden by default for security
reasons. is means that your Ubuntu system can search other Bluetooth
devices, but others cannot find your Ubuntu system when they perform
a search on their own computer. If you would like to let another device
find your computer, you will have to explicitly allow your computer to be
found. To allow your computer to be found, select “Make computer dis-
coverable” in Bluetooth preferences. You can also click on the Bluetooth
icon and select Visible to make your computer discoverable.

Você também pode adicionar um nome diferente para o seu sistema
Ubuntu com Bluetooth ativo, alterando o texto de Nome amigável.

Another feature present in the Bluetooth icon menu is “Send files to
device.” Use this option to send a file to a mobile phone without pairing
with the computer. Android devices need to be paired at all times,

even while transferring files.

http://www.kinodv.org/
http://www.kinodv.org/




5 Gerenciamento de Programas

Gerenciamento de software no Ubuntu.

Como discutido em Capítulo : Trabalhando com o Ubuntu, o Ubuntu
oferece a você uma grande variedade de aplicativos para o seu trabalho
diário. O Ubuntu vem com um conjunto básico de aplicativos para tarefas
comuns, como navegar na Internet, checar seu e-mail, escutar músicas
e organizar suas fotos e vídeos. Você pode desejar um nível extra de
especialização: por exemplo, você quer retocar suas fotos, executar alguns
sowares para seus negócios ou jogar alguns jogos novos. Em cada um
desses casos você pode procurar por um aplicativo, instalá-lo e usá-lo
—geralmente, sem nenhum custo extra.

M I S S I N G S C R E E N S H O T

ss:software-center-icon

The file screenshots/pt_BR/05-software-
center-icon.png does not

exist!

Figura 5.1: Ícone da Central de programas

Soware in Ubuntu is delivered as packages, simplifying the instal-

We recommend Ubuntu Software Center for
searching, installing and removing applicati-
ons, although you still have the possibility to
use the command-line application apt-get,
or install and use the advanced application
Synaptic Package Manager.

lation to one click. A package is a compressed file archive containing
everything needed to run the application. Packages can also contain in-
formation describing which other applications, called dependencies or
libraries, are needed. Linux is designed in a way that any library can be
updated without having to reinstall the complete application, minimizing
hard drive usage by leing other applications use the same library.

Most other operating systems require a user to purchase commercial
soware (online or through a physical store), or search the Internet for
a free alternative (if one is available). e correct installation file must
then be verified for integrity, downloaded and located on the computer,
followed by the user proceeding through a number of installation prompts
and options. By default Ubuntu gives you a centralized point with two
different ways to browse the repositories for searching, installing and
removing soware.

‣ Central de Programas do Ubuntu
‣ Linha de comando apt-get

Procurar, instalar e/ou remover aplicativos com a Central de Programas
do Ubuntu é o caminho mais fácil e confortável. Ela é recomendada para
todos os tipos de usuários, começando dos iniciantes e indo até os usuá-
rios mais avançados.

Usando a Central de Programas do Ubuntu

Existem numerosas maneiras de instalar programas em um sistema ope-
racional. No Ubuntu, a maneira mais rápida e fácil de encontrar e instalar
novos aplicativos é através da Central de Programas do Ubuntu.

Para iniciar o aplicativo, clique no ícone da Central de Programas
do Ubuntu no Lançador ou clique no Painel e procure por Central de
Programas do Ubuntu.

A Central de programas do Ubuntu pode ser usada para instalar aplica-
tivos que estão disponíveis nos repositórios oficiais do Ubuntu. A janela
da Central de programas possui quatro partes,—uma lista de categorias
na esquerda, um banner no topo, um painel ”Recomendado para você” na
parte de baixo e duas áreas relacionadas na direita. Clicando em uma ca-
tegoria, uma lista de aplicativos relacionados será mostrada. Por exemplo,
a categoria Internet contém o navegador web Firefox. As áreas relaciona-
das em destaque estão em ”Novidades” e ”Melhor avaliados”. Cada área
mostra diferentes ícones de aplicativos. Clique em um ícone para obter
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Figura 5.2: Você pode instalar e remover
aplicativos do seu computador usando a
Central de Programas.

mais informações sobre o aplicativo ou para instalá-lo. Para ver todos os
programas que a área contém, clique em Mais.

Essas três sessões no topo representam sua visualização atual do ca-
tálogo da Central de programas. Clique no botão Todos os aplicativos
para ver os programas que estão disponíveis para a instalação, clique
em Instalado para ver uma lista de programas que já estão instalados no
seu computador ou clique no Histórico para ver instalações anteriores e
exclusões organizadas pela data.

Localize seu aplicativo

Ubuntu Soware Center displays different sources in the “Get Soware”
section. Clicking the arrow next to “All Soware” will show a list of in-
dividual sections. Selecting “Provided by Ubuntu” will show free official
soware, “For Purchase” will show soware for purchasing, and “Cano-
nical Partners” will show soware from partners of Canonical, such as
Adobe.

Se você está procurando por um aplicativo, você pode já conhecê-lo
pelo nome específico (por exemplo, VLC Media Player) ou apenas possuir
sua categoria geral na mente (por exemplo, a categoria Vídeo e Som inclui
um grande número de diferentes aplicativos como conversores de vídeo,
editores de audio e reprodutores de música).

Para ajudá-lo a encontrar o aplicativo certo, você pode procurar no
catálogo da Central de Programas clicando na categoria que reflete o tipo
de programa que você está procurando ou usar o campo de pesquisa na
direita do topo para procurar por nomes específicos ou palavras chave.

Ao selecionar uma categoria, uma lista de aplicativos será mostrada.
Algumas categorias contém sub-categorias—por exemplo, a categoria Jo-
gos contém sub-categorias para Simulação e Jogos de cartas. Para explorar
as categorias você pode usar os botões Voltar e Próximo no topo da janela.
Esta versão do Ubuntu contém a nova categoria ”Livros & revistas” que
contém livros e revistas interessantes.



   

Instalando software

Uma vez encontrado um aplicativo que você gostaria de experimentar,
instalá-lo está a apenas um clique de distância.

Para instalar programas:

. Click the Install buon to the right of the selected package to install
it. If you would like to read more about the soware package before
installing it, first click on “More Info.” is will take you to a short
description of the application, as well as a screenshot and a Web link
when available. Related add-ons will be listed below the application’s
description. You can click Install from this screen as well. In addi- You must have administrative privileges, and

you will need to be connected to the Internet
for the Software Center to work. To learn
how to set up your Internet connection, see
Obtendo on-line.

tion, if you use the Gwibber micro-blogging application, you can hit
the “Share…” link below the description of an application to tell your
friends about it.

. Aer clicking Install, enter your password into the authentication
window that appears. is is the same password you use to log in to
your account. You are required to enter it whenever installing or re-
moving soware in order to prevent someone without administrator
access from making unauthorized changes to your computer. If you
receive an Authentication Failure message aer typing in your pas-
sword, check that you typed it correctly by trying again. If the error
continues, this may mean that your account is not authorized to install
soware on the computer.

. Espere até o pacote terminar de instalar. Durante a instalação (ou
remoção) de programas, você verá um ícone animado de setas rodando
à esquerda do botão de progresso na barra lateral. Se você desejar, é
possível voltar para a janela principal do navegador e escolher pacotes
adicionais de soware para serem instalados seguindo os passos acima.
A qualquer momento, ao clicar no botão de progresso no topo , você
será levado para um resumo de todas as operações que estão sendo
atualmente processadas. Aqui, você também pode clicar no ícone de X
para cancelar qualquer operação.

Uma vez que a Central de programas terminou de instalar um aplicativo,
ele estará pronto para ser utilizado. Você pode iniciá-lo indo ao Painel e
digitando seu nome na barra de pesquisa. Por padrão o aplicativo é adicio-
nado ao Lançador. Você pode modificar esse comportamento demarcando
a opção Ver ‣Aplicativos recentes no lançador.

Removendo software

Remover aplicativos é muito similar a instalá-los. Primeiro, encontre o
programa instalado na Central de programas do Ubuntu. Você pode clicar
no botão Instalado, que irá mostrar uma lista de provedores de progra-
mas, que também podem ajudar a restringir sua busca. Você pode também
querer digitar palavras chaves no campo de busca para rapidamente en-
contrar programas instalados, ou procurar pela data na aba de Histórico
(mais sobre o Histórico abaixo).

Para remover programas:

. Clique no botão Remover à direita do aplicativo selecionado.
. Digite a sua senha na janela de autenticação que irá aparecer. Remover

programas também requer que você digite sua senha para ajudar a
proteger o seu computador de mudanças não autorizadas. O pacote
então entrará na fila de remoção e irá aparecer na seção Progresso no
topo.
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Figura 5.3: Instalando programas via Central
de programas do Ubuntu.

A remoção de um pacote também irá atualizar os seus menus de
acordo.

Histórico de programas

A Central de programas do Ubuntu mantém o controle do gerenciamento
de aplicativos antigos na seção de Histórico. Isso é útil caso você deseje
reverter instalações ou remoções e não se lembre do nome do aplicativo.

Existem quatro botões na seção de histórico—Todas as alterações,
Instalações, Atualizações e Remoções. Clicar em um deles irá mostrar
uma lista de dias em que a ação ocorreu. Se você clicar na seta próxima
ao dia, uma lista de pacotes individuais vai ser mostrado, junto com o
que foi feito a eles e em que data. A seção de Histórico mostra o histórico
de instalação de todos os programas, não só as mudanças feitas com
a Central de programas. Por exemplo, pacotes atualizados através do
Gerenciador de atualizações também serão listados.

Recomendações de programas

e Ubuntu Soware Center offers two types of recommendations—per
user based and per application based. Click the Turn On Recommenda-
tions buon at the boom of the Ubuntu Soware Center to enable per
—user based recommendations. You will have to log in with your Ubuntu
Soware Center account. is is the same as your Ubuntu One or Laun-
chpad account. When you enable recommendations, your list of installed
soware will be periodically sent to servers of Canonical. Recommen-
dations will appear in the boom panel. If you want to disable these
recommendations then go to View ‣Turn Off Recommendations.

Per—application based recommendations do not require log in. ey
are labeled as “People Also Installed.” ese are the applications installed
by users who also installed the application which you are about to install.
ese recommendations are shown in the detailed page of particular
application.
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Figura 5.4: You can turn on Software Re-
commendations via clicking on the Turn On
Recommendations button.
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Figura 5.5: The “People Also Installed” section
shows applications installed by users who also
installed the application which you are about
to install.

Gerenciando programas adicionais

Apesar da Central de programas do Ubuntu prover uma grande biblioteca
de aplicativos para escolher, inicialmente somente aqueles pacotes dis-
poníveis nos repositórios oficiais do Ubuntu são listados. Às vezes, você
pode estar interessado em um aplicativo em particular que não está dis-
ponível nesses repositórios. Se isso ocorrer, é importante entender alguns
métodos alternativos para acessar e instalar programas no Ubuntu, como,
por exemplo, baixar um arquivo de instalação manualmente da Internet
ou adicionar repositórios extras. Primeiro, nós iremos falar sobre como
administrar seus repositórios através de Canais de soware.

Canais de software

A Central de programas do Ubuntu lista somente aqueles aplicativos que
estão disponíveis nos seus repositórios habilitados. Repositórios podem
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ser adicionados ou removidos através do aplicativo Canais de soware.
Você pode abrir o Canais de soware a partir da Central de programas do
Ubuntu. Simplesmente vá até Editar ‣Canais de soware ou abra o 
(tecla Alt) e procure por ”fontes”.

Gerenciando repositórios oficiais

Ao abrir Canais de soware, você visualizará a aba Aplicativos Ubuntu
onde as primeiras quatro opções estão habilitadas por padrão. A aba Aplicativos Ubuntu lista os repositó-

rios oficiais do Ubuntu, cada um contendo
diferentes tipos de pacotes.Soware livre e gratuito suportado pela Canonical (main) Este repositó-

rio contém todos os pacotes de código aberto que são mantidos pela
Canonical.

Soware livre e gratuito mantido pela comunidade (universe) Este repositó-
rio contém todos os pacotes de código aberto que são desenvolvidos e
mantidos pela comunidade do Ubuntu.

Drivers proprietários para dispositivos (restricted) Este repositório con-
tém drivers proprietário, que podem ser necessários para utilizar os
recursos completos de alguns de seus dispositivos ou hardware.

Pacotes de código fechado são algumas
vezes referidos como não livres. Esta é
uma referência à liberdade de expressão,
preferivelmente ao custo monetário. Não é
necessário pagar para usar estes pacotes.
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Figura 5.6: Drivers podem ser instalados ou
removidos via aplicativo Drivers adicionais.

Soware restricted by copyright or legal issues (multiverse) is repository
contains soware that may be protected from use in some states or
countries by copyright or licensing laws. By using this repository you
assume responsibility for the usage of any packages that you install.

Source code is repository contains the source code that is used to build Building applications from source is an
advanced process for creating packages, and
usually only concerns developers. You may
also require source files when using a custom
kernel, or if trying to use the latest version of
an application before it is released for Ubuntu.
As this is a more advanced area, it will not be
covered in this manual.

the soware packages from some of the other repositories. e Source
code option should not be selected unless you have experience with
building applications from source.

Selecionando o melhor servidor de programas

Ubuntu provides and allows many servers around the world to mirror the
packages from the sources listed under “Managing the official reposito-
ries.” Ubuntu grants permission to many servers all

across the world to act asmirrors. That is, they
host an exact copy of all the files contained in
the official Ubuntu repositories.

Ao selecionar um servidor, você deve considerar o seguinte:

Distância do servidor. Isto irá afetar a velocidade que você pode atingir
com o servidor de arquivos.
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Internet Service Provider. Some Internet service providers offer cheaper, or
even unlimited free downloads from their own servers.

alidade do servidor. Alguns servidores oferecem downloads com uma
velocidade reduzida, limitando a velocidade com que você pode instalar
e atualizar os programas no seu computador.

Ubuntu will automatically choose an appropriate server while ins-
talling, and as such these seings should not be changed unless your
physical location changes drastically or if you feel a higher speed should
be achieved by your Internet connection. e guide below will help in
choosing an optimal server.

O Ubuntu fornece uma ferramenta para selecionar o servidor que provê
a conexão mais rápida com o seu computador.

. Clique na caixa de seleção próxima a ”Baixar de:” na janela de Canais
de soware.

. Selecione ”Outro…” da lista.
. Na janela ”Escolher um Servidor” que irá aparecer. Clique no botão

Selecionar Melhor Servidor no canto superior direito. Seu computador
irá tentar agora se conectar aos servidores disponíveis, então selecione
aquele com a velocidade mais rápida.

Se você está contente com a seleção automática, clique em Escolher
Servidor para retornar à janela de Canais de soware.

Se você não está contente com a seleção automática ou prefere não
utilizar a ferramenta, o servidor mais rápido é geralmente o mais perto de
você geograficamente. Nesse caso, apenas escolha ”Outro…” e encontre
a localização mais perto do seu computador. ando estiver feliz com
as configurações clique em Escolher Servidor para retornar à janela de
Canais de soware.

If you do not have a working Internet connection, updates and pro-
grams can be installed from the installation media itself by inserting your
media and clicking the box under “Installable from /.” Once
this box is checked the media within the/ drive will function
as an online repository and as such the soware on the media will be
installable from the Ubuntu Soware Center.

Adicionando mais repositórios de software

O Ubuntu facilita a adição de outros repositórios de terceiros à sua lista de Um PPA é um Arquivo de Pacote Pessoal.
Esses são os repositórios online usados para
hospedar as últimas versões dos pacotes
de programas, projetos digitais, e outros
aplicativos.

fonte de programas. Os repositórios mais comuns adicionados ao Ubuntu
são chamados de s. Estes lhe permitem instalar pacotes de programas
que não estão disponíveis nos repositórios oficiais, e ser automaticamente
notificado sempre que atualizações para estes pacotes estiverem disponí-
veis.

If you know the web address of a ’s Launchpad site, adding it to
your list of soware sources is relatively simple. To do so, you will need
to use the Other Soware tab in the “Soware Sources” window.

On the Launchpad site for a , you will see a heading to the le
called “Adding this PPA to your system.” Underneath will be a short
paragraph containing a unique  in the form of ppa:test-ppa/example.
Highlight this  by selecting it with your mouse, then right-click and
select Copy.

Return to the “Soware Sources” window, and in the Other So-
ware tab click Add… at the boom. A new window will appear, and you
will see the words “Apt line:” followed by a text field. Right-click on the
empty space in this text field and select Paste, and you should see the 

ppa:test-ppa/example
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Figura 5.7: Isto é um exemplo de uma página
do Launchpad para o PPA do Lifeserver.
O Lifesaver é um aplicativo que não está
disponível nos repositórios oficiais do Ubuntu.
Entretanto, adicionando este PPA à sua lista
de fontes de programas, será fácil instalar e
atualizar este aplicativo através da Central de
Programas.

appear that you copied from the s Launchpad site earlier. Click Add
Source to return to the “Soware Sources” window. You will see a new
entry has been added to the list of sources in this window, with a selected
check box in front meaning it is enabled.

Caso você clique no botão Fear localizado na parte inferior à direita
desta janela, uma mensagem aparecerá informando a você que “A infor-
mação sobre a disponibilidade de soware está atrasada.” Isto se deve ao
fato de você ter adicionado um novo repositório no Ubuntu, e ele agora
precisar conectar a este repositório e baixar a lista de pacotes que ele
provê. Clique em Recarregar, e espere enquanto o Ubuntu atualiza to-
dos os repositórios habilitados (incluindo este novo repositório que você
adicionou). ando terminar, a janela fechará automaticamente.

Congratulations, you have just added a  to your list of soware
sources. You can now open the Soware Center and install applications
from this , in the same way you previously installed applications from
the default Ubuntu repositories.

Instalação manual de aplicativo

Although Ubuntu has extensive soware available, on some occasions you
may want to manually install soware packages that are not available in
the repositories. If there is not a  for the soware, you will need to
install it manually. Before you choose to do so, make sure you trust the
package and its maintainer.

Os pacotes no Ubuntu possuem extensão .deb. Clicar duplamente em
um pacote irá abrir uma página com um resumo na Central de programas,
que lhe dará mais informações sobre aquele pacote.

A visão geral ou resumo fornece algumas informações técnicas sobre
aquele pacote, um link para um website (se for aplicável) e a opção de
instalar. Clicar em Instalar irá instalar o pacote assim como qualquer
outra instalação na Central de programas.
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Figura 5.8: Instalando arquivos .debmanual-
mente usando a central de programas.

Atualizações simples e atualizações de versão do sistema

Ubuntu também permite a você decidir como gerenciar as atualizações de
pacotes pela aba Atualizações na janela Canais de soware.

Atualizações do Ubuntu

In this section, you are able to specify the kinds of updates you wish to
install on your system, and usually depends on your preferences around
stability, versus having access to the latest developments.
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Figura 5.9: You can update installed software
by using the Update Manager application in
Ubuntu.

Atualizações de segurança importantes Estas atualizações são altamente
recomendadas para assegurar que seu sistema permaneça o mais se-
guro possível. Elas são habilitadas por padrão.

Atualizações recomendadas Estas atualizações não são tão importantes
para manter o seus sistema seguro, mas garantem que os seus paco-
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tes estejam com as mais recentes soluções para bugs ou atualizações
menores que foram testadas e aprovadas. Esta opção também vem
habilitada por padrão.

Atualizações de pré-lançamento Esta opção é para aqueles que preferem
se manter atualizados de cada lançamento das últimas versões dos
aplicativos, com o risco de instalar uma atualização com bugs não
solucionados ou conflitos. Note que é possível que você encontre
problemas com estes aplicativos atualizados, por isso esta opção não é
habilitada por padrão.

Atualizações não suportadas Estas atualizações não foram ainda completa-
mente testadas e revisadas pela Canonical. Alguns bugs podem ocorrer
ao usá-las e portanto esta opção não está habilitada por padrão.

Atualizações automáticas

A seção do meio desta janela permite a você personalizar como o seu sis-
tema gerencia as atualizações, tal como a frequência com que ele verifica
por novos pacotes, bem como ele pode instalar atualizações importan-
tes de imediato (sem pedir sua permissão), baixá-las apenas, ou somente
notificar-te sobre elas.

Atualização de versão

Aqui você pode decidir de quais atualizações de versões do sistema você A cada seis meses, a Canonical lança uma
nova versão do sistema operacional Ubuntu.
Elas são chamadas versões normais. A cada
quatro lançamentos normais—ou 24 meses
—a Canonical lança uma versão de suporte
de longo prazo (LTS). As versões LTS têm
a intenção de ser as mais estáveis quanto
possível, e têm suporte por um período mais
longo.

gostaria de ser notificado.

Nunca Escolha essa opção se você prefere não ser notificado sobre novas
versões do Ubuntu.

Para qualquer nova versão Escolha essa opção se você deseja sempre
ter a última versão do Ubuntu, não importando se ela é uma versão
de suporte longo ou não. Esta opção é recomendada para usuários
domésticos padrão.

Para versão de suporte longo Escolha esta opção se você precisa de uma
versão mais estável e com suporte por mais tempo. Se você utiliza
o Ubuntu por motivos de negócios, você pode desejar considerar a
seleção desta opção



6 Tópicos avançados

Ubuntu para usuários avançados

We hope you understand how using Ubuntu can make your computing
experience easier, safer, and more efficient. To this point, we’ve provided
detailed instructions on geing the most from Ubuntu’s basic features.
In this chapter, we’ll detail some of Ubuntu’s more advanced features
—like the terminal, a powerful utility that can help you accomplish tasks
without the need for a graphical user interface (). We’ll also discuss
some advanced security measures you can implement to make your com-
puter even safer. We’ve wrien this chapter with advanced users in mind.
If you’re new to Ubuntu, don’t feel as though you’ll need to master these
topics to get the most out of your new soware (you can quite easily
skip to the next chapter without any adverse impact to your experience
with Ubuntu). However, if you’re looking to expand your knowledge of
Ubuntu, we encourage you to keep reading.

Introdução ao terminal

Ao longo deste manual, nós focamos primariamente na interface gráfica
do ambiente de trabalho do usuário. Para conseguir observar todo o poder
do Ubuntu, você pode querer aprender como usar o terminal.

O que é o terminal?

A maioria dos sistemas operacionais, incluindo o Ubuntu, possuem dois
tipos de interfaces com o usuário. A primeira é a interface gráfica do
usuário (, do inglês, Graphical User Interface). Ela é a área de trabalho,
janelas, menus e barras de ferramentas que você clica para fazer as coisas.
O segundo, e muito mais velho, tipo de interface é a interface de linha de
comando (, do inglês, Command-Line Interface).

O terminal é a interface do Ubuntu para linhas de comando. É um
método de controlar alguns aspectos do Ubuntu, usando apenas comandos
que você digita no seu teclado.

Por que eu iria querer usar o terminal?

Você pode executar a maioria das atividades do dia-a-dia sem nunca
precisar abrir o terminal. Porém, o terminal é uma ferramenta poderosa
e inestimável que pode ser usada para executar muitas tarefas úteis, que
podem não ser possíveis de serem realizadas com uma . Por exemplo:

‣ A solução de eventuais problemas que possam surgir quando se utiliza
o Ubuntu, às vezes, requer que você use o terminal.

‣ Uma interface de linha de comando é, às vezes, um caminho mais
rápido para executar uma tarefa. Por exemplo, geralmente é mais fácil
executar operações em muitos arquivos simultaneamente usando o
terminal.

‣ Aprender a interface de linha de comando é o primeiro passo rumo a
solução mais avançada, administração do sistema, e as habilidades de
desenvolvimento de soware. Se você está interessado em se tornar
um desenvolvedor ou um usuário avançado do Ubuntu, conhecimento
sobre a linha de comando será essencial.
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Abrindo o terminal

Você pode abrir o terminal clicando em Painel ‣Aplicativos ‣Terminal. O terminal lhe dá acesso ao que é chamado de
shell. Ao digitar o comando no terminal, o shell
interpreta este comando, resultando na ação
desejada. Diferentes tipos de shells aceitam
comandos ligeiramente diferentes. O mais
popular é o chamado ”bash” e é o shell padrão
no Ubuntu.

When the terminal window opens, it will be largely blank apart from
some text at the top le of the screen, followed by a blinking block. is
text is your prompt—it displays, by default, your login name and your
computer’s name, followed by the current directory. e tilde (~) means

In GUI environments the term “folder” is
commonly used to describe a place where
files are stored. In CLI environments the term
“directory” is used to describe the same thing.
This metaphor is exposed in many commands
(i.e., cd or pwd) throughout this chapter.

that the current directory is your home directory. Finally, the blinking
block is the cursor—this marks where text will be entered as you type.

Para testar um comando no teminal, digite pwd e pressione Enter. O
terminal deverá exibir /home/seunomedeusuario. Este texto é chamado de
“saída”. Você acabou de usar o comando pwd (print working directory, em
português, imprimir o diretório de trabalho), que tem como saída (exibe) o
diretório atual.
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Figura 6.1: A janela padrão do terminal
permite a você rodar centenas de comandos
úteis.

Todos os comandos no terminal seguem a mesma abordagem: Digite
um comando, possivelmente seguido por algum parâmetros e pressione
Enter para executar a ação especificada. Frequentemente, algumas saídas Parâmetros são segmentos extras de texto,

geralmente adicionados no final de um
comando, que podemmudar o modo como
um comando é interpretado. Eles geralmente
tomam a forma de -h ou --help, por exemplo.
De fato, --help pode ser adicionado à
maioria dos comandos para exibir uma curta
descrição do comando, assim como uma lista
de qualquer outros parâmetros que podem ser
usados com ele.

serão exibidas para confirmar que a ação foi completada com sucesso,
porém isso pode depender do comando executado. Por exemplo, usar o
comando cd para mudar o seu diretório atual (veja abaixo) modificará a
linha de comando, mas não exibirá nenhuma saída.

O resto deste capítulo irá cobrir alguns usos muito comuns do terminal.
Porém, não vai ser possível endereçar a quase infinita gama de possibi-
lidades disponíveis quando você usa a interface de linha de comando no
Ubuntu. Através da segunda parte deste manual, nós continuaremos a nos
referir à linha de comando, particularmente, ao discutir os passos envol-
vidos na solução de problemas e no gerenciamento mais avançado do seu
computador.

Estrutura do sistema de arquivos do Ubuntu

O Ubuntu usa o sistema de arquivos Linux, que é baseado em uma série
de pastas no diretório raiz. Cada um destes diretórios contém sistemas de
arquivos importantes que não podem ser modificados a menos que você
esteja executando como usuário root ou usando sudo. Esta restrição existe
por ambas razões de segurança e de proteção: vírus de computador não
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conseguem modificar os arquivos núcleo do sistema e usuários comuns
não deverão poder acidentalmente danificar algo vital.

Abaixo estão alguns dos diretórios mais importantes.
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Figura 6.2: Alguns dos diretórios mais impor-
tantes no sistema de arquivos raiz.

O diretório raiz—denotado por /—contém todos os outros diretórios e
arquivos. Aqui estão os conteúdos de alguns diretórios de sistema essenci-
ais:

/bin & /sbin Muitos aplicativos essenciais do sistema (equivalentes a
C:\Windows)

/etc Arquivos de configuração de todo o sistema
/home Each user will have a subdirectory to store personal files (for

example /home/your-username, equivalent to C:\Users or C:\Documents
and Settings)

/lib Biblioteca de arquivos, similar aos arquivos .dll do Windows
/media Mídia removível, ( e drives ) serão montados neste

diretório
/root Este contém os arquivos do usuário root (não deve ser confundido

com o diretório raiz)
/usr Pronunciado ”user”, ele contém a maioria dos arquivos de progra-

mas (não deve ser confundido com cada diretório home de usuário,
equivalente a C:\Arquivos de programas)

/var/log Contém arquivos de log escritos pela maioria dos aplicativos

Cada diretório tem um caminho. O caminho é o nome completo de um
diretório—que descreve uma forma de navegar no diretório em qualquer
lugar do sistema.

Por exemplo, o diretório /home/seu-nomedeusuario/Área de Trabalho
contém todos os arquivos que estão na sua área de trabalho do Ubuntu. O
caminho /home/seu-nomedeusuario/Área de Trabalho pode ser quebrado
em um punhado de peças chave:

. /—indica que o caminho começa no diretório raiz
. home/—do diretório raiz, o caminho vai para o diretório home
. seuusuario/—do diretório home, o caminho vai para o diretório do

seuusuário
. Desktop—do diretório seuusuario, o caminho acaba no diretório Desk-

top
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Cada diretório no Ubuntu contém um caminho completo que começa
com / (diretório raiz) e termina no nome do próprio diretório.

Directories and files that begin with a period are hidden directories. If you are creating a file or directory from
the command line and ultimately want it
hidden, then simply start the filename or
directory name with a dot (.)—this signals to
the filesystem that the file/directory should
be hidden unless expressly viewed through
showing hidden files and folders through the
GUI or through the appropriate command line
switch.

ese are usually only visible with a special command or by selecting a
specific option. In the Nautilus you can show hidden files and directories
by selecting View ‣ Show Hidden Files, or by pressing Ctrl+H. If you are
using the terminal, then you would type ls -a and press Enter to see the
hidden files and directories. ere are many hidden directories in your
home folder used to store program preferences. For example, /home/your-
username/.evolution stores preferences used by the Evolution mail
application.

Montando e desmontando dispositivos removíveis

alquer hora que você adicionar uma mídia de armazenamento no seu
computador—em um disco rígido interno ou externo, um pendrive ,
um —ele precisa ser montado antes de estar acessível. Montar um
dispositivo significa associar um nome de diretório a ele, permitido que
você navegue no diretório para acessar os arquivos do dispositivo.

ando um dispositivo, como um pendrive  ou um reprodutor de
mídia é montado no Ubuntu, uma pasta é automaticamente criada para
isso no diretório media e as permissões apropriadas são dadas a você para
habilitá-lo a ler e escrever no arquivo.

A maioria dos gerenciadores de arquivos adicionará automaticamente
um atalho para o dispositivo montado na barra lateral do seu diretório
home, então você terá fácil acesso ao dispositivo. Você não deve navegar
fisicamente no diretório media no Ubuntu, a menos que você escolha fazer
isso pela linha de comando.

Ao terminar de usar um dispositivo, você pode desmontá-lo. Desmontar
um dispositivo desassocia o dispositivo de seu diretório, permitindo que
você o ejete.

Tornando o Ubuntu seguro

Agora que você já sabe um pouquinho mais sobre como utilizar a linha
de comando, nós podemos usá-la para fazer o seu computador ficar mais
seguro. As seguintes seções irão discutir vários conceitos de segurança,
junto com procedimentos para fazer o seu computador rodar tranquila-
mente, sem perigos e de forma segura.

Porque o Ubuntu é seguro

O Ubuntu é seguro por padrão devido a um grande número de motivos: Não é só porque o Ubuntu implementa uma
segurança forte por padrão, que isso significa
que o usuário pode ”jogar as preocupações
ao vento”. Cuidados deverão ser tomados ao
baixar arquivos, abrir e-mails e navegar na
Internet. Usar um bom programa anti-vírus é
uma garantia.

‣ Ubuntu distingue claramente entre usuários normais e usuários admi-
nistrativos.

‣ Os programas para o Ubuntu são mantido em um repositório seguro
on-line, que não contém programas falsos ou programas maliciosos.

‣ Sowares de código aberto como o Ubuntu permitem que falhas de
segurança sejam facilmente detectadas.

‣ Correções de segurança para soware de código aberto como Ubuntu
muitas vezes são liberados rapidamente.

‣ Muitas viroses projetadas para ter como alvo primário sistemas basea-
dos em Windows não afetam sistemas Ubuntu.
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Conceitos básicos de segurança

As seguintes seções discutem conceitos básicos de segurança—como per-
missões de arquivo, senhas e contas de usuário. Entender esses conceitos
irá ajudá-lo a seguir os procedimentos restantes para tornar seu computa-
dor seguro.

Permissões

No Ubuntu, arquivos e diretórios podem ser configurados para que so-
mente usuários específicos possam vê-los, modificá-los ou executá-los.
Por exemplo, você pode querer compartilhar um arquivo importante com
outros usuários, porém não quer que eles possam editar o arquivo. O
Ubuntu controla o acesso aos arquivos do seu computador através de um
sistema de ”permissões”. Permissões são configurações com finalidade de
controlar exatamente como os arquivos no seu computador são acessados
e usados.

Para aprender mais sobre como modificar permissões, visite https://
help.ubuntu.com/community/FilePermissions.

Senhas

Você deve usar uma senha forte para aumentar a segurança no seu com-
putador. Sua senha não deve conter nomes, palavras ou frases comuns.
Por padrão, o comprimento mínimo de uma senha no Ubuntu é de quatro
caracteres. Nós recomendamos a utilização de uma senha com mais ca-
racteres. Uma senha com um mínimo de oito caracteres incluindo ambas
letras maiúsculas e minúsculas, números e símbolos é considerada forte.

Bloqueando a tela

ando você deixa o seu computador sem manuseá-lo, você pode querer
travar a tela, Travar a sua tela prevenirá o uso do seu computador até que
a sua senha senha inserida. Para travar a tela:

‣ Clique no ícone do menu de sessão, no canto superior direito do painel,
e então selecione Bloquear tela, ou

‣ pressione Ctrl+Alt+L para bloquear a tela. Esse atalho do teclado pode
ser modificado em Painel ‣Configurações do Sistema ‣Teclado

Contas de usuário

Usuários e grupos

ando o Ubuntu é instalado, ele é automaticamente configurado para
apenas uma pessoa utilizá-lo. Se mais de uma pessoa irá utilizar o compu-
tador, cada uma delas deve ter sua própria conta de usuário. Dessa forma,
cada usuário pode possuir diferentes configurações, documentos e outros
arquivos. Se for necessário, você pode também proteger arquivos de serem
vistos ou modificados por usuários sem privilégios administrativos.

Como a maioria dos sistemas operacionais, o Ubuntu permite que você
crie contas de usuários separadas para cada pessoa. O Ubuntu também su-
porta grupos de usuários, que permitem que você administre permissões
para múltiplos usuários ao mesmo tempo.

Cada usuário no Ubuntu é um membro de no mínimo um grupo—no
mínimo, o usuário do computador possui permissões em um grupo com
o mesmo nome do usuário. Um usuário pode também ser um membro

https://help.ubuntu.com/community/FilePermissions
https://help.ubuntu.com/community/FilePermissions
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de grupos adicionais. Você pode configurar alguns arquivos e pastas
para serem somente acessíveis a um usuário ou a um grupo. Por padrão,
os arquivos de um usuário são somente acessíveis para aquele usuário;
arquivos de sistema são somente acessíveis para usuário root.

M I S S I N G S C R E E N S H O T
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Figura 6.3: Adicione, remova ou modifique as
contas de usuário.

Gerenciando usuários

Você pode gerenciar usuários e grupos usando o aplicativo administrativo
Contas de usuários. Para encontrar este aplicativo, clique em Indicador de
sessão ‣Configurações do sistema ‣Contas de usuários.

Para ajustar as configurações de usuário, primeiro, clique no botão
Desbloquear e digite a sua senha para desbloquear as configurações de
usuário. Em seguida, selecione o usuário da lista que você deseja modifi-
car. Então, clique no elemento que você deseja mudar.

Adicionando um usuário Click the + buon which appears underneath
the list of the current user accounts that have already been created. A
window will appear that has two fields. e Name field is for a friendly
display name. e Username field is for the actual username. Fill in
the requested information, then click OK. A new dialog box will appear
asking you to enter a password for the user you have just created. Fill out
the fields, then click OK. You can also click the gears buon to generate
a password. Privileges you grant to the new user can be altered in “Users
Seings”.

Modificando um usuário Clique no nome do usuário na lista de usuários
e, então, clique na entrada de texto que aparece perto de cada uma das
seguintes opções:

‣ Tipo de conta:
‣ Senha:
‣ Login Automático:

Apagando um usuário Selecione um usuário da lista e clique em -. O
Ubuntu irá desativar a conta do usuário e você poderá escolher se quer
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remover o seu diretório home ou mantê-lo. Se um usuário for removido e
os seus arquivos forem mantidos, o único usuário que poderá acessá-los
será o root ou alguém associado com o grupo do arquivo.

Gerenciando grupos

O gerenciamento de grupos é feito através da linha de comando (Termi-
nal) ou adicionando aplicativos de terceiros, os quais estão além do escopo
deste manual. Você encontrará mais informações na sub-seção ”Usando a
linha de comando” abaixo.

Adicionando um grupo Para adicionar um grupo, digite sudo addgroup
nomedogrupo e pressione Enter, substituindo nomedogrupo pelo nome do
grupo que você deseja adicionar.

Modificando um grupo Para alterar usuários em um grupo já existente,
digite sudo adduser nomedeusuario nomedogrupo (adicionar um usuário)
ou sudo deluser nomedeusuario nomedogrupo (remover um usuário) e
pressione Enter, subustituindo nomedeusuario e nomedogrupo pelo nome
de usuário e do grupo que você está trabalhando.

Removendo um grupo Para excluir um grupo, digite sudo delgroup
nomedogrupo e pressione Enter, substituindo nomedogrupo pelo nome do
grupo que você deseja excluir.

Aplicando grupos à arquivos e pastas

Para modificar o grupo associado com um arquivo ou diretório, abra o ge-
renciador de arquivos Nautilus e navegue até o arquivo ou diretório apro-
priado. Então, ou selecione o diretório e escolha Arquivo ‣ Propriedades
na barra de menu, ou clique com o botão direito no arquivo ou diretório
e selecione Propriedades. Na janela de diálogo Propriedades, clique na
aba Permissões e selecione o grupo desejado na lista drop-down Grupo.
Então feche a janela.

Usando a linha de comando

Você também pode modificar as configurações de usuário e grupo via
linha de comando. Nós recomendamos que você use o método grá-
fico acima, a menos que você tenha uma boa razão para usar a linha de
comando. Para maiores informações sobre a utilização da linha de co-
mando para modificar usuários e grupos, veja o Guia do Ubuntu Server
em hps://help.ubuntu.com/./serverguide/C/user-management.html

Atualizações de sistema

Uma boa segurança ocorre em um sistema atualizado. O Ubuntu provê
programas gratuitos e atualizações de segurança. Você deveria aplicar
essas atualizações regularmente. Veja Atualizações simples e atualizações
de versão do sistema para aprender como atualizar seu computador com
Ubuntu com as últimas correções e atualizações de segurança.

Confiando em fontes de terceiros

Normalmente, você irá adicionar aplicativos ao seu computador via Cen-
tral de programas do Ubuntu, que baixa os programas dos repositórios

https://help.ubuntu.com/12.04/serverguide/C/user-management.html
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do Ubuntu como descritos em Capítulo : Gerenciamento de Programas.
Porém, ocasionalmente é necessário adicionar programas de outras fontes.
Por exemplo, você pode precisar fazer isso quando um aplicativo não está
disponível nos repositórios do Ubuntu ou quando você precisa de uma
versão mais nova do que aquela disponível nos repositórios do Ubuntu.

Repositórios adicionais estão disponíveis em sites como getdeb.net e
Launchpad s que são adicionados como descrito em Canais de so-
ware. Você pode baixar os pacotes  para alguns aplicativos dos seus
respectivos sites de projeto na Internet. Alternativamente, você pode com-
pilar aplicativos a partir do código fonte (um método avançado de instalar
e utilizar aplicativos).

Usando apenas fontes reconhecidas como um site do projeto, , ou
vários repositórios da comunidade (como getdeb.net) é mais seguro que
baixar aplicativos a partir de uma fonte arbitrária (e talvez menos respei-
tável). Ao utilizar uma fonte de terceiros, considerar a sua credibilidade, e
ter a certeza que você sabe exatamente o que você está instalando em seu
computador.

Firewall

Um firewall é um aplicativo que protege o seu computador contra acesso
não autorizado de pessoas na Internet ou em sua rede local. O Firewall
bloqueia conexões de seu computador a fontes desconhecidas. Isso ajuda a
evitar violações de segurança.

Uncomplicated Firewall () is the standard firewall configuration
program in Ubuntu. It runs from the command line, but a program called
Gufw allows you to use it with a graphical user interface . See Capí-
tulo : Gerenciamento de Programas to learn more about installing the
Gufw package.

Once Gufw is installed, start Gufw by clicking Dash ‣Applications ‣
Firewall configuration. To enable the firewall, select the Enable option.
By default, all incoming connections are denied. is seing should be
suitable for most users.

Se você está executando um soware servidor no seu sistema Ubuntu
(como um servidor web, ou um servidor ), então você necessitará
abrir as portas que estes servições usam. Se você não é familiarizado com
servidores, você não precisará abrir portas adicionais.

Para abrir a porta, clique no botão Adicionar. Para mais fins, a aba Pré-
configurado é suficiente. Selecione o botão Permitir da primeira caixa e
então selecione o programa ou serviço requerido.

A aba simples pode ser usado para permitir acesso a uma porta sim-
ples, e a aba Avançado pode ser usado para permitir acesso a um intervalo
de portas.

Encriptação

You may wish to protect your sensitive personal data—for instance, fi-
nancial records—by encrypting it. Encrypting a file or folder essentially
“locks” that file or folder by encoding it with an algorithm that keeps it
scrambled until it is properly decoded with a password. Encrypting your
personal data ensures that no one can open your personal folders or read
your private data without your authorization through the use of a private
key.

O Ubuntu inclui muitas ferramentas para criptografar arquivos e di-
retórios. Este capítulo irá discutir duas delas. Para maiores informações

http://getdeb.net
http://getdeb.net
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sobre como usar a criptografia tanto em arquivos individuais quanto
no e-mail, veja a documentação do Suporte da Comunidade Ubuntu em
hps://help.ubuntu.com/community.

Pasta pessoal

Ao instalar o Ubuntu, é possível criptografar a pasta pessoal de um usuá-
rio. Veja Capítulo : Instalação para mais informações.

Pasta privativa

Se você não optou por criptografar a sua pasta pessoal inteira, é possí-
vel criptografar uma única pasta—chamada Privativa—dentro da pasta
pessoal de um usuário. Para fazer isso, siga os seguintes passos:

. Instale o pacote de soware ecryptfs-utils na Central de programas
do Ubuntu. (Para maiores informações sobre a central de programas,
reveja Usando a Central de Programas do Ubuntu.)

. Utilize o terminal para executar ecryptfs-setup-private e configurar
a pasta privativa.

. Entre com sua senha de conta quando solicitado.
. Escolha ou gere uma frase secreta para montagem.
. Grave ambas as frases de segurança em um local seguro. Elas serão

solicitadas no caso de você decidir recuperar seus dados manualmente.
. Encerre a sessão e entre novamente para montar a pasta criptografada.

Depois que a pasta Privativa foi configurada, todos os arquivos e
pastas dentro dela serão automaticamente criptografados.

Se você precisa recuperar seus arquivos criptografados manualmente,
veja https://help.ubuntu.com/community/EncryptedPrivateDirectory.

https://help.ubuntu.com/community
https://help.ubuntu.com/community/EncryptedPrivateDirectory




7 Solução de problemas

Resolvendo problemas

Às vezes, as coisas podem não se comportar como deveriam. Felizmente,
os problemas que são encontrados quando trabalhamos com o Ubuntu
são geralmente fáceis de se consertar. Abaixo, nós oferecemos um guia
para resolver problemas básicos que os usuários podem encontrar ao
usar o Ubuntu. Se você precisar de alguma ajuda adicional além da que
esse capítulo provê, dê uma olhada nas outras opções de suporte que são
discutidas em Encontre mais ajuda e suporte mais tarde neste livro.

Guia de resolução de problema

A chave para uma efetiva solução de problemas é trabalhar lentamente,
completar todos os passos da solução de problemas e documentar as
mudanças que você fizer no Ubuntu. Dessa forma, você poderá desfazer
seu trabalho ou dar a usuários informações confiáveis sobre as tentativas
anteriores no caso de recorrer por suporte à comunidade.

Não consigo iniciar o Ubuntu após ter instalado o Windows

Ocasionalmente, você pode instalar o Ubuntu e depois decidir instalar
o Microso Windows como segundo sistema operacional rodando lado-
a-lado com o Ubuntu. Isso é suportado pelo Ubuntu, você pode também
achar que após instalar o Windows você não conseguirá mais iniciar o
Ubuntu.

When you first turn on your computer, a “bootloader” must start
Ubuntu or another operating system. When you installed Ubuntu, you A bootloader is the initial software that loads

the operating system when you switch on the
computer.

installed an advanced bootloader called  which allows you to cho-
ose between the various operating systems on your computer, such as
Ubuntu, Windows, Solaris or Mac  . However, when you installed
Windows, it replaced the  with its own bootloader, thus removing
the ability to choose which operating system you’d like to use. You can
restore  and regain the ability to choose your operating system by
using the same  you used to install Ubuntu.

First, insert your Ubuntu  into your computer and then restart it,
making sure to have your computer start from the  (see Capítulo :
Instalação). Next, choose your language (e.g., English) and select Try
Ubuntu. Once Ubuntu starts, click on the top-most icon in the Launcher
(the Dash icon). en, search for Terminal using the search box and
then select Terminal in the search results. A window should open with a
blinking prompt line. Enter the following, and press Enter:

$ sudo fdisk -l

Disk /dev/hda: 120.0 GB, 120034123776 bytes
255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes

Device Boot Start End Blocks Id System
/dev/sda1 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended
/dev/sda4 14532 14593 498015 82 Linux swap
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Entradas da tabela de partição não estão em ordem no disco

Essa saída mostra que seu sistema (Linux, o qual o Ubuntu é base- O dispositivo (/dev/sda1, /dev/sda2, etc.)
que estamos procurando é identificado
pela palavra ”Linux” na coluna de Sistema.
Modifique as instruções abaixo se necessário,
substituindo /dev/sda1 com o nome do seu
dispositivo Linux.

ado) está instalado no dispositivo /dev/sda1, mas o seu computador está
iniciando a partir de /dev/sda2 (onde o Windows está localizado). Isso
precisa ser arrumado, basta dizer ao computador para iniciar a partir do
dispositivo Linux.

Para fazer isso, primeiro, crie um local para conectar a sua instalação
do Ubuntu já existente, com sua sessão temporária de solução de proble-
mas:

$ sudo mkdir /media/root

Agora ligue sua instalação Ubuntu a essa nova pasta
$ sudo mount /dev/sda1 /media/root

Se você concluiu isto corretamente, então você deveria ver o seguinte:
$ ls /media/root bin dev home lib mnt root srv usr boot
etc initrd lib64 opt sbin sys var cdrom initrd.img media proc selinux tmp
vmlinuz

Agora você pode reinstalar o :
$ sudo grub-install --root-directory=/media/root
/dev/sda Instalação terminada. Nenhum erro encontrado.
Este é o conteúdo do mapa de dispositivos /boot/grub/device.map. Verifique
se ele está correto ou não. Se alguma das linhas está incorreta, arrume-a e
re-execute o script grub-install. (hd0) /dev/sda

Finalmente, remova o disco do Ubuntu do seu dispositivo de ,
reinicie seu computador e então comece a desfrutar do sistema operacio-
nal Ubuntu mais uma vez.

Este guia pode não funcionar para todos os usuários do Ubuntu devido
a diferenças nas várias configurações de sistema. Ainda assim, este é o
método recomendado e de maior chance de sucesso para recuperação do
gerenciador de inicialização . Se você está seguindo este guia e ele
não restaurar o  no seu computador, então tente os outros méto-
dos de resolução do problema em https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows.

Eu esqueci minha senha

Se você esquecer a sua senha do Ubuntu, você precisará reiniciá-lo usando
o ”Modo de recuperação”.

Para iniciar o Modo de recuperação, desligue o seu computador e então
ligue-o novamente. ando o seu computador iniciar, pressione a tecla
Shift. Selecione a opção Modo de recuperação usando as teclas de setas
no seu teclado. O Modo de recuperação deve ser o segundo ítem na lista.

Aguarde até que o Ubuntu inicie—isto pode levar alguns minutos. Uma
vez iniciado, você não poderá ver a sua tela normal de início de sessão.
Em vez disto, o Menu de recuperação lhe será apresentado. Selecione
root utilizando as teclas de cursor e pressione Enter.

Você agora estará em um terminal de comandos:
root@ubuntu:~#

Para apagar sua senha, entre
# passwd nomedousuario

Substitua ”nomedousuario” acima pelo nome do seu usuário, após
isso, o Ubuntu irá pedir que você digite uma nova senha. Digite a senha
desejada e pressione a tecla Enter, redigite sua senha novamente e pres-
sione Enter. (O Ubuntu pede a sua senha duas vezes para ter certeza que
você não cometeu um erro ao digitar). Uma vez que você restabeleceu sua
senha, retorne ao ambiente normal do sistema digitando:

https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
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Figura 7.1: Esta é a tela do grub quando você
seleciona o modo de recuperação.

# init 2

Efetue o login como de costume e continue apreciando o Ubuntu.

Eu acidentalmente removi alguns arquivos de que precisava

Se você removeu um arquivo por acidente, você poderá recuperá-lo na
Lixeira do Ubuntu. Trata-se de uma pasta especial onde o Ubuntu guarda
arquivos apagados antes que eles sejam permanentemente removidos de
seu computador.

Para acessar a pasta lixeira, clique no ícone de uma lixeira na parte de
baixo do Lançador do Unity.

Se você quiser restaurar itens apagados da lixeira:

. Abrir Lixeira
. Clique em um ítem que você deseja restaurar para selecioná-lo. Pressi-

one e segure Ctrl para selecionar múltiplos ítens.
. Clique em Restaura os ítens selecionados para mover os ítens exclui-

dos de volta para as suas localizações originais.

Como eu limpo o Ubuntu?

Com o tempo, o sistema de pacotes dos programas do Ubuntu podem
acumular muitos pacotes não utilizados e arquivos temporários. Esses
arquivos temporários, também chamados caches, contém arquivos de
todos os pacotes que você instalou. Com o tempo esse cache pode crescer
muito. Limpar o cache permite que você recupere espaço no disco rígido
do seu computador, para armazenar seus documentos, músicas, fotografias
ou outros arquivos.

Para limpar o cache, você pode tanto usar a opção clean ou a opção
autoclean para o programa de linha de comando apt-get. O comando clean irá remover cada ítem

do cache, enquanto o comando autoclean
somente irá remover ítens no cache que não
puderemmais ser baixados (estes ítens são
geralmente desnecessários).

Para executar o comando clean, abra o Terminal e digite:
$ sudo apt-get clean

Pacotes podem se tornar não utilizados com o passar do tempo. Se um
pacote foi instalado para auxiliar a execução de outro programa—e aquele
programa foi removido e você não precisa mais dar suporte ao pacote.
Você pode removê-lo com: apt-get autoremove.
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Carregue o Terminal e digite:
$ sudo apt-get autoremove

Não consigo reproduzir determinados arquivos de áudio ou vídeo

Muitos formatos usados para fornecer rico conteúdo de mídia são propri-
etários, significa que não são livres para usar, modificar ou distribuir com
um sistema operacional open-source como Ubuntu. Portanto, o Ubuntu
não inclui a capacidade de usar estes formatos por padrão; contudo, os
usuários podem facilmente configurar o Ubuntu para usar estes formatos
proprietários. Para mais informações sobre as diferenças entre soware
open source e proprietário, veja Capítulo : Aprendendo mais.

Se você se encontrar precisando de um formato proprietário, pode ser
necessária a instalação de arquivos da Central de programas do Ubuntu
para utilizá-lo. Tenha certeza que você possui os repositórios Universe
e Multiverse habilitados antes de continuar. Veja a seção Canais de so-
ware para aprender como fazer isso. ando você estiver pronto para
continuar, instale os programas necessários, como segue:

. Abra a Central de programas do Ubuntu, procure por ela no Painel (o
botão mais acima no Lançador).

. Procure por ubuntu-restricted-extras digitando “Ubuntu restricted
extras” na caixa de pesquisa no lado direito da janela principal da
Central de Programas do Ubuntu. ando a Central de Programas
encontrar o soware apropriado, clique na seta próxima ao seu título.

. Clique em Instalar e espere até o Ubuntu instalar o soware.

One program that can play many of these formats is VLC media player.
It can be installed from the Ubuntu Soware Center. Once Ubuntu has
successfully installed this soware, your rich media content should work
properly.

Como posso mudar minha resolução de tela?

Uma imagem em cada monitor é composta por milhões de pontos pe-
quenos e coloridos chamados de pixels. A mudança do número de pixels
exibidos em seu monitor é chamada “mudança de resolução.” Aumentar
a resolução vai tornar as imagens mais definidas, mas também tende a
deixá-las menores. O contrário também é verdade quando a resolução
da tela é diminuída. A maioria dos monitores possuem uma “resolução
nativa,” que é a resolução que mais se aproxima do número de pixels no
monitor. Sua tela ficará a mais definida possível quando seu sistema ope-
racional usa uma resolução que casa com a resolução nativa do monitor.

O utilitário de configuração do Ubuntu Monitores permite que os
usuários mudem a resolução. Abra ele clicando no indicador de sessão e
então em Monitores…. A resolução pode ser mudada usando a caixa de
seleção dentro do programa. Ao escolher as opções mais acima na lista
(por exemplo, aquelas com números maiores) a resolução aumentará.

Você pode experimentar várias resoluções clicando em Aplicar na parte
de baixo da janela até que você encontre uma que é confortável para você.
Tipicamente, a maior resolução será a resolução nativa. Selecionando
uma resolução e clicando no botão Aplicar, a resolução da tela será mu-
dada temporariamente para o valor selecionado e uma caixa de diálogo
também será exibida. Ela permitirá que você reverta para a configuração
de resolução antiga ou mantenha a nova resolução. A caixa de diálogo
desaparecerá em  segundos, restaurando a resolução antiga.
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M I S S I N G S C R E E N S H O T

ss:display-properties

The file screenshots/pt_BR/07-troubleshooting-display-properties.png does not exist!

Figura 7.2: Você pode alterar as configurações
de exibição.

M I S S I N G S C R E E N S H O T

ss:08-display-properties-confirm

The file screenshots/pt_BR/07-troubleshooting-display-properties-confirm.png does
not exist!

Figura 7.3: Você pode reverter para as
configurações antigas se for necessário.

Esta funcionalidade foi implementada para prevenir que alguém seja
bloqueado de usar o computador por uma resolução que distorce o mo-
nitor e o faz ficar inutilizável. ando você terminar de configurar a
resolução de tela, clique em Fear.

O Ubuntu não está funcionando bem no meu Apple MacBook ou MacBook
Pro

ando instalado em notebooks da Apple como por exemplo o MacBook
ou o MacBook Pro. O Ubuntu nem sempre habilita todos os componentes
internos do computador, incluindo a câmera ISight e o adaptador sem
fio Airport. A comunidade do Ubuntu oferece documentação de como
resolver este e outros problemas. Se Você esta encontrando problemas
em instalar ou usar o Ubuntu no seu notebook Apple, por favor siga as
instruções em https://help.ubuntu.com/community/MacBook. Você pode

https://help.ubuntu.com/community/MacBook
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escolher o guia apropriado ao identificar o numero do modelo do seu
computador. Para instruções de como fazer isso, visite a pagina acima.

O Ubuntu não está funcionando corretamente no meu Asus EeePC

ando instalado em netbooks da Asus—como EeePC—o Ubuntu nem
sempre ativa todos os componentes embutidos do computador, incluindo
teclas atalhos do teclado e o adaptador de internet sem fio. A comunidade
Ubuntu oferece documentação sobre como ativar estes componentes e
consertar outros problemas. Se você está tendo problema para instalar
ou usar o Ubuntu em seu Asus EeePC, por favor siga as instruções em
https://help.ubuntu.com/community/EeePC. Esta página de documentação
contém informações pertinentes especificamente a netbooks EeePC.

Para ativar muitos dos recursos e as teclas de função, uma solução
rápida é adicionar ”acpi_osi=Linux” à sua configuração do grub a partir do
terminal.

$ gksudo gedit /etc/default/grub
e com muito cuidado modifique a linha

GRUB_CMDLINE_LINUX_DEFAULT="quiet splash"
para

GRUB_CMDLINE_LINUX_DEFAULT="quiet splash acpi_osi=Linux"
Salvar e fechar o arquivo. Então, a partir do terminal:

sudo update-grub
Após o comando terminar e você reiniciar o computador, você conseguirá
usar as teclas Fn normalmente.

Meu hardware não está funcionando corretamente

Ubuntu occasionally has difficulties running on certain computers, ge-
nerally when hardware manufacturers use non-standard or proprietary
components. e Ubuntu community offers documentation to help you
troubleshoot many common issues that may arise from this situation,
including problems with wireless cards, scanners, mouse and printers.
You can find the complete hardware troubleshooting guide on Ubuntu’s
support wiki, accessible at https://wiki.ubuntu.com/HardwareSupport. If
your hardware problems persist, please see Obtendo mais ajuda for more
troubleshooting options or information on obtaining support or assistance
from an Ubuntu user.

Obtendo mais ajuda

Este guia não cobre todos os possíveis fluxos de trabalho, tarefas ou pro-
blemas no Ubuntu. Se você precisar de assistência além da informação
contida no manual, você pode encontrar uma grande variedade de oportu-
nidades de suporte on-line

Mais detalhes sobre as muitas opções de suporte disponíveis, pode ser
encontrada em Encontre mais ajuda e suporte mais adiante neste livro.

https://help.ubuntu.com/community/EeePC
https://wiki.ubuntu.com/HardwareSupport
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O que mais posso fazer com o Ubuntu?

Você agora deve ser capaz de usar o Ubuntu para a maioria de suas ativi-
dades diárias—como navegar na Web, enviar e-mail, e criar documentos.
Mas você pode estar interessado em conhecer outras versões do Ubuntu
que possam integrar seu estilo de vida digital. Neste capítulo, apresenta-
remos a você outras versões do Ubuntu especializadas em certas tarefas.
Também forneceremos recursos para responder quaisquer perguntas
restantes que você possa ter e diremos como você pode se envolver na
comunidade mundial de usuários do Ubuntu. Mas primeiro, discutiremos
as tecnologias que tornam o Ubuntu uma poderosa coleção de programas.

programa de código aberto

Ubuntu é um soware de código aberto. Soware de código aberto difere
de soware proprietário—soware cujo código fonte não está livremente
disponível para modificação ou distribuição por qualquer um exceto o de-
tentor dos direitos. Microso Windows e Adobe Photoshop são exemplos O código-fonte de um programa é a coleção de

arquivos que foi escrita numa linguagem de
computador para fazer o programa.

de soware proprietário.

Software Proprietário é o software que não
pode ser copiado, modificado ou distribuído
livremente.

Diferentemente de programas aplicativos proprietários, os programas
incluídos no Ubuntu são licenciados especificamente para promover o
compartilhamento e colaboração. As regras legais governando a produ-
ção e distribuição do Ubuntu asseguram que qualquer um pode obter,
executar, ou compartilhá-lo para qualquer propósito que deseje. Usuá-
rios de computador podem modificar os programas de código-aberto
como Ubuntu para adequá-los às suas necessidades individuais, para
compartilhá-los, para aprimorá-los, ou para traduzi-los para outros idi-
omas—desde que forneçam o código-fonte dessas modificações para que
outros possam fazer o mesmo. Na verdade, os termos de muitos dos acor-
dos de licença de código-aberto tornam ilegal não fazê-lo. Para mais
informações a respeito dos padrões de licenciamento dos programas do
Ubuntu, veja http://www.ubuntu.com/project/about-ubuntu/licensing.

Como o programa de código aberto é desenvolvido por grandes comu-
nidades de programadores distribuídos por todo o mundo, isso beneficia
o ciclo de desenvolvimento rápido e lançamentos rápido de segurança (no
caso em que alguém descobre bugs no programa). Em outras palavras, o
programa de código aberto é atualizado, melhorado e mais seguro a cada
dia conforme programadores de todo o mundo continuem a melhorá-lo.

Além destas vantagens técnicas, o soware de código aberto também
tem benefícios econômicos. Apesar de os usuários precisarem aderir aos
termos de um acordo de licença de código aberto quando instalam e usam
o Ubuntu, eles não precisam pagar para obter esta licença. E embora nem
todo soware de código aberto seja gratuito, muitos são.

Para aprender mais sobre soware de código aberto, veja a definição
de iniciativa de código aberto, disponível em http://www.opensource.org/
docs/definition.php.

http://www.ubuntu.com/project/about-ubuntu/licensing
http://www.opensource.org/docs/definition.php
http://www.opensource.org/docs/definition.php
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Famílias de distribuições

Ubuntu is one of several popular operating systems based on Linux (an
open source operating system). ese Linux-based operating systems
—called Linux “distributions,”—may look different from Ubuntu at first
glance, but they share similar characteristics because of their common
roots. A distribuição, or “distro,” is an operating

systemmade from open source applications,
which are bundled together to make them
easier to install and use.

Distribuições Linux podem ser divididas em duas grandes famílias:
a família Debian e a família Red Hat. Cada família recebe o nome da
distribuição na qual se baseiam distribuições subsequentes. Por exemplo,
”Debian” refere-se tanto ao nome de uma distribuição Linux quanto a
uma família de distribuições derivadas da distribuição Debian. O Ubuntu
é parte desta família. ando descrevem relações entre vários projetos de
código aberto, desenvolvedores de soware geralmente usam a metáfora
de afluentes se conectando a um curso d’água comum. Por esta razão,
você pode ouvir alguém dizer que o Ubuntu está localizado ”downstream”
(rio abaixo) em relação ao Debian, porque alterações do Debian fluem
em novas versões do Ubuntu. Adicionalmente, melhorias no Ubuntu
geralmente fluem ”upstream” (rio acima)—de volta ao Debian e membros
de sua família, que se beneficiam do trabalho da comunidade Ubuntu.
Outras distribuições na família Debian incluem o Linux Mint, Xandros e
CrunchBang Linux. Distribuições na família Red Hat incluem Fedora e
Mandriva.

A diferença mais significante entre distribuições baseadas no Debian
e no Red Hat é o sistema que cada um usa para instalar e atualizar pro-
gramas. Esses sistemas são chamados “Sistemas de gerenciamento de
pacotes.” Pacotes de programa Debian são arquivos , enquanto pacotes Sistemas de gerenciamento de pacotes são os

meios pelos quais os usuários podem instalar,
remover e organizar o programa instalado em
computadores com sistemas operacionais de
código aberto como o Ubuntu.

de programa Red Hat são arquivos . Os dois sistemas são geralmente
incompatíveis. Para mais informações sobre gerenciamento de pacotes,
veja Capítulo : Gerenciamento de Programas.

Você também vai encontrar as distribuições Linux que foram especiali-
zadas para determinadas tarefas. A seguir, vamos descrever essas versões
do Ubuntu e explicar o uso a que cada uma foi desenvolvida.

Escolhendo entre Ubuntu e suas variações

Assim como o Ubuntu é baseado no Debian, várias distribuições são sub-
sequentemente baseadas no Ubuntu. Cada uma difere das outras com
respeito aos programas incluídos na distribuição. Alguns são desenvol-
vidos para uso geral, enquanto outras são projetadas para realizar um
conjunto mais restrito de tarefas.

Interfaces alternativas

Ubuntu apresenta uma interface gráfica de usuário () baseada no
desktop de código aberto . Como explicamos em Capítulo : O
Ubuntu Desktop, uma “interface de usuário” é uma coleção de elementos
de soware—ícones, cores, janelas, temas, e menus—que determinam
como alguém pode interagir com um computador. Algumas pessoas
preferem usar alternativas ao , então elas criaram distribuições
apresentando diferentes interfaces de usuário. Elas incluem:

‣ Kubuntu, que usa o , ambiente gráfico em vez do ambiente 
encontrado no Ubuntu;

‣ Lubuntu, que usa o ambiente gráfico  ao invés do ambiente 
encontrado no Ubuntu; e
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‣ Xubuntu, que usa o ambiente gráfico  ao invés do ambiente 
encontrado no Ubuntu.

Além disso, cada uma dessas distribuições pode conter aplicativos
padrão diferentes dos apresentados no Ubuntu. Por exemplo, o player
de música padrão no Ubuntu é o Rhythmbox, mas em Lubuntu o player
de música padrão é o Aqualung, e no Kubuntu o padrão é o Amarok.
Certifique-se de investigar essas diferenças se você estiver pensando em
instalar uma distribuição Ubuntu com um ambiente de trabalho alterna-
tivo.

Para mais informações sobre estas e outras distribuições derivadas, veja
http://www.ubuntu.com/project/derivatives.

Distribuições de função específica

Outras distribuições Ubuntu tem sido criadas para realizar tarefas específi-
cas ou rodar em configurações especializadas.

Ubuntu Edição para Servidor

O Ubuntu Server Edition é um sistema operacional otimizado para exe-
cutar tarefas multi-usuários quando instalado em servidores. Tais tarefas Um servidor é um computador que é configu-

rado para gerenciar ou “servir,” arquivos que
várias pessoas desejam acessar.

incluem compartilhamento de arquivos e sites web ou hospedagem de
email. Se você planeja usar um computador para realizar tarefas como
estas, você deve querer usar esta distribuição servidora especializada
juntamente com um hardware servidor.

Este manual não explica o processo de execução de um servidor web
seguro ou a realização de outras tarefas possíveis com o Ubuntu Server
Edition. Para detalhes de uso do Ubuntu Server Edition, consulte o manual
em http://www.ubuntu.com/business/server/overview.

Edubuntu

Edubuntu é uma personalização derivada para uso em escolas e outras
instituições educacionais. Ela contem programas similares aos oferecidos
no Ubuntu, mas também aplicações características adicionais - como um
editor de texto colaborativo e jogos educacionais.

Para informações adicionais sobre o Edubuntu, visite http://www.
edubuntu.org/

Ubuntu Studio

Este derivado do Ubuntu é projetado especificamente para pessoas que
usam computadores para criar e editar projetos multimídia. Ele apresenta
aplicações para ajudar os usuários a manipular imagens, compor música
e editar vídeo. Apesar dos usuários poderem instalar estas aplicações em
computadores rodando a versão desktopo do Ubuntu, o Ubuntu Studio
torna todas elas disponíveis imediatamente na instalação.

Se você quiser saber mais sobre o Ubuntu Studio (ou obter uma cópia
para si mesmo), visite http://ubuntustudio.org/home.

Mythbuntu

Mythbuntu permite que os usuários transformem os seus computado-
res em sistemas de entretenimento. Isso ajuda os usuários a organizar e
ver varios tipos de arquivos multimédia como filmes, programas de TV,
podcasts de vídeo. Usuários com receptores de  também podem usar o
Mythbuntu para gravar vídeos e programas de TV

http://www.ubuntu.com/project/derivatives
http://www.ubuntu.com/business/server/overview
http://www.edubuntu.org/
http://www.edubuntu.org/
http://ubuntustudio.org/home
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Para aprender mais sobre Mythbuntu, visite http://www.mythbuntu.
org/.

Encontre mais ajuda e suporte

Este guia não pode conter tudo o que você precisa saber sobre o Ubuntu.
Porque o guia Introdução ao Ubuntu . nunca poderá responder a todas
suas perguntas, nós encorajamos você a tirar proveito da vasta comu-
nidade do Ubuntu quando se busca informações, solução de problemas
técnicos, ou fazer perguntas sobre o seu computador. A seguir, vamos dis-
cutir alguns desses recursos, de modo que você pode aprender mais sobre
o Ubuntu ou outras distribuições Linux.

Chat ao vivo

Se você está familiarizado com (), você pode usar clientes de bate papo
como XChat ou Pidgin para se juntar ao canal #ubuntu em irc.freenode.net.
Aqui, centenas de usuários voluntários podem responder suas perguntas
ou oferecer suporte em tempo real. Para saber mais sobre como usar o
IRC para buscar ajuda com o Ubuntu, visite https://help.ubuntu.com/
community/InternetRelayChat.

Times regionais

Dentro da comunidade Ubuntu estão dezenas de grupos locais de usuários,
chamados “LoCo teams.” Espalhados por todo o mundo, essas equipes
oferecem apoio e aconselhamento, respondem perguntas e promovem
o Ubuntu em suas comunidades e realizam eventos regularmente. Para
localizar e contatar a LoCo team mais próxima, visite o site http://loco.
ubuntu.com/.

Livros e revistas

Muitos livros têm sido escritos sobre o Ubuntu, e revistas profissionais
sempre trazem notícias e informações relacionadas ao Ubuntu. Você vai
frequentemente encontrar estes recursos em alguma livraria ou banca
de jornais próximas. Entretanto, muitas destas publicações impressas
também estão disponíveis através de download compradas na Central de
Programas do Ubuntu. Para encontrá-las, inicie a Central de Programas do
Ubuntu, e escolha “Livros & Revistas” no painel esquerdo.

Documentação Oficial do Ubuntu

A equipe de Documentação do Ubuntu mantém uma série de páginas wiki Além da ajuda oficial do Ubuntu e da comuni-
dade, você encontrará frequentemente ajuda
de terceiros disponível na Internet. Apesar
desses documentos geralmente parecerem
boas fontes, alguns pode estar errados ou
desatualizados. É sempre melhor verificar
informações de fontes de terceiros antes
de levar em conta seus conselhos. Quando
possível, baseie-se na documentação oficial do
Ubuntu.

oficiais projetadas para auxiliar tanto usuários novos quanto experientes
que queiram aprender mais sobre o Ubuntu. A comunidade Ubuntu ava-
liza estes documentos, que servem como um primeiro ponto de referência
confiável para usuários buscando ajuda online. Você pode acessá-las em
http://help.ubuntu.com. Para acessar o Guia do Ubuntu Desktop embu-
tido, tecle F1 em seu computador, ou digite ”ajuda” no Painel.

Os fóruns do Ubuntu

Os “Ubuntu forums” são os fóruns oficiais da comunidade Ubuntu. Mi-
lhões de usuários do Ubuntu usam os fóruns diariamente para procurar
ajuda e apoio de outros usuários. Você pode criar uma conta “Ubuntu
forums” em minutos. Para criar uma conta e saber mais sobre o Ubuntu

http://www.mythbuntu.org/
http://www.mythbuntu.org/
https://help.ubuntu.com/community/InternetRelayChat
https://help.ubuntu.com/community/InternetRelayChat
http://loco.ubuntu.com/
http://loco.ubuntu.com/
http://help.ubuntu.com
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a partir dos membros da comunidade, visite http://ubuntuforums.org em
inglês e http://ubuntuforum-br.org/ em português.

Launchpad Answers

Launchpad, um repositório de código open source e também uma co-
munidade de usuários, disponibilia um serviço de perguntas e respostas
que permite que qualquer pessoa faça perguntas acerca de algum tópico
relacionado ao Ubuntu. Criar uma conta Launchpad requer apenas al-
guna minutos. Você pode fazer uma pergunta visitando o Launchpad em
https://answers.launchpad.net/ubuntu/+addquestion.

Ask Ubuntu

Ask Ubuntu é um website gratuito do tipo comunidade para usuários e de-
senvolvedores Ubuntu. Como o Ubuntu Forums, ele permite que os usuá-
rios postem perguntas para que outros membros da comunidade Ubuntu
possam responder. Mas o Ask Ubuntu também permite que visitantes “vo-
tem” nas respostas dadas pelos usuários, e assim as respostas mais úteis
ou que mais ajudaram recebam destaque no site. O Ask ubuntu é parte da
rede Stack Exchange de websites, e é um dos melhores recursos de suporte
Ubuntu disponível, a custo zero. Visite http://www.askubuntu.com para
poder começar a usa-lo.

Mecanismos de busca

Devido ao Ubuntu ser um sistema operacional de código-aberto popular,
muitos usuários tem escrito sobre ele online. Portanto, usar ferramentas
de busca para localizar respostas para suas perguntas sobre o Ubuntu é
geralmente um meio efetivo de conseguir ajuda. ando usar mecanismos
de busca para responder perguntas sobre o Ubuntu, certifique-se de que
sua busca seja o mais específica possível. Em outras palavras, uma busca
por ”interface Unity” retornará resultados que são menos úteis que aque-
les associados com a busca ”como utilizar a interface Ubuntu Unity” ou
”como personalizar a interface Ubuntu Unity”.

Suporte da comunidade

Se você leu todos esse manuais e ainda não conseguiu encontrar respostas
para suas perguntas, visite o site Community Support em http://www.
ubuntu.com/support/community.

A comunidade Ubuntu

Ao redor do Ubuntu há uma comunidade de usuários apaixonados que
querem ajudar outros a adotar, usar, compreender, e até mesmo alterar
ou melhorar o Ubuntu. Ao Escolher instalar e executar o Ubuntu, você
se torna parte desta comunidade. À medida que aprende mais sobre o
Ubuntu, você pode querer colaborar com outros a torná-lo melhor—o
futuro do Ubuntu, relatar bugs de programas que descobrir, promover
o Ubuntu a novos usuários, compartilhar conselhos sobre o Ubuntu ou
responder questões de outros usuários. Nesta seção, discutiremos al-
guns projetos da comunidade que podem conectar você a outros usuários
Ubuntu.

http://ubuntuforums.org
http://ubuntuforum-br.org/
https://answers.launchpad.net/ubuntu/+addquestion
http://www.askubuntu.com
http://www.ubuntu.com/support/community
http://www.ubuntu.com/support/community
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Full Circle Magazine

Full Circle Magazine - Revista Full Circle, é a “revista independente para
a comunidade Ubuntu Linux.” Lançada todo mês, a Revista Full Circle
contem revisões de novos programas (incluindo jogos) para Ubuntu,
tutoriais passo a passo que você pode realizar com Ubuntu, editoriais
discutindo questões importantes na comunidade Ubuntu, e dicas para
o Ubuntu de outros usuários. Você pode baixar edições da Revista Full
Circle em http://fullcirclemagazine.org/.

O Podcast Ubuntu UK

Produzido por membros do time Ubuntu LoCo do Reino Unido, essa
transmissão de áudio on-line (ou ”podcast”), que acontece uma se-
mana sim e uma não, contém discussões vívidas sobre o Ubuntu, e
muitas vezes inclui entrevistas com membros da comunidade Ubuntu
que trabalham para melhorar o Ubuntu. Episódios estão disponíveis em
http://podcast.ubuntu-uk.org/. Um podcast é uma transmissão de áudio

estilo rádio, disponível como um arquivo de
áudio para download em computadores e
reprodutores portáteis de mídia.OMG! Ubuntu!

OMG! Ubuntu! é um blog que tem como objetivo informar à comunidade
Ubuntu sobre notícias, eventos, anúncios e atualizações recentes. Também
permite aos usuários Ubuntu discutir meios em que eles possam promover
ou compartilhar o Ubuntu. Você pode ler esse blog ou assiná-lo em http://
www.omgubuntu.co.uk/.

Contribuindo

Contribuindo para o Ubuntu

Como mencionamos antes nesse capítulo, o Ubuntu é um sistema ope-
racional mantido pela comunidade. Você pode ajudar a fazer o Ubuntu
melhor de muitas maneiras. A comunidade consiste em milhares de indi-
víduos e times. Se você quiser contribuir com o Ubuntu, por favor visite
https://wiki.ubuntu.com/ContributeToUbuntu.

Você também pode participar da comunidade Ubuntu contribuindo
para este manual. Você pode escolher escrever novos conteúdos, editar
seus capítulos, assim eles serão mais fáceis para os novos usuários Ubuntu
compreenderem e usar, ou traduzi-lo para a sua própria linguagem. Você
também pode providenciar as capturas de tela encontradas no manual.
Para participar no Projeto Manual Ubuntu, visite http://ubuntu-manual.
org/getinvolved.

http://fullcirclemagazine.org/
http://podcast.ubuntu-uk.org/
http://www.omgubuntu.co.uk/
http://www.omgubuntu.co.uk/
https://wiki.ubuntu.com/ContributeToUbuntu
http://ubuntu-manual.org/getinvolved
http://ubuntu-manual.org/getinvolved


A License

Introdução ao Ubuntu . está licenciado sob a Licença Creative Com-
mons Aribution–Share Alike ..

Você é livre:

para Compartilhar copiar, distribuir e transmitir a obra
Remixar para adaptar a obra

Sob as seguintes condições:

Atribuição Você deve creditar a obra na maneira indicada pelo autor ou
licenciamento (mas não de maneira que sugira que estes aprovem você
ou o seu uso da obra).

Share Alike Se você alterar, transformar ou construir com base neste
trabalho, você pode distribuir o trabalho resultante usando a mesma
licença, ou uma similar.

Devido à variação de legislação entre os países onde este manual pode
ser distribuído, não foi possível incluir uma licença totalmente traduzida
nesse momento. Você pode, no entanto, ler a licença completa traduzida
on-line em http://creativecommons.org/licenses/by-sa/./legalcode.

Creative Commons Attribution–ShareAlike 3.0 Legal Code

  (  )       
    (“”  “”).   
   /   .   
          
   .

        ,  
          .   
        ,  
         
     .

. Definitions
(a) “Adaptation” means a work based upon the Work, or upon the

Work and other pre-existing works, such as a translation, adapta-
tion, derivative work, arrangement of music or other alterations
of a literary or artistic work, or phonogram or performance and
includes cinematographic adaptations or any other form in which
the Work may be recast, transformed, or adapted including in any
form recognizably derived from the original, except that a work that
constitutes a Collection will not be considered an Adaptation for the
purpose of this License. For the avoidance of doubt, where the Work
is a musical work, performance or phonogram, the synchronization
of the Work in timed-relation with a moving image (“synching”) will
be considered an Adaptation for the purpose of this License.

(b) “Collection” means a collection of literary or artistic works, such
as encyclopedias and anthologies, or performances, phonograms
or broadcasts, or other works or subject maer other than works
listed in Section () below, which, by reason of the selection and

http://creativecommons.org/licenses/by-sa/3.0/legalcode
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arrangement of their contents, constitute intellectual creations,
in which the Work is included in its entirety in unmodified form
along with one or more other contributions, each constituting
separate and independent works in themselves, which together
are assembled into a collective whole. A work that constitutes a
Collection will not be considered an Adaptation (as defined below)
for the purposes of this License.

(c) “Creative Commons Compatible License” means a license that is
listed at http://creativecommons.org/compatiblelicenses that has
been approved by Creative Commons as being essentially equiva-
lent to this License, including, at a minimum, because that license:
(i) contains terms that have the same purpose, meaning and effect
as the License Elements of this License; and, (ii) explicitly permits
the relicensing of adaptations of works made available under that li-
cense under this License or a Creative Commons jurisdiction license
with the same License Elements as this License.

(d) “Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or
other transfer of ownership.

(e) “License Elements” means the following high-level license aributes
as selected by Licensor and indicated in the title of this License:
Aribution, ShareAlike.

() “Licensor” means the individual, individuals, entity or entities that
offer(s) the Work under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work,
the individual, individuals, entity or entities who created the Work
or if no individual or entity can be identified, the publisher; and in
addition (i) in the case of a performance the actors, singers, musi-
cians, dancers, and other persons who act, sing, deliver, declaim,
play in, interpret or otherwise perform literary or artistic works or
expressions of folklore; (ii) in the case of a phonogram the producer
being the person or legal entity who first fixes the sounds of a per-
formance or other sounds; and, (iii) in the case of broadcasts, the
organization that transmits the broadcast.

(h) “Work” means the literary and/or artistic work offered under the
terms of this License including without limitation any production
in the literary, scientific and artistic domain, whatever may be the
mode or form of its expression including digital form, such as a
book, pamphlet and other writing; a lecture, address, sermon or
other work of the same nature; a dramatic or dramatico-musical
work; a choreographic work or entertainment in dumb show; a
musical composition with or without words; a cinematographic
work to which are assimilated works expressed by a process analo-
gous to cinematography; a work of drawing, painting, architecture,
sculpture, engraving or lithography; a photographic work to which
are assimilated works expressed by a process analogous to pho-
tography; a work of applied art; an illustration, map, plan, sketch
or three-dimensional work relative to geography, topography, ar-
chitecture or science; a performance; a broadcast; a phonogram; a
compilation of data to the extent it is protected as a copyrightable
work; or a work performed by a variety or circus performer to the
extent it is not otherwise considered a literary or artistic work.

(i) “You” means an individual or entity exercising rights under this
License who has not previously violated the terms of this License
with respect to the Work, or who has received express permission

http://creativecommons.org/compatiblelicenses
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from the Licensor to exercise rights under this License despite a
previous violation.

(j) “Publicly Perform” means to perform public recitations of the Work
and to communicate to the public those public recitations, by any
means or process, including by wire or wireless means or public
digital performances; to make available to the public Works in such
a way that members of the public may access these Works from a
place and at a place individually chosen by them; to perform the
Work to the public by any means or process and the communication
to the public of the performances of the Work, including by public
digital performance; to broadcast and rebroadcast the Work by any
means including signs, sounds or images.

(k) “Reproduce” means to make copies of the Work by any means
including without limitation by sound or visual recordings and the
right of fixation and reproducing fixations of the Work, including
storage of a protected performance or phonogram in digital form or
other electronic medium.

. Fair Dealing Rights. Nothing in this License is intended to reduce,
limit, or restrict any uses free from copyright or rights arising from
limitations or exceptions that are provided for in connection with the
copyright protection under copyright law or other applicable laws.

. License Grant. Subject to the terms and conditions of this License,
Licensor hereby grants You a worldwide, royalty-free, non-exclusive,
perpetual (for the duration of the applicable copyright) license to
exercise the rights in the Work as stated below:

(a) to Reproduce the Work, to incorporate the Work into one or more
Collections, and to Reproduce the Work as incorporated in the
Collections;

(b) to create and Reproduce Adaptations provided that any such Adap-
tation, including any translation in any medium, takes reasonable
steps to clearly label, demarcate or otherwise identify that changes
were made to the original Work. For example, a translation could
be marked “e original work was translated from English to Span-
ish,” or a modification could indicate “e original work has been
modified.”;

(c) to Distribute and Publicly Perform the Work including as incorpo-
rated in Collections; and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdic-
tions in which the right to collect royalties through any statutory
or compulsory licensing scheme cannot be waived, the Licen-
sor reserves the exclusive right to collect such royalties for any
exercise by You of the rights granted under this License;

ii. Waivable Compulsory License Schemes. In those jurisdictions
in which the right to collect royalties through any statutory or
compulsory licensing scheme can be waived, the Licensor waives
the exclusive right to collect such royalties for any exercise by
You of the rights granted under this License; and,

iii. Voluntary License Schemes. e Licensor waives the right to
collect royalties, whether individually or, in the event that the
Licensor is a member of a collecting society that administers
voluntary licensing schemes, via that society, from any exercise
by You of the rights granted under this License.

e above rights may be exercised in all media and formats whether
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now known or hereaer devised. e above rights include the right
to make such modifications as are technically necessary to exercise
the rights in other media and formats. Subject to Section (), all
rights not expressly granted by Licensor are hereby reserved.

. Restrictions. e license granted in Section  above is expressly made
subject to and limited by the following restrictions:

(a) You may Distribute or Publicly Perform the Work only under the
terms of this License. You must include a copy of, or the Uniform
Resource Identifier (URI) for, this License with every copy of the
Work You Distribute or Publicly Perform. You may not offer or im-
pose any terms on the Work that restrict the terms of this License or
the ability of the recipient of the Work to exercise the rights granted
to that recipient under the terms of the License. You may not sub-
license the Work. You must keep intact all notices that refer to this
License and to the disclaimer of warranties with every copy of the
Work You Distribute or Publicly Perform. When You Distribute
or Publicly Perform the Work, You may not impose any effective
technological measures on the Work that restrict the ability of a
recipient of the Work from You to exercise the rights granted to that
recipient under the terms of the License. is Section (a) applies to
the Work as incorporated in a Collection, but this does not require
the Collection apart from the Work itself to be made subject to the
terms of this License. If You create a Collection, upon notice from
any Licensor You must, to the extent practicable, remove from the
Collection any credit as required by Section (c), as requested. If
You create an Adaptation, upon notice from any Licensor You must,
to the extent practicable, remove from the Adaptation any credit as
required by Section (c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under
the terms of: (i) this License; (ii) a later version of this License with
the same License Elements as this License; (iii) a Creative Commons
jurisdiction license (either this or a later license version) that con-
tains the same License Elements as this License (e.g., Aribution-
ShareAlike . US)); (iv) a Creative Commons Compatible License. If
you license the Adaptation under one of the licenses mentioned in
(iv), you must comply with the terms of that license. If you license
the Adaptation under the terms of any of the licenses mentioned
in (i), (ii) or (iii) (the “Applicable License”), you must comply with
the terms of the Applicable License generally and the following
provisions: (I) You must include a copy of, or the URI for, the Ap-
plicable License with every copy of each Adaptation You Distribute
or Publicly Perform; (II) You may not offer or impose any terms on
the Adaptation that restrict the terms of the Applicable License or
the ability of the recipient of the Adaptation to exercise the rights
granted to that recipient under the terms of the Applicable License;
(III) You must keep intact all notices that refer to the Applicable
License and to the disclaimer of warranties with every copy of the
Work as included in the Adaptation You Distribute or Publicly Per-
form; (IV) when You Distribute or Publicly Perform the Adaptation,
You may not impose any effective technological measures on the
Adaptation that restrict the ability of a recipient of the Adaptation
from You to exercise the rights granted to that recipient under the
terms of the Applicable License. is Section (b) applies to the
Adaptation as incorporated in a Collection, but this does not require
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the Collection apart from the Adaptation itself to be made subject to
the terms of the Applicable License.

(c) If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant
to Section (a), keep intact all copyright notices for the Work and
provide, reasonable to the medium or means You are utilizing: (i)
the name of the Original Author (or pseudonym, if applicable) if
supplied, and/or if the Original Author and/or Licensor designate
another party or parties (e.g., a sponsor institute, publishing en-
tity, journal) for aribution (“Aribution Parties”) in Licensor’s
copyright notice, terms of service or by other reasonable means,
the name of such party or parties; (ii) the title of the Work if sup-
plied; (iii) to the extent reasonably practicable, the URI, if any, that
Licensor specifies to be associated with the Work, unless such URI
does not refer to the copyright notice or licensing information for
the Work; and (iv) , consistent with Ssection (b), in the case of an
Adaptation, a credit identifying the use of the Work in the Adapta-
tion (e.g., “French translation of the Work by Original Author,” or
“Screenplay based on original Work by Original Author”). e credit
required by this Section (c) may be implemented in any reason-
able manner; provided, however, that in the case of a Adaptation
or Collection, at a minimum such credit will appear, if a credit for
all contributing authors of the Adaptation or Collection appears,
then as part of these credits and in a manner at least as prominent
as the credits for the other contributing authors. For the avoid-
ance of doubt, You may only use the credit required by this Section
for the purpose of aribution in the manner set out above and, by
exercising Your rights under this License, You may not implicitly
or explicitly assert or imply any connection with, sponsorship or
endorsement by the Original Author, Licensor and/or Aribution
Parties, as appropriate, of You or Your use of the Work, without the
separate, express prior wrien permission of the Original Author,
Licensor and/or Aribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may
be otherwise permied by applicable law, if You Reproduce, Dis-
tribute or Publicly Perform the Work either by itself or as part of
any Adaptations or Collections, You must not distort, mutilate, mod-
ify or take other derogatory action in relation to the Work which
would be prejudicial to the Original Author’s honor or reputation.
Licensor agrees that in those jurisdictions (e.g. Japan), in which
any exercise of the right granted in Section (b) of this License (the
right to make Adaptations) would be deemed to be a distortion,
mutilation, modification or other derogatory action prejudicial to
the Original Author’s honor and reputation, the Licensor will waive
or not assert, as appropriate, this Section, to the fullest extent per-
mied by the applicable national law, to enable You to reasonably
exercise Your right under Section (b) of this License (right to make
Adaptations) but not otherwise.

. Representations, Warranties and Disclaimer
         ,
        
       , , 
,   , ,  ,
  , ,    
 , ,      
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 , ,       ,
   .     
    ,     
  .

. Limitation on Liability.       
 ,            
   , , ,  
           
,          
 .

. Termination
(a) is License and the rights granted hereunder will terminate au-

tomatically upon any breach by You of the terms of this License.
Individuals or entities who have received Adaptations or Collections
from You under this License, however, will not have their licenses
terminated provided such individuals or entities remain in full com-
pliance with those licenses. Sections , , , , , and  will survive
any termination of this License.

(b) Subject to the above terms and conditions, the license granted here
is perpetual (for the duration of the applicable copyright in the
Work). Notwithstanding the above, Licensor reserves the right to
release the Work under different license terms or to stop distribut-
ing the Work at any time; provided, however that any such election
will not serve to withdraw this License (or any other license that
has been, or is required to be, granted under the terms of this Li-
cense), and this License will continue in full force and effect unless
terminated as stated above.

. Miscellaneous
(a) Each time You Distribute or Publicly Perform the Work or a Collec-

tion, the Licensor offers to the recipient a license to the Work on the
same terms and conditions as the license granted to You under this
License.

(b) Each time You Distribute or Publicly Perform an Adaptation, Li-
censor offers to the recipient a license to the original Work on the
same terms and conditions as the license granted to You under this
License.

(c) If any provision of this License is invalid or unenforceable under
applicable law, it shall not affect the validity or enforceability of the
remainder of the terms of this License, and without further action
by the parties to this agreement, such provision shall be reformed
to the minimum extent necessary to make such provision valid and
enforceable.

(d) No term or provision of this License shall be deemed waived and
no breach consented to unless such waiver or consent shall be in
writing and signed by the party to be charged with such waiver or
consent.

(e) is License constitutes the entire agreement between the parties
with respect to the Work licensed here. ere are no understand-
ings, agreements or representations with respect to the Work not
specified here. Licensor shall not be bound by any additional provi-
sions that may appear in any communication from You. is License
may not be modified without the mutual wrien agreement of the
Licensor and You.

() e rights granted under, and the subject maer referenced, in this
License were draed utilizing the terminology of the Berne Conven-
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tion for the Protection of Literary and Artistic Works (as amended
on September , ), the Rome Convention of , the WIPO
Copyright Treaty of , the WIPO Performances and Phonograms
Treaty of  and the Universal Copyright Convention (as revised
on July , ). ese rights and subject maer take effect in the
relevant jurisdiction in which the License terms are sought to be
enforced according to the corresponding provisions of the imple-
mentation of those treaty provisions in the applicable national law.
If the standard suite of rights granted under applicable copyright
law includes additional rights not granted under this License, such
additional rights are deemed to be included in the License; this
License is not intended to restrict the license of any rights under
applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not
be liable to You or any party on any legal theory for any damages what-
soever, including without limitation any general, special, incidental or
consequential damages arising in connection to this license. Notwith-
standing the foregoing two () sentences, if Creative Commons has ex-
pressly identified itself as the Licensor hereunder, it shall have all rights
and obligations of Licensor.

Except for the limited purpose of indicating to the public that the
Work is licensed under the CCPL, Creative Commons does not authorize
the use by either party of the trademark “Creative Commons” or any
related trademark or logo of Creative Commons without the prior wrien
consent of Creative Commons. Any permied use will be in compliance
with Creative Commons’ then-current trademark usage guidelines, as
may be published on its website or otherwise made available upon request
from time to time. For the avoidance of doubt, this trademark restriction
does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/




Glossário

ambiente de trabalho Um termo genérico para descrever uma interface
gráfica que permite que pessoas interajam com computadores. Existem
muitos ambientes de trabalho, tais como , ,  e ,
somente para nomear alguns

Canonical Canonical, a mantenedora oficial do Ubuntu, provê suporte
para o núcleo do sistema Ubuntu. Possui cerca de  membros pagos
ao redor do mundo a fim de garantir que os fundamentos do sistema
operacional sejam estáveis, bem como verificar todos os trabalhos
submetidos por colaboradores voluntários. Para aprender mais sobre a
Canonical, visite http://www.canonical.com.

Central de Programas A Central de Programas é onde você pode geren-
ciar facilmente a instalação e a remoção de programas, inclusive os
instalados a partir de pacotes locais.

  ou interface da linha de comando é outro nome para o terminal.
conexão com fio Uma conexão com fio é quando seu computador está

fisicamente conectado a um roteador ou Porta Ethernet com um cabo,
este é o método mais simples de conexão à Internet e rede local para
computadores de mesa.

conexão discada Uma conexão discada é quando seu computador utiliza
um modem para conectar-se a um  (Provedor de Serviços de Inter-
net) através da linha telefônica.

conexão sem-fio Uma conexão de rede que usa um sinal sem fio para se
comunicar com um roteador, ponto de acesso ou computador.

criptografia A criptografia é uma medida de segurança que impede os
outros de acessar e visualizar o conteúdo de seus arquivos e/ou discos
rígidos Os arquivos devem primeiro ser descriptografados com a sua
senha.

cursor A linha vertical ou um quadrado piscando (geralmente) é usado
para mostrar onde o texto irá aparecer quando você começar a digitar.
Você pode movê-lo com as setas do seu teclado prompt no terminal ou
outra aplicação de entrada de texto.

  sigla para Dynamic Host Configuration Protocol, é usado por
um  servidor para definir ao computador um  endereço de rede
automaticamente.

distribuição Uma distribuição é uma coleção de programas que já está
compilada e configurada, pronta para ser instalada. O Ubuntu é um
exemplo de uma distribuição.

dupla-inicialização dupla-inicialização é o processo de ser capaz de esco-
lher entre dois sistemas operacionais diferentes que estejam instalados
em um computador a partir de um menu de inicialização. Uma vez se-
lecionado, o computador irá inicializar o sistema operacional que você
escolher no menu de inicialização. A dupla-inicialização é um termo
usado genericamente, e pode se referir à inicialização de mais de dois
sistemas operacionais.

  (uma sigla para  Network Object Model Environment)
é o ambiente de trabalho padrão utilizado no Ubuntu.

 A  (Graphical User Interface - Interface Gráfica do Usuário),

http://www.canonical.com
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permite ao usuário interagir com o computador através de gráficos e
imagens ao invés de entradas puramente textuais.

  sigla para Internet Service Provider - Provedor de Serviços de Inter-
net, um  é o mesmo que um provedor de acesso, uma empresa que
provê sua conexão com a Internet.

kernel O kernel é a porção central de um sistema operacional baseado em
Unix, responsável por rodar aplicações, processos, e fornecer segurança
para os componentes centrais.

maximizar ando você maximiza um aplicativo no Ubuntu ele passará a
ocupar toda a área de trabalho, excluindo os painéis.

minimize ando você minimizar um aplicativo aberto, a janela não
será mais vista na sua ária de trabalho. Se você clicar no botão de uma
aplicação minimizada no painel, ela será restaurada ao seu estado
normal e permitir que você interaja com ele.

package Os pacotes contém soware em um pronto-a-instalar o formato.
Na maioria das vezes você pode usar o Central de Programas em vez
de instalar manualmente pacotes. Pacotes têm uma extensão deb. no
Ubuntu.

parâmetro Parâmetros são opções especiais que você pode utilizar com
outros comandos no terminal para fazer com que o comando se com-
porte de maneira diferente. Isto pode tornar muitos comandos bem
mais úteis.

partition Uma partição é uma área de espaço alocado em um disco rígido
onde você pode inserir dados.

Porta Ethernet Uma porta Ethernet é o local onde um cabo Ethernet é
conectado quando você usa uma conexão com fio.

prompt O prompt mostra algumas informações úteis sobre o seu com-
putador. Ele pode ser personalizado para ser mostrado em diferentes
cores, assim como ser capaz de mostrar o horário, data e diretório
atual, assim como quase qualquer outra coisa que você desejar.

proprietário Soware feito por empresas que não liberam o código-fonte
sob uma licença código aberto.

roteador Um roteador é um computador especialmente projetado que,
usando seu soware e hardware, encaminha informações da Internet a
uma rede. É também chamado de gateway.

saída A saída de um comando é qualquer texto mostrado na próxima
linha após o comando ser digitado e o enter pressionado, e.g., se você
digitar pwd em um terminal e pressionar Enter, o nome de diretório que
ele mostra na próxima linha é a saída.

servidor Um servidor é um computador que executa um sistema ope-
racional especializado e fornece serviços para computadores que se
conectam a ele e realizam uma requisição.

shell O terminal fornece acesso ao shell. ando você digita um comando
no terminal e pressiona Enter o shell pega aquele comando e realiza a
ação correspondente.

terminal O terminal é uma interface baseada em texto do Ubuntu, é um
método de controlar o sistema operacional usando somente comandos
digitados através do teclado, o outro método se estiver usando seu
computador o Ubuntu é usar um  tal como Unity.
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USB Universal Serial Bus é uma especificação de interface padrão para
conectar dispositivos de hardware periféricos a computadores. Dispo-
sitivos USB podem variar de discos rígidos externos a digitalizadores e
impressoras.
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